WebSphere Solution Bundles: Implementation and Integration Guide

Planning and implementation of Business Partner and ISV e-business applications

Recommended hardware and software selection for WebSphere Application Server

Examples of development, test, and production environments

Rufus Credle
Matthew Stokes
Karthikeyan Subramanian

ibm.com/redbooks
WebSphere Solution Bundles: Implementation and Integration Guide

August 2002
Take Note! Before using this information and the product it supports, be sure to read the general information in “Notices” on page ix.

First Edition (August 2002)

This edition applies to planning, installing, and configuring of IBM WebSphere Application Server Advanced Edition 4.0 and Enterprise Edition 4.1, WebSphere Studio Application Developer Integration Enterprise 4.1, MQSeries 5.2.1, WebSphere MQ Integrator 2.1, and IBM MQSeries Workflow V3.3.2, Windows 2000 Server, IBM AIX 4.3.3 on IBM @server xSeries and pSeries systems.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. HQ7  Building 662
P.O. Box 12195
Research Triangle Park, NC 27709-2195

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 2002. All rights reserved.
Note to U.S Government Users – Documentation related to restricted rights – Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
Contents

Notices ................................................................. ix
Trademark ............................................................. x

Preface ................................................................. xi
The team that wrote this redbook ........................................ xii
Notice ................................................................. xiv
Comments welcome ................................................... xiv

Chapter 1. WebSphere Application Server roadmap ............... 1
  1.1 WebSphere Application Server .................................. 2
  1.2 Various WebSphere Application Server environments ........ 3
    1.2.1 Why do we need separate environments ................... 3

Chapter 2. Understanding the WebSphere family .................. 7
  2.1 The WebSphere family ........................................... 8
  2.2 WebSphere: The architecture ................................... 8
  2.3 WebSphere platform architecture .............................. 9
  2.4 Foundation and Tools .......................................... 10
    2.4.1 IBM WebSphere Application Server V4.0 Advanced Edition . 11
    2.4.2 WebSphere Application Server V4.1 Enterprise Edition ........ 12
    2.4.3 WebSphere Application Server, V5.0 .......................... 12
    2.4.4 WebSphere Application Server Enterprise, V5.0 ............. 16
    2.4.5 WebSphere Application Server - Express, V5.0 ............... 16
    2.4.6 WebSphere Application Server for z/OS, V5.0 ............... 17
    2.4.7 WebSphere Studio ........................................... 18
    2.4.8 Host Access ................................................ 19
  2.5 Reach and User Experience .................................... 20
    2.5.1 Reach and User Experience: WebSphere Commerce ......... 21
    2.5.2 Reach and User Experience: WebSphere Portal ............. 22
    2.5.3 Reach and User Experience: Pervasive .................... 23
  2.6 Business Integration ........................................... 26
    2.6.1 Business Integration: Process Integration ................. 27
    2.6.2 Business Integration: Application Connectivity ........... 32
  2.7 Transaction Servers and Tools ................................ 35
    2.7.1 Transaction Servers and Tools: Enterprise Modernization . 35
    2.7.2 Transaction Servers and Tools: transaction processing ...... 37
    2.7.3 Transaction Servers and Tools: traditional tools .......... 37
  2.8 Distributed computing and WebSphere Application Server .... 39
    2.8.1 Three-tiered client/server computing ..................... 39
2.8.2 Transactions .............................................. 41
2.8.3 Security ................................................ 42
2.9 Competitive comparison ................................. 43

Chapter 3. IBM and ISV e-business applications and offerings .......... 45
3.1 Setting the stage and foundation for stages of e-business adoption .... 46
  3.1.1 Whole Product Concept ................................ 47
  3.1.2 Business scenario: Getting started in e-business ............... 48
  3.1.3 Business scenario: Dynamic e-business ..................... 49
  3.1.4 Business scenario: High-volume Web site .................... 50
  3.1.5 Business scenario: High-volume Web site for z/OS .......... 51
  3.1.6 Business scenario: Enhancing your e-business with Web services . 52
  3.1.7 Business scenario: Enterprise modernization/integration .... 54
  3.1.8 Business scenario: Enhance ROI through improved programmer productivity ................................................. 55
  3.1.9 Business scenario: Gain flexibility to compete in the dynamic e-business environment........................................... 57
  3.1.10 Business scenario: Rational offering- liberated development .... 57
  3.1.11 Business scenario: Accelerating and simplifying enterprise application development ....................................... 58
3.2 IBM PartnerWorld for Software ................................ 59
3.3 Developer partnership programs ................................ 60
  3.3.1 PartnerWorld for Developers (PWD) .......................... 61
  3.3.2 developerWorks: Outreach to individual developers ........ 62
3.4 Global Solutions Directory .................................... 64

Chapter 4. Planning considerations .................................. 67
4.1 Assessment .................................................. 68
4.2 Do you need a development environment? ......................... 68
  4.2.1 Build a staging/test environment ............................. 69
4.3 Build and implement the solution ................................ 70
  4.3.1 IBM @server solutions .................................... 70
  4.3.2 Why IBM platforms for the e-business infrastructure? ...... 77
  4.3.3 IBM @server xSeries ...................................... 77
  4.3.4 IBM @server pSeries ...................................... 78
  4.3.5 IBM @server iSeries ....................................... 78
  4.3.6 IBM @server zSeries ....................................... 79
  4.3.7 Requests for sizing and capacity planning .................... 80
  4.3.8 IBM @server planning, installation and configuration tools .... 81
  4.3.9 Operating systems .......................................... 82
  4.3.10 Web servers ............................................... 83
  4.3.11 Databases ................................................ 84
  4.3.12 Third-party JDBC driver managers .......................... 85
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.13 Web browsers</td>
<td>86</td>
</tr>
<tr>
<td>4.3.14 Java</td>
<td>87</td>
</tr>
<tr>
<td>4.3.15 Java specifications</td>
<td>88</td>
</tr>
<tr>
<td>4.3.16 XML/XSL</td>
<td>89</td>
</tr>
<tr>
<td>4.3.17 MQSeries</td>
<td>89</td>
</tr>
<tr>
<td>4.3.18 Security</td>
<td>90</td>
</tr>
<tr>
<td>4.3.19 WebSphere Application Server Advanced Edition hardware and</td>
<td>91</td>
</tr>
<tr>
<td>software requirements</td>
<td></td>
</tr>
<tr>
<td>4.3.20 WebSphere Application Server Enterprise Edition hardware and</td>
<td>95</td>
</tr>
<tr>
<td>software requirements</td>
<td></td>
</tr>
<tr>
<td>4.3.21 IBM MQSeries V5.2.1 (WebSphere MQ)</td>
<td>96</td>
</tr>
<tr>
<td>4.3.22 MA88: MQSeries classes for Java and MQSeries classes for Java Message Service requirements</td>
<td>98</td>
</tr>
<tr>
<td>4.3.23 IBM MQSeries Integrator (WebSphere MQ Integrator)</td>
<td>99</td>
</tr>
<tr>
<td>4.3.24 IBM MQSeries Workflow (WebSphere MQ Workflow)</td>
<td>101</td>
</tr>
<tr>
<td>4.3.25 IBM development server hardware and software prerequisites</td>
<td>103</td>
</tr>
<tr>
<td>4.3.26 IBM staging server hardware and software prerequisites</td>
<td>105</td>
</tr>
<tr>
<td>4.4 WebSphere Application Server performance tools</td>
<td>106</td>
</tr>
<tr>
<td>4.5 Security</td>
<td>108</td>
</tr>
<tr>
<td>4.6 System management</td>
<td>108</td>
</tr>
<tr>
<td>4.6.1 IBM Tivoli Monitoring for Web Infrastructure</td>
<td>108</td>
</tr>
<tr>
<td>4.6.2 IBM Tivoli Storage Manager for Application Servers</td>
<td>109</td>
</tr>
<tr>
<td>4.6.3 IBM Tivoli Access Manager for Business Integration</td>
<td>109</td>
</tr>
<tr>
<td>4.6.4 IBM Tivoli Access Manager for e-business</td>
<td>110</td>
</tr>
<tr>
<td>4.6.5 IBM Tivoli Web Site Analyzer</td>
<td>111</td>
</tr>
</tbody>
</table>

Chapter 5. Skills planning and education ................................. 115
  5.1 Installers and system administrators                              116
  5.2 Application developers and system architects                     117
  5.3 Developing solutions for e-business                              117
    5.3.1 Course roadmaps                                              117

Chapter 6. Build your WebSphere development environment ................ 125
  6.1 Development environment setup                                     126
    6.1.1 Software used for our development environment                 126
    6.1.2 Hardware used for our development environment                 126
  6.2 WebSphere Studio Application Developer Integration Edition installation 126
    6.2.1 Starting the WebSphere Studio Application Developer Integration Edition 133
  6.3 IBM DB2 Personal Developer Edition installation                  135
    6.3.1 Updating DB2 to latest FixPak                                 143
    6.3.2 Configure DB2                                                  149
  6.4 Install IBM MQSeries classes for Java and MQSeries classes for Java 150
Message Service ................................................................. 151
6.4.1 Configure SupportPac MA88 ........................................ 158
6.5 Sample application ........................................................... 159
6.5.1 Create POENTRY queue ................................................. 159
6.5.2 Create WebSphere Studio Application Developer projects. ... 160
6.5.3 Coding WSADMQDemoWeb application ............................ 163
6.5.4 Setting up environment variables for WSADMQDemoWeb ...... 191
6.5.5 Configuring the WebSphere Application Server in WebSphere Studio Application Developer ............................................. 194
6.5.6 Running the application .................................................. 198
6.5.7 Exporting the demo application to an .ear file ...................... 199

Chapter 7. Build your WebSphere staging environment ................. 201
7.1 Staging environment setup ................................................... 202
7.1.1 Software used for our staging environment .......................... 203
7.1.2 Hardware used in our development environment ..................... 203
7.2 DB2 Universal Database Enterprise Edition V7.2 installation ....... 203
7.2.1 DB2 FixPak installation ................................................ 211
7.2.2 Verifying the database is running .................................... 215
7.3 WebSphere Application Server V4.0 Advanced Edition installation .... 215
7.3.1 Pre-installation tasks .................................................. 216
7.3.2 Installing WebSphere Application Server V4.0.1 Advanced Edition 217
7.3.3 Installing FixPak for WebSphere Application Server V4.0 Advanced Edition (PTF2) ..................................................... 224
7.3.4 Configuring WebSphere service for auto start on reboot .............. 228
7.4 WebSphere Application Server V4.1 Enterprise Edition installation .... 229
7.5 IBM MQSeries V5.2.1 (WebSphere MQ) installation ..................... 233
7.5.1 Pre-installation tasks ................................................. 234
7.5.2 Installing MQSeries V5.2.1 ........................................... 234
7.5.3 Post installation task ................................................ 253
7.5.4 Installing SupportPac MA88 (MQSeries Class for Java and JMS) .... 259
7.6 MQSeries Workflow V3.3.2 (WebSphere MQ Workflow) installation ...... 264
7.6.1 Configuring MQSeries Workflow ..................................... 272
7.7 WebSphere MQ Integrator V2.1 installation ............................... 290
7.7.1 Installing CSD 00 (FPU200167) for MQ Integrator V2.1 .......... 295
7.7.2 Configuring the databases for MQ Integrator V2.1 .................... 298
7.7.3 Creating and configuring Configuration Manager and Broker ....... 302
7.7.4 Autostarting Broker and Configuration Manager on reboot ......... 310
7.7.5 Configuring WebSphere MQ Integrator V2.1 ....................... 311
7.8 Creation of the POENTRY queue ....................................... 318
7.9 Configuring the sample application in our WebSphere Application Server staging environment ................................................. 318
7.9.1 Running the sample application ..................................... 329
# Chapter 8. Build your WebSphere production environment

- **8.1 Software used in our production environment** ........................................ 332
- **8.2 Hardware used in our production environment** ...................................... 332
- **8.3 IBM DB2 UDB V7.2 Enterprise Edition installation** ............................... 332
  - **8.3.1 Updating DB2 to latest FixPak** .................................................. 347
  - **8.3.2 Post-installation tasks** ................................................................. 351
- **8.4 IBM WebSphere Application Server V4.0 Advanced Edition installation** .... 352
  - **8.4.1 Pre-installation tasks** ................................................................... 352
  - **8.4.2 Installing IBM WebSphere Application Server V4.0** ......................... 353
  - **8.4.3 Installing IBM WebSphere Application Server FixPak** ....................... 360
  - **8.4.4 Post installation setup** ................................................................. 362
- **8.5 IBM WebSphere Application Server V4.1 Enterprise Edition - Enterprise Services installation** .......................................................... 368
- **8.6 IBM MQSeries V5.2 (WebSphere MQ) installation** ............................... 372
  - **8.6.1 Post installation tasks** ................................................................... 372
- **8.7 IBM WebSphere MQ Integrator V2.1 installation** ................................. 374
  - **8.7.1 Pre-installation tasks** ................................................................... 374
  - **8.7.2 Installing WebSphere MQ Integrator** ............................................. 374
  - **8.7.3 Install FixPak** .............................................................................. 375
  - **8.7.4 Post installation configuration** ....................................................... 376
- **8.8 IBM MQSeries Workflow V3.3.2 installation** ....................................... 378
  - **8.8.1 Pre-installation** ............................................................................ 378
  - **8.8.2 Install IBM MQSeries Workflow** .................................................. 380
  - **8.8.3 Configure MQSeries Workflow** .................................................... 380
  - **8.8.4 Install MQSeries Java classes** ....................................................... 387
- **8.9 Deploying and testing the demo application** ....................................... 388
  - **8.9.1 Starting the demo application** ....................................................... 393
  - **8.9.2 Create a queue** ............................................................................ 395
  - **8.9.3 Running the application** ............................................................... 395

---

## Appendix A. Additional material

- **Locating the Web material** .......................................................................... 397
- **Using the Web material** ............................................................................. 397
- **System requirements for downloading the Web material** ............................ 398
- **How to use the Web material** ................................................................. 398

---

## Abbreviations and acronyms

- .................................................................................................................. 399

## Related publications

- **IBM Redbooks** ......................................................................................... 401
- **Referenced Web sites** ............................................................................. 401
- **How to get IBM Redbooks** ................................................................. 406
- **IBM Redbooks collections** ................................................................. 406
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM's application programming interfaces.
Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

Redbooks™
WebSphere
AIX®
AS/400®
CICS®
DB2®
DB2 Connect™
DB2 Extenders™
DB2 OLAP Server™
DB2 Universal Database™
Encina®
Everyplace™
IBM®
IMS™

iSeries™
MQIntegrator®
MQSeries®
Netfinity®
OS/390®
OS/400®
PartnerWorld®
Perform™
pSeries™
Redbooks™
RS/6000®
S/390®
ServerProven®
Software Mall®

SP™
SP1®
SupportPac™
TopPage®
TXSeries™
VisualAge®
WebSphere®
xSeries™
z/OS™
zSeries™

The following terms are trademarks of International Business Machines Corporation and Lotus Development Corporation in the United States, other countries, or both:

Lotus®
Domino®
Lotus Notes®

The following terms are trademarks of other companies:

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service marks of others.
Preface

The WebSphere Solution Bundles: Implementation and Integration Guide was developed to help the marketing and support efforts for WebSphere Channels Enablement. This guide represents one of two documents, together known as the Solution Bundle for WebSphere Channel Enablement. The Solution Bundle includes WebSphere channel-ready documentation in the form of a Solution Bundles Marketing and Sales Guide and an implementation and integration guide. The purpose of this implementation and integration guide is to simplify the planning and implementation of IBM Business Partners' and independent software vendors' e-business applications that are enabled for WebSphere Application Server. It also takes into consideration the “Whole Product Concept”, which incorporates everything the customer needs to achieve the business goals that drive its purchase decisions, including consultation, design, configuration, implementation, OEM products and services, and on-going support.

In this book, we review and execute a step-by-step set of instructions that includes the setup and configuration of WebSphere Application Server, and the design and development of an e-business application to be deployed on Microsoft Windows 2000 and IBM AIX. This methodology provides a reference for a working solution that has been system-assured and can be quickly implemented. Additional information on performance guidelines, sizing, education and support is included to help you to understand and manage your WebSphere e-business solution.

This book is intended for technical professionals, IT architects, Business Partners, independent solution developers, customers and IBM IT specialists. It is assumed that the reader has some knowledge of the IBM *product line, WebSphere Application Server 4.0, WebSphere MQ family of products, and IBM DB2 UDB.*

During the writing of this book, IBM announced the release of WebSphere Application Server Version 5.0. Although the examples presented in this book reference WebSphere Application Server Advanced Edition Version 4.0 and Enterprise Edition 4.1, we wanted to inform the public of the latest features of WebSphere Version 5.0 as this product evolves.

The channel marketing guide and the Business Partner guide can be obtained from the following Web sites:

- Business Partners: For the quick path to accessing the Solutions Bundles Marketing and Sales Guide -- go to the WebSphere Innovation Connection Online Web site

© Copyright IBM Corp. 2002. All rights reserved.
IBMers: The Solutions Bundles Marketing and Sales Guide can be accessed by going to the WebSphere Sales and Support intranet site

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world working at the International Technical Support Organization, Raleigh Center.

Rufus Credle is a Senior I/T Specialist and certified Professional Server Specialist at the International Technical Support Organization, Raleigh Center. He conducts residencies and develops redbooks about network operating systems, ERP solutions, voice technology, high availability and clustering solutions, and IBM and OEM e-business applications, all running xSeries systems. Rufus’s various positions during his IBM career have included assignments in administration and asset management, systems engineering, sales and marketing, and IT services. He holds a BS degree in business management from Saint Augustine’s College. Rufus has been employed at IBM for 22 years.

Matthew Stokes is a Software Engineer in the Internet Technology Team, IBM Server Group. Matthew has a Bachelor's of Science degree in Computer Science, with minors in Math and Physics from Brigham Young University. He is a Microsoft Certified Systems Engineer (MCSE), Red Hat Certified Engineer (RHCE), Certified Lotus Professional Principal Developer (CLPD), and an IBM Certified Specialist in AIX Administration and DB2. Matthew has seven years of experience with IBM in software development, systems administration and Executive deskside support. For the past three years, Matthew has worked both as a developer and system administrator. As a member of the Internet Technology Team, he has developed applications, databases and plug-ins for IBM WebSphere, IBM DB2, Lotus Domino and Linux. As an administrator, he is an active advocate for Linux in the Enterprise, and is lead administrator and architect for DB2, Domino, and Linux.

Karthikeyan Subramanian is a solutions architect at Saama Technologies Inc., San Jose, CA. He is responsible for understanding clients’ business objectives and developing a framework and solution that is extensible for future growth. Karthik has a degree in chemical engineering from Venkateshvara College of Engineering, Chennai, India and is a Sun-certified J2EE architect. His specializations include application servers and design patterns and his areas of interest include enterprise integration and Web services.
Thanks to the following people for their contributions to this project:

Rick Stanley, Routes-To-Market and Strategy Manager, WebSphere Application Server Channel Development
IBM New York

Joe Nicke, Channels Development Manager
IBM Research Triangle Park

Carol Plummer, Solution Development Manager, Global Systems Integrators
IBM Bethesda

Dee Peterson-Wise, Program Manager, Application and Integration Middleware-Channels
IBM Atlanta

Donna J. Zubrod, WebSphere Market Manager
IBM Raleigh

Janet Olausen, Technical Marketing Program Manager
IBM Minneapolis

Jere Cline, ITSO Raleigh Center Manager
IBM Raleigh

Navin Enand, ITSO Consultant
IBM Charlotte

Donald Fox, WebSphere Consultant
IBM McLean

Paul C. Castiglione, WebSphere Application Server Advanced Edition Market Manager
IBM Research Triangle Park.

Dan Kloud, WebSphere Application Server Enterprise Edition Market Manager
IBM Somers

John D’Arco, WWFF e-business and Infrastructure Development Project Office
IBM New York

Rajeev Dadia, eCom Practice Director
Saama Technologies, Inc.

Bob McNamara, AIM Campaign and Go To Market Planner
IBM Somers
Ahnee Min, WebSphere Business Integration
IBM Burlingame

Thanks to the following people from the International Technical Support Organization, Raleigh-Rochester-San Jose Centers for their contributions to this project:

Geert Van De Putte, Mark Endrei, John Ganci, Carla Sadtler, Peter Kovari, Michele L Galic, Bill J Moore, Aleksandr Nartovich, and Ueli Wahl
ITSO WebSphere Team

Gail Christensen, Margaret Ticknor, Jeanne Tucker, Tamakia Barrow, Diane O'Shea, Linda Robinson
ITSO Support Team

Notice

This publication is intended to help system administrators, IBM developers, Independent Solution Vendors (ISV), IBM I/T Specialist and I/T Architects, IBM Business Partners, and IBM customers to implement and integrate an IBM WebSphere Application Server Advanced Edition and Enterprise Edition runtime environment. The information in this publication is not intended as the specification of any programming interfaces that are provided by WebSphere Application Server Version 4.0 Advanced Edition and Version 4.1 Enterprise Edition. See the PUBLICATIONS section of the IBM Programming Announcement for WebSphere Application Server Version 4.0 Advanced Edition and Version 4.1 Enterprise Edition for more information about what publications are considered to be product documentation.

Comments welcome

Your comments are important to us!

We want our Redbooks to be as helpful as possible. Send us your comments about this or other Redbooks in one of the following ways:

► Use the online Contact us review redbook form found at:
  ibm.com/redbooks
► Send your comments in an Internet note to:
  redbook@us.ibm.com
► Mail your comments to the address on page ii.
WebSphere Application Server roadmap

Dynamic e-business is about adapting e-business processes and associated systems to support changing business strategies and tactics. As e-business continues to grow in speed and complexity, so must the IT infrastructure that supports it. To provide a competitive advantage in a constantly evolving marketplace, the foundation of any e-business must facilitate fast and efficient responses. The need to improve both top and bottom-line results drives businesses to bring new products and services to market faster, to create a compelling Web experience that improves the quality and quantity of site traffic, to increase transaction volume and frequency and to leverage reusable assets. Dynamic e-business is about creating business processes that can meet several of these goals with decreasing levels of incremental investment.

Dynamic e-business demands a robust, flexible software infrastructure that can enable you to:

- Build applications based on open industry standards within multi-vendor environments
- Rapidly develop and deploy applications to meet your needs today and then extend those applications dynamically as your needs change
- Incorporate mobile devices, new languages and locales and new trading partners, with a minimum amount of recoding or redeployment
Provide high performance, scalability and security to maximize application integrity

The IBM WebSphere software platform for e-business is a comprehensive set of award-winning, integrated e-business solutions. It’s a software platform based on industry standards making it flexible and pluggable, which can allow you to adapt on the fly as markets shift and business goals change. Building on this robust platform, you can integrate diverse IT environments to maximize current investments. Deliver core business applications to the Web. Grow these applications to meet changing needs and increasing demand. And create a differentiated e-business that sets your business apart from the competition. For more information about the full line of WebSphere software platform products and solutions, visit:

http://www.ibm.com/websphere

1.1 WebSphere Application Server

The foundation of the WebSphere software platform is IBM WebSphere Application Server. Being able to respond and adapt to the changing demands of dynamic e-business requires optimum control over a flexible e-business infrastructure. WebSphere Application Server, V4.0 represents a move to a single application server family with flexible configuration options. These options can enable you to maximize control over your infrastructure by helping you choose how you respond to the changing marketplace. You can scale seamlessly to meet the needs of changing workload and markets, without migrating to a different technology base or replacing existing technology investments. With WebSphere Application Server, V4.0, you can move your applications to more capable platforms or can simply add to your existing infrastructure. WebSphere Application Server, V4.0 provides the right capabilities and functions based on your specific business needs.

WebSphere Application Server, V4.0 delivers dynamic e-business in another important way - leading the marketplace in industry open-standards support. WebSphere Application Server, V4.0 provides integrated support for open standards for key Web services, making it a leading production-ready Web application server for the deployment of enterprise Web services solutions. It also provides full Java 2 Platform, Enterprise Edition (J2EE) certification with a rich set of enterprise Java open standards implementations on the market today. IBM leadership in open standards implementation is providing flexibility, choice and control for your business because it allows you to adapt dynamically.
1.2 Various WebSphere Application Server environments

Many firms with internal development projects have a three-tier scheme that may include the following phases:

- The initial Development phase is undertaken on one system and sometimes on an isolated development LAN.
- Once the development is “complete”, a simulated live environment is created for the sole purpose of confirming the completion and its correct functionality. This is the Staging phase, and may likewise be on an isolated test LAN.
- Only after these two phases have run their course is an application “promoted” to the production environment.

Migrating from a staging to production environment means all development of e-business applications will take place on a server physically separate from than the production servers that will service end-user HTTP requests.

1.2.1 Why do we need separate environments

In the design of non-distributed or centralized applications, the process flow from development to production follows the stages shown in Figure 1-1. The application developer first works on the application, which is typically unstable and marginally close to the production site. Once the code is tested and proves to be stable, it's moved to the staging server. The application on the staging server should be as close to 100 percent production quality as possible. The code and content in this environment is then tested thoroughly, and any final bugs are ironed out. The last step is moving from staging to production. Once on the production server, a site is live and accessible to the audience. When building centralized sites, the code is moved from a single server to another single server.
Distributed sites follow a different process, especially for the final two steps staging and production. As shown in Figure 1-2, multiple applications must be updated with the relevant content. For example, there needs to be a concurrent update in two different applications running in production server 1 and 2, which are hosting two different applications.
In this book, we will address the development, staging, and production environments with respect to the WebSphere Application Server product family.

**Development environment**
A development environment is generally

- Unstable
- Dynamic
- Proof of concept testing
- For rapid application development

Generally, for these purposes we would choose a Windows platform.

**Staging environment**
A staging environment is very similar to a production environment. It is mainly used to do quality assurance (QA) and load balancing. Here QA refers to functional testing, stress testing, and all other types of testing.
Production environment
This is the live environment that is exposed to the World Wide Web. In this environment, a change to any existing code needs to go through a cycle of a change requests. Hence it is a very stringent environment. Generally, production environments are UNIX flavors, which are very rugged and stable.

We have discussed the various phases of an e-business solution built from scratch. However, this may not always be the case. There may be applications that have already been built and need to be ported or migrated to a WebSphere Application Server 4.0 environment. WebSphere Application Server 4.0 is a J2EE-compliant Application Server. So for deploying a J2EE application, the following are components that need to be built for an enterprise e-business application:

- WAR (Web Archive) - the Web-related components (HTML, JavaScript, JSP)
- JAR (Java Archive) - the Java classes that make up the business logic components
- EAR (Enterprise Archive) - the JAR files plus WAR files that make up an enterprise application

**Note:** The minimum deployable unit in WebSphere Application Server 4.0 is a WAR file. If the application is developing EJBs, then a JAR file and EAR file are necessary.
Chapter 2. Understanding the WebSphere family

The World Wide Web (the Web) is still relatively new, but its popularity among both individuals and businesses has grown rapidly. Although individuals use the Web for an array of different purposes, businesses use the Web primarily to provide products, services, and information to their customers, suppliers, and employees. Businesses are building active Web sites where customers can order products directly, customer and suppliers can communicate with the business, and employees can communicate with each.

At the time when the Web side of many businesses was changing rapidly, non-Web business systems also went through some major changes as application development spread into distributed systems from mainframe systems. The Open Group's Distributed Computing Environment (DCE) and the Object Management Group's (OMG) Common Object Request Broker Architecture (CORBA) were two major technologies that provided the infrastructure for these types of systems.

Until recently, Web and non-Web business systems remained largely detached from each other. The IBM e-business initiative and the WebSphere family change that by enabling businesses to integrate their Web-based systems with their non-Web systems, to produce a single enterprise-wide business system. Further, the WebSphere family is available in three different editions so that customers
can approach the challenge of implementing e-business solutions in several different ways. Therefore, it is important that we understand the WebSphere Application Server family and how we can leverage the multiple facets of the product to support the different purposes mentioned.

2.1 The WebSphere family

The IBM WebSphere family was designed to help users realize the promise of e-business. The WebSphere family is a set of software products that helps customers develop and manage high-performance Web sites and integrate those Web sites with new or existing non-Web business systems. It focuses on the following general types of businesses:

- Businesses that want to use the latest technologies to establish a powerful Web presence or upgrade their current Web presence
- Businesses that want to develop distributed, enterprise-wide business systems and applications
- Businesses that want to integrate their Web presence with their non-Web systems and applications

The WebSphere family consists of the WebSphere Application Server and other WebSphere family software that is tightly integrated with the WebSphere Application Server and enhances its performance.

2.2 WebSphere: The architecture

WebSphere provides a complete open standards platform for e-business, with increased productivity via performance and scalability. As an IBM Business Partner, this means that WebSphere technology grows as you grow. For your developers, this means they can learn WebSphere technology and use it throughout their careers. They will not have to rewrite applications as the business grows.

As e-business takes hold with companies of all sizes, technology continues to evolve. From the very beginning, an industrial-strength application server has been essential. But today, companies must integrate the application server into a broad infrastructure of servers, Web applications, data, and business processes. And with Web services taking center stage, the application server and its associated development tools must develop, deploy, and access Web services.
The IBM WebSphere software platform for e-business is a family of products and offerings built on open standards. Together, they provide the middleware and development tools that e-business requires.

### 2.3 WebSphere platform architecture

WebSphere is infrastructure software for dynamic e-business, delivering a proven, secure and reliable software portfolio.

Providing comprehensive e-business leadership, WebSphere evolves to meet the demands of companies faced with challenging business environments such as the need for increasing operations efficiencies, strengthening customer loyalty, and integrating disparate systems.

Leading customers toward dynamic e-business means WebSphere provides answers to these challenging business environments. WebSphere is the only e-business platform that can provide everything you need to build, deploy, and integrate your e-business, including Foundation and Tools, Reach and User Experience, Business Integration, and Transaction Servers and Tools.

Together, these facets of the WebSphere software platform close the gap between business strategy and information technology, allowing you to create and operate a dynamic e-business.

These four areas of functionality yield four broad classes of software:

- Foundation and Tools for building, deploying, and growing your e-business.
- Reach and User Experience for extending and personalizing your e-business.
- Business Integration for integrating and automating your e-business.
- Transaction Servers and Tools for leveraging existing software assets to enhance your e-business.

**Note:** In this chapter, based on the products required for ready-to-run ISV business applications, we will concentrate on the areas of Foundation and Tools and Business Integration.
2.4 Foundation and Tools

WebSphere Application Servers and MQ messaging form a solid foundation for the platform. This foundation includes state-of-the-art, integrated and scalable development and content management tools to keep your Web-based information up-to-the-minute. The Foundation and Tools product family provide the Internet expertise you need, enable you to build and use Web Services, and link you to a greater technical community of developers and other WebSphere users.

At the time of the writing of this book, the current product family for Foundation and Tools were:

- **Application Server** - to enable customers to achieve their e-business goals.
- **WebSphere Studio** - enables developers to use a single development environment that is designed to meet their specific development needs.
- **WebSphere Host Access** - enables you to connect hosting capabilities with older technology in your enterprise.

**Note:** During the completion of this book, IBM announced the release of WebSphere Application Server, V5.0. Although the examples presented in this book reference WebSphere Application Server Advanced Edition V4.0 and Enterprise Edition 4.1, we wanted to inform the public of the latest features of WebSphere V5.0 as the product evolves.

The IBM announcements list the new products for Foundation and Tools as:

- **Application Server:**
  - WebSphere Application Server, V5.0 with the following configurations:
    - WebSphere Application Server Enterprise
    - WebSphere Application Server - Express
    - WebSphere Application Server for z/OS

- **WebSphere Studio:**
  - Homepage Builder
  - Studio Professional
  - WebSphere Studio Site Developer Advanced
  - WebSphere Studio Application Developer
  - WebSphere Studio Application Developer Integration Edition
  - WebSphere Studio Enterprise Edition
  - Device Developer
  - Versata Logic Suite

- **Host Access:**
2.4.1 IBM WebSphere Application Server V4.0 Advanced Edition

The IBM WebSphere Application Server V4.0, Advanced Edition builds on the WebSphere Application Server Standard Edition. As the foundation of the WebSphere software platform, WebSphere Application Server provides the core software to deploy, integrate and manage e-business applications.

IBM WebSphere Application Server V4.0, Advanced Edition is available in two additional configuration options that meet different business needs. These specialized configuration options offer businesses the flexibility to respond to the changing marketplace without migrating to a different technology base:

The single server configuration, IBM WebSphere Application Server V4.0, Advanced Single Server Edition, provides J2EE and Web services in a single runtime process. This configuration appeals to businesses that need to build stand-alone or departmental applications that are transaction- or message-oriented. They want applications that don’t require failure bypass, workload distribution, or remote administration. It features a browser-based administration console to enable easy installation and management of single-server usage scenarios, including development, staging, and stand-alone department solutions. It is limited to a single machine and cannot be used on separate servers beyond the single machine.

The developer configuration, IBM WebSphere Application Server V4.0, Advanced Developer Edition, extends the WebSphere Application Server family with a low-priced configuration to meet the needs of individual e-business application developers who need an easy-to-use environment for building and testing new applications. IBM WebSphere Application Server V4.0, Advanced Developer Edition is functionally equivalent to IBM WebSphere Application Server V4.0, Advanced Single Server Edition, except that its license agreement excludes production usage. It can be used without modifications, as these two configurations are functionally equivalent.
2.4.2 WebSphere Application Server V4.1 Enterprise Edition

WebSphere Application Server V4.1 Enterprise Edition builds on the Advanced Application Server and also offers a robust solution to grow e-business applications into enterprise environments. It includes the following:

- TXSeries, IBM's world-class transactional application environment (consisting of both Encina and CICS), with the full distributed object and business-process integration capabilities of Component Broker
- A complete version of the WebSphere Application Server Advanced Edition
- MQSeries
- DB2 UDB
- Enterprise Services

2.4.3 WebSphere Application Server, V5.0

At the time of the writing of this book, IBM announced the release of WebSphere Application Server, V5.0. Although the examples presented in this book reference WebSphere Application Server Advanced Edition V4.0 and Enterprise Edition 4.1, we wanted to provide more information on WebSphere V5.0 as the product evolves.

Please go to the following Web site for other related documents and sites:


WebSphere Application Server, V5.0 offers a world-class infrastructure for the next chapter in open e-business platforms. As the foundation of the WebSphere software platform, WebSphere Application Server provides an e-business application deployment environment with a complete set of application services including capabilities for transaction management, security, clustering, performance, availability, connectivity, and scalability.

What's new in WebSphere Application Server, V5.0

WebSphere Application Server, V5.0 provides the latest functionality in the following ways.

**Comprehensive build-to-integrate platform**

Helps you to improve time-to-value by building new integration-ready applications that leverage existing software assets.

- Enable dynamic application interaction
WebSphere Application Server, V5.0 enables dynamic application interaction through native, high-performance Java Messaging Service (JMS), J2EE 1.3 Message Beans, and container-managed messaging. JMS simplifies development by allowing loosely coupled, reliable asynchronous interactions among J2EE components and legacy systems capable of messaging. Message beans save valuable programming time and skill by allowing requests to be processed when they arrive, as opposed to code that checks for the arrival of messages.

WebSphere Application Server, V5.0 also supports container-managed messaging. This feature further reduces required skill level and development time to create these asynchronous applications, allowing the Enterprise JavaBean (EJB) container to take care of core messaging aspects that would otherwise have to be coded in the message beans. This added support for JMS, Message Beans, and container-managed messaging simplifies development without requiring in-depth JMS skills.

- Reuse and integrate disparate systems and applications

WebSphere Application Server, V5.0 significantly reduces the complexity of interacting with back-end systems through advanced support for Java Connector Architecture (JCA). This feature simplifies the development necessary to connect different types of systems, for example single-phase resources, such as CICS, to two-phase resources, such as DB2.

- Unleash powerful Web services

WebSphere Application Server, V5.0 offers an extremely rich Web services implementation, allowing you to create new business opportunities by exposing business and application services for integration by other divisions, business organizations, or platforms. WebSphere Application Server, V5.0 is the most comprehensive Web services implementation across platforms on the market, including iSeries and zSeries. The new version offers the ability to build, deploy, and securely externalize Web services for application consumption across the firewall.

In order to facilitate further business efficiencies for customers, WebSphere Application Server, V5.0 supports long-running flows with intermittent human interaction. Developers can build flows that can be interrupted prior to completion, then automatically restarted, in addition to flows that prompt users to perform a task or work list.

Support for Business Rule Beans and compensation is added in the new version. Business Rule Beans allow a business analyst to dynamically update business rules without having to hand-code application changes. This feature further reduces costs of creating more efficient processes.
WebSphere Application Server, V5.0 supports automated compensation to increase developer productivity by reducing the need to create complex logic to manage transactions. This feature allows completing or negating a list of defined transactions that depend on each other to fully complete a unit of work. This ability enables you to visually define the process of the transactions and the appropriate actions to undo or commit the list of transactions in the event of a failure.

**Agile deployment and administration**
Lower your cost of ownership and minimize startup investment with highly productive and flexible administration, deployment, and management services.

- **Manage with ease**
  A new XML-based administrator client that works over HTTP is one of many significant usability enhancements to WebSphere Application Server, V5.0. With this client, the administrator can create and manage the cluster while quickly and easily deploying new components, applications, and services. Databases are no longer necessary for administering WebSphere Application Server. However, for simplicity and cost savings, DB2 is included with WebSphere Application Server, V5.0 for use in session persistence.

  Additionally, management is made easier in WebSphere Application Server, V5.0 with support for significant parts of JSR 115, the Java Authorization Service. This allows customers to plug in third-party authorization/roles engines to their WebSphere environment. Administrators can now easily manage a joint authorization engine and application serving environment.

**Intelligent end-to-end application optimization**
Create a competitive advantage and optimize price/performance while meeting the demands of dynamic e-business with an industry-leading combination of reliability, availability, scalability, performance, and security.

- **Handle the volume dynamically**
  WebSphere Application Server, V5.0 improvements allow administrators to work more efficiently and easily. Support for Java Management eXtensions (JMX), which records and logs statistics on usage and resources, is included in the new version. JMX is a standard way of managing a J2EE environment and exposes the WebSphere administrative data to partners such as Tivoli and others for management integration. This allows administrators to better manage performance through best-of-breed tooling that is tightly integrated with their application-serving environment. The combination of JMX and Performance Monitor Interface (PMI) in WebSphere Application Server allows customers to capture and manage wide-ranging performance metrics. Customers can now capture performance metrics defined in the PMI, plus WebSphere and application-specific metrics.
In addition to JMX, WebSphere Application Server, V5.0 contains multiple components to improve the ability to handle volumes dynamically with high performance. For example, included in WebSphere Application Server, V5.0 is Tivoli Performance Viewer (previously named Resource Analyzer). This feature offers smart auto-tuning to simplify the administrator’s job by automatically making recommendations to tune critical WebSphere parameters for maximized performance. Tivoli Performance Viewer saves time while enabling improved application performance.

► Enable an always on, always available infrastructure

WebSphere Application Server, V5.0 has new elements that decrease costly downtime. Additional load balancing is included to allow failover beyond the cluster level to the domain level. The new Content Distribution Framework (CDF) enables business applications and transactions to continue despite down links or limited bandwidth in branch situations or multiple geographic situations. CDF pre-positions Web content closer to end users and makes it available on demand.

WebSphere Application Server, V5.0 provides Transactional Qualities of Service that enable you to give prioritized levels of service to clients. For example, a bank might want to optimize service to their large deposit customers while giving lower priority to small account clients. This new feature enables WebSphere Application Server, V5.0 enables you to provide the highest qualities of service and create stronger customer loyalty and higher satisfaction among your most important customers.

► Instill confidence with security

WebSphere Application Server, V5.0 extends security authentication options to include Kerberos tokens, strong authentication security for client/server applications. For those who would prefer to use an alternate authentication and/or authorization security solution, the new version provides open Security Programming Interfaces (SPIs) for integration into those third-party solutions.

WebSphere Application Server, V5.0 will have an embedded version of Tivoli Policy Director for use with WebSphere. This allows centralized site-wide authentication and access control security in a single repository. This embedded version easily enables extending security beyond WebSphere resources by upgrading to a full license of Tivoli Policy Director.
2.4.4 WebSphere Application Server Enterprise, V5.0

IBM delivers business value with WebSphere Application Server Enterprise, V5.0, by allowing a higher return on IT investments, by offering a greater level of application development productivity, and by delivering the flexibility needed to respond to the constantly changing world of e-business. WebSphere Application Server Enterprise has evolved into a middle-tier deployment platform, providing the capabilities to solve the most demanding enterprise business needs.

Building on the world-class Web services and J2EE implementation of WebSphere Application Server, IBM WebSphere Application Server Enterprise, V5.0 is a next-generation application server environment designed to help you:

- Take control of business applications, IT resources, and business processes in a complex and diverse transactional environment.
- Simplify the integration of heterogeneous applications and assets with a powerful integration framework.
- Manage the complexity of building and deploying enterprise applications through visual and logical process flow capabilities.
- Incorporate e-business infrastructure designed to cut costs, build customer loyalty, and promote business agility.
- Increased confidence in predicting the impact of change.

2.4.5 WebSphere Application Server - Express, V5.0

With all the tools necessary to create and run a simple dynamic Web site in one tightly integrated and affordable package, IBM WebSphere Application Server - Express, V5.0 offers a cost-effective, approachable on-ramp to e-business - a ready-to-go, out-of-the-box solution. Based on the latest Java and Web services standards, WebSphere Application Server - Express lets you convert static Web sites into dynamic Web sites by viewing and performing simple information updates in back-end databases - while also providing the ability to consume Web services and resources for integrating with packaged applications.

WebSphere Application Server - Express provides:

- Quick, easy-to-use wizard-driven installation.
- Integrated development environment (available separately as IBM WebSphere Studio Site Developer for Windows) offering a simplified programming model focusing on JavaScript and Tag Libraries.
- Support for the latest specifications for JavaServer Pages and Java Servlets.
Development environment complete with wizards and samples that can be used as a starting point, code repository or reference and educational guide to help developers through the process of building a dynamic Web site.

One-click application assembly and deployment and near-zero maintenance to minimize administration requirements.

Smooth migration to other WebSphere Application Server and WebSphere Studio configurations when more advanced development and deployment capabilities are required.

### 2.4.6 WebSphere Application Server for z/OS, V5.0

IBM WebSphere Application Server for z/OS, V5.0 is the latest release of WebSphere Application Server that is designed to fully exploit the advanced capabilities of IBM z/OS and OS/390 operating systems. WebSphere Application Server for z/OS, V5.0 is J2EE 1.3 compatible, allowing for seamless deployment of J2EE-based applications to the mainframe. WebSphere Application Server for z/OS includes all the functions of WebSphere Application Server, V5.0, and a significant number of features from WebSphere Application Server Enterprise, V5.0 that make sense for deployment on the zSeries platform. As the proven application server for z/OS, WebSphere Application Server for z/OS, adopted by large companies worldwide, combines the best of two worlds: the speed of the Internet age with the reliability and availability of the data center.

WebSphere Application Server for z/OS is not a part of the base application server, but built from the ground up to take advantage of the z/OS operating system environment and zSeries qualities of service. The difference between a part and being built from the ground up is crucial. WebSphere Application Server for z/OS is designed to utilize zSeries and z/OS features including:

- Exploits the zSeries failover capabilities that enable high reliability and availability needs, allowing for the avoidance of both a hardware and software failure.
- Allows for heterogeneous two-phase commit capability across z/OS resource managers. Only WebSphere on zSeries can provide this commit between IMS, CICS, and DB2 as a result of the deep integration of the Resource Recovery Services (RRS) into the implementation.
- Enjoys inherent proximity to data benefits. Much of the world’s data resides on the zSeries and S/390, resulting in shorter pathlengths for increased performance, ease of management, and overall architecture simplification.
- Exploits the zSeries parallel sysplex, giving massive and near linear scalability and exceptional availability, and allowing a high degree of data integrity.
Utilizes the z/OS workload manager, enabling intelligent, heuristic self-management according to business goals under peak load. This includes managing both constraints in the network and Web server traffic.

Only WebSphere Application Server offers the tightest integration with z/OS and zSeries.

2.4.7 WebSphere Studio

The IBM WebSphere Studio is an open, integrated application development environment that cuts development costs via unprecedented gains in productivity and quality. Built on industry-supported technologies, with extensions from IBM and partners, Studio’s highly integrated and configurable development and deployment environment has multiple configurations to best meet your development needs.

Web development
WebSphere Studio Homepage Builder is designed to allow novice Web developers to create and publish professional-quality Web sites.

WebSphere Studio Site Developer provides everything a professional Web developer needs to create, manage, and maintain dynamic Web applications that meet the latest Web standards.

Application development and integration
WebSphere Studio Application Developer is optimized to allow the professional application developer to quickly and easily build, test, integrate and deploy Java and J2EE applications.

WebSphere Studio Device Developer provides a development environment for the professional application developer to build J2ME applications for devices and embedded systems.

WebSphere Studio Enterprise Developer is designed to help professional application developers and integrators build advanced J2EE, Web services, and non-J2EE applications.

Rapid application development (RAD)
Versata Logic Suite leverages the power of business logic to provide application developers with a highly productive solution for developing enterprise-scale distributed Java applications.
Tools and plug-ins

Complementing WebSphere Studio are many best-of-breed tools and plug-ins offered by IBM and partners.

- Toolkits and complimentary tools from IBM middleware integrate with the WebSphere Studio environment allowing you to quickly and easily add new functionality and tools targeted at specific development needs.
- Partner tools, built using Eclipse open-source technology, integrate with the WebSphere Studio environment to provide additional plug-ins for developers.

The WebSphere Studio product listed under Web development category are:

- Homepage Builder
- Studio Professional
- WebSphere Studio Site Developer Advanced

The WebSphere Studio products listed under the Application development and integration category are:

- WebSphere Studio Application Developer
- WebSphere Studio Application Developer Integration Edition
- WebSphere Studio Enterprise Edition
- WebSphere Studio Device Developer

The WebSphere Studio products listed under the RAD development category are:

- Versata Logic Suite

For more information on WebSphere Studio, go to the following Web site:

2.4.8 Host Access

The Web and its associated technologies offer you virtually unlimited ways to extend the reach of your business information. As a result, providing access to information stored on IBM iSeries, IBM zSeries and other back-end systems, such as UNIX, Microsoft Windows NT, and Microsoft Windows 2000 system-based servers, is more important than ever. Your critical business information and applications most likely reside on host systems such as these. The quantity and quality of your business information, combined with the reach of the Web, presents you with the opportunity to transform that information into a powerful competitive advantage.
Merging Web technology with your existing information systems defines e-business. IBM WebSphere Host Integration Solution offers industry-leading host access with unmatched flexibility for multiple environments. Leverage legacy data with new e-business solutions to help maximize your total return on investment.

IBM WebSphere Host Integration Solution is a single offering, providing a fast and cost-effective way to access, integrate and publish host information to Web-based clients and applications. This product portfolio integrates with and leverages the IBM WebSphere software platform. It comprises IBM software communication clients and servers, including:

- **IBM Personal Communications** is a professional emulation (fat client) that allows you to access the mainframe.
- **IBM WebSphere Host On-Demand** is a browser-based emulator installed on a server and accessed from a Web browser (thin client).
- **IBM Screen Customizer** is a simple graphical user interface using drag-and-drop technology.
- **IBM WebSphere Host Publisher** is a WebSphere application that extends host applications to Web browser users and new Web applications.
- **IBM WebSphere Application Server Advanced Edition** is a powerful deployment environment for Java applications and components.
- **IBM WebSphere Communications Server** includes SNA Gateways, TN3270E and TN5250 servers, security and support, optional carriers for Host Publisher.

To learn more about the Host Access products, go to the following Web site:


### 2.5 Reach and User Experience

Success is creating a single interactive user experience. Considering the various applications in existence and the numerous devices users interact with, this can be a tremendous challenge. Furthermore, customizing this user interaction, enabling full transactional support, and integrating back into multiple business systems adds another layer of complexity.
The WebSphere Reach and User Experience product family simplifies the process, allowing you to deliver user-centric interactions for customers, partners, and employees alike through portal interfaces across all of your business processes. Commerce offerings enable full transactional support and integrate with existing business systems. Expanding these user interactions for mobile access, providing a common experience throughout, delivers real value to e-business in the global and mobile marketplace.

Bringing the user experience together with back-end systems adds tremendous value for business. Yielding more effective collaboration and new business opportunities, Reach and User Experience family of products has a direct impact on your bottom line. From the user perspective, delivering a more complete and unified interactive experience through various devices results in higher customer loyalty.

The Reach and User Experience line of products creates a single interactive user experience that ties directly to your business systems. Enabling Foundation and Tools to build and deploy integrated applications, Business Integration to integrate applications and processes, and Transaction Servers and Tools to leverage existing software asset, the WebSphere portfolio truly delivers dynamic e-business.

2.5.1 Reach and User Experience: WebSphere Commerce

IBM WebSphere Commerce software helps you sell goods and services online to a global and mobile marketplace, implement B2C, B2B, or private exchange business models using open, industry-accepted standards, and confidently engage with IBM WebSphere’s proven technologies in next-generation e-commerce.

The WebSphere Commerce solutions are:

- **B2B e-commerce**: Make it easy for your customers and trading partners to do business with you today and to continue to do business with you tomorrow.
- **B2C e-commerce**: Move to the forefront of online retailing to global and mobile consumer markets.
- **Commerce-enabled portals**: Allow businesses to address multiple constituencies with personalization needs beneficial to both B2B and B2C commerce solutions.
- **IBM WebSphere Commerce for Digital Media**: Allows you to store, search, view, manage, collaborate, sell and download digital assets, reaching customers online around the world.
2.5.2 Reach and User Experience: WebSphere Portal

IBM WebSphere Portal for Multiplatforms provides a single point of interaction with dynamic information, applications, processes and people to help build successful business-to-employee (B2E), business-to-business (B2B), and business-to-consumer (B2C) portals. WebSphere Portal also supports a wide variety of pervasive devices enabling users to interact with their portal anytime, anywhere, using any device, wired or wireless.

WebSphere Portal consists of three packaged offerings: the Portal Enable offering is the base offering, and Portal Extend and Portal Experience both add more functionality. Refer to Table 2-1 on page 23 for a list of products included in each offering.

The WebSphere Portal Enable offering enables you to build scalable portals that simplify and speed a user's access to personalized information and applications.

The WebSphere Portal Extend offering allows your portal users to act on information and applications accessed by collaborating with other portal users. This offering includes all capabilities of the Enable offering, plus integrated team room, instant messaging, extended search, community and Web site analysis capabilities.

The WebSphere Portal Experience offering provides the capability for developing, deploying and maintaining enterprise portals. This solution includes all the capabilities of the Extend offering, plus advanced e-meeting, application sharing, enterprise content management, and enhanced security features.
Table 2-1  WebSphere Portal product matrix

<table>
<thead>
<tr>
<th>Enable</th>
<th>Extend</th>
<th>Experience</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSphere Application Server Advanced Edition V4.0.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>IBM Secureway Directory V3.2.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Personalization V4.0</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>DB2 Universal Database V7.2+Fixpack 5</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>WebSphere Studio Application Developer V4.02</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Web content publishing</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Collaborative Places</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Collaborative Components</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Extended Search R3.6</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tivoli Site Analyzer V4.1*</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Sametime R2.6 **</td>
<td>**</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Quickplace R2.5 **</td>
<td>**</td>
<td>X</td>
</tr>
<tr>
<td>IBM Content Manager V7</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tivoli Access Manager V3.9</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Enterprise Information Portal</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

*Formerly Tivoli Policy Director
**In Extend Sametime and Quickplace are limited portal use only.
**In Experience customers can use inside or outside of the portal.

Learn more about the WebSphere Portal offerings:


2.5.3 Reach and User Experience: Pervasive

Pervasive computing lets you deliver any information over any network using any device. Personalization features let you deliver the information in the user's language of choice or most suitable style for the task at hand (whether it's voice, touch, or sight).
With pervasive computing, business can leverage traditional, nontraditional, and embedded computing technologies - both wired and wireless - to enable, integrate, and extend e-business opportunities and new applications. IBM Pervasive Computing provides the software, hardware, and solutions to help businesses create applications and services for this new generation of computing devices.

Products in the IBM Pervasive Computing family are explained in the following sections.

**IBM WebSphere Everyplace Access**
Everyplace Access helps you to expand your Web infrastructure to support mobile solutions, including unified clients supporting connected and disconnected operations for today's leading handheld devices. Extend your e-business applications with features such as intelligent synchronization services, transcoding, mobile messaging, and location based services.

**IBM WebSphere Everyplace Server Enable Offering**
With this offering, you can take existing and new applications mobile while supporting current wireless devices and networks. Connect your applications to pervasive devices, adapt application content, optimize and scale applications, and provide tailored security and management services. The necessary software is integrated into this offering to easily install and deploy your mobile solutions.

**IBM WebSphere Everyplace Server, Service Provider Edition**
This product helps you to gain market advantage, increase customer loyalty, and enhance your revenue growth by providing the right information to your customers, employees, and partners at the right time anywhere, anytime.

**IBM WebSphere Translation Server**
The Translation Server expands your existing Web infrastructure by offering Web content to your users in their native languages, at a fraction of the cost of professional translation. You can provide Web pages, e-mail messages, and chat conversations in multiple languages and in real time.

**IBM WebSphere Voice Server**
You can extend your business solutions to customers without an Internet connection by allowing them to access Web information and conduct Internet transactions in a natural, user-friendly way - using their voices.
**IBM WebSphere Voice Server for Transcription**
This product integrates transcription (deferred recognition) services into your Web applications. Based on IBM's ViaVoice speech technology, it supports multiple users with multiple languages accessing services from a central location. Users dictate information with a microphone, handheld recorder, or a telephone, and Voice Server for Transcription converts the recorded audio into text using those users' personalized voice model.

**IBM WebSphere Voice Toolkit**
IBM helps you extend your e-business reach by offering integrated hardware, software, and services that support the convergence of voice and data by using open standards-based VoiceXML technology.

**IBM WebSphere Voice Response for AIX**
You can extend your services with this highly scalable and reliable solution. Voice Response for AIX is ideal for organizations with high call volumes such as Telcos and call centers, allowing for robust, 24x7 continuous operation.

**IBM WebSphere Voice Response for Windows NT and Windows 2000**
With this product, you can improve customer satisfaction by reducing the time your customers need to wait for service. Now you can develop applications that answer and screen large numbers of calls simultaneously without an agent.

**IBM WebSphere Voice Response Beans**
With Voice Response Beans, you can develop interactive voice response applications that work with any WebSphere Voice Response product on AIX or Windows using popular Java technology. IBM WebSphere Voice Response Beans are fully compatible with the JavaBeans specification.

**IBM Message Center**
The Message Center can improve your customer's experience with a unified messaging solution that manages employee and customer voice mail, e-mail and faxes, allowing access virtually anywhere and anytime over the telephone or the Internet.

**IBM MQ Everyplace**
MQ Everyplace provides an assured messaging infrastructure on devices with small footprints and optimized communication protocols. MQ Everyplace offers functionality tailored to mobile devices, including both synchronous and asynchronous messaging support, local and remote queue access, direct and indirect routing, rock-solid security and extensive customization capabilities.
**IBM WebSphere Edge Server**
The Edge Server controls and enables application-aware networks by providing an integrated solution for load balancing, static and dynamic caching, application offload, content distribution, enhanced security, and transactional quality of service all under centralized administrative and application control.

**IBM WebSphere Transcoding Publisher**
You can extend your user’s experience by dynamically adapting, reformatting and filtering Web content and applications to make them optimally suited for mobile devices such as telephones, personal data assistants (PDAs), and pagers.

**IBM WebSphere Everyplace Mobile Connect**
Mobile Connect allows your users to directly transfer information from multiple handheld devices directly to corporate systems, without the need to synchronize via a PC. They can enable two-way relational database synchronization, two-way file transfer, and the remote installation of applications. Your users can directly synchronize with Lotus Notes and Microsoft Exchange for server based synchronization of e-mail, calendars, contacts and tasks.

**IBM WebSphere Everyplace Portal**
The Everyplace Portal ensures that your employees, Business Partners and customers have access to the specific information they need, when they need it, while filtering out everything else. Users sign on to your portal and have immediate access to personalized Web pages.

For more information visit the following Web site:


### 2.6 Business Integration

For connecting and integrating assets within the enterprise and with trading partners, WebSphere offerings such as WebSphere MQ make it easy to connect to any commercial systems in business today.

The Business Integration product families are:

- Process Integration
- Application Connectivity

In this section, we concentrate on both the WebSphere CrossWorlds and MQ family of products.
IBM is uniquely positioned to deliver the most comprehensive business integration. While competitors are limited to niche integration, IBM is the only vendor that can provide comprehensive leadership in integration with offerings that work seamlessly together:

- WebSphere Event Broker V2.1 extends application connectivity leadership by delivering real-time, event-based information to people, applications, and devices.
- The WebSphere Business Integration offering includes IBM CrossWorlds and WebSphere MQ technologies, enabling companies to automate business processes that integrate multiple applications.
- Major industries editions, with prebuilt process collaborations and application adapters, are available for telecommunications, retail distribution, insurance, automotive and electronics.
- WebSphere portal, commerce and mobile access offer pre-built capabilities that enable significantly lower technology implementation costs and deliver real business value more quickly for user interaction.
- WebSphere messaging middleware and enterprise application integration is recognized as the industry leader that enables application connectivity.
- IBM CrossWorlds completes WebSphere's process integration portfolio with industry-leading functionality, while helping to preserve customer investments.
- WebSphere's Foundation and Tools product family leverages Web services and existing software assets, delivering comprehensive J2EE development and deployment capabilities, all necessities when you build to integrate.

IBM data management leads the industry in addressing customers' desires to unify structured, semi-structured, and unstructured information for cost-effective information integration.

### 2.6.1 Business Integration: Process Integration

The IBM WebSphere Process Integration product family allows you to model and automate business processes across disparate systems and organizations. Process Integration is often at the heart of many business and technology initiatives such as connecting to a B2B exchange, taking a product or service online, standardizing customer information or integrating a newly purchased application. The bottom line is that integrated processes make it easier to implement business strategy.
Process and workflow management
Companies want to integrate and manage high-level business processes that involve multiple people and applications across functional areas. There are two parts to this:

1. The ability to model processes, analyze them and identify ways to improve them (cut costs or time) is central. Key functions are:
   - Model business processes
   - Analyze business processes
   - Monitor business processes
   - Optimize business processes

2. Companies need a way to take these process models and actually automate the process (generate to-do lists for employees, route documents for approval). Critical features include:
   - State management
   - Data persistence
   - Manual intervention "in" events
   - Centralized execution
   - "Intelligent" assignment of tasks
   - Event dependencies

Products:
- **WebSphere MQ Workflow** provides capabilities to design, document, execute, control, improve, and optimize the business processes, so you can focus on your company's business goals.
- **Holosofx** enables you to rapidly define and model business processes, as well as execute processes across people, departments, and systems in a consistent and cost-effective way.

Process automation
You need a way to rapidly automate distinct steps within a broader enterprise process - for example, eliminate the need for manual data entry during the order process. Plus you need to easily manage business objects (for example, customer, item, order information) across various systems and applications and automate the synchronization of information both inside and outside your company's firewall.

Key functions:
- Automate individual steps in a business process
- Real-time synchronization and management of enterprise data
- Data integrity
Critical features:
- Flexible built-in object management
- Compensation model
- Object Relationship Management
- Cross-referencing
- Powerful mapping/transformation
- Event Sequencing
- Error detection and handling

Products:
IBM CrossWorlds provides sophisticated business object management and process automation capabilities. IBM CrossWorlds' patented Common Object Model, industry templates, extensive connectivity, and object management runtime environment enable faster and easier integration. Use it to quickly automate individual steps within a process as well as streamline processes for competitive advantage.

Business integration with IBM CrossWorlds
More leading companies are selecting IBM CrossWorlds technology to tie customer data together, automate business processes and link to Business Partners over the Internet. As part of the WebSphere platform, IBM CrossWorlds offers process integration solutions that easily extend with other IBM products, helping maximize your company's flexibility to make you more competitive.

IBM CrossWorlds delivers a comprehensive integration solution with functionality that spans Enterprise Application Integration (EAI) and Business-to-Business Integration (B2Bi). From linking two applications or systems together to establishing an enterprise-wide standard integration infrastructure integrating and automating business processes, IBM CrossWorlds can help you with your present and future integration challenges.

The IBM CrossWorlds solution consists of the following components:
- **IBM CrossWorlds InterChange Server** for a sophisticated runtime environment and managing business objects and processes.
- Pre-built Collaborations (predefined business logic templates) that graphically define and automate process steps for common industry-specific processes, such as Telco order management and manufacturing bill of materials management.
- Easy-to-use graphical development environment and tool set for rapid, end-to-end development, deployment, and maintenance of Collaborations, business objects, and connectors.
- Connectors for fast integration with out-of-the-box access to many commonly used packaged applications.
For the full list of CrossWorlds Collaborations, visit:


IBM CrossWorlds Tools
This is a full set of intuitive, visual, and easy-to-use tools to provide customers both administrative and development support for system management, application connectivity, and business process modeling. Included in the IBM CrossWorlds Full Toolset are:

- IBM CrossWorlds System Manager
- IBM CrossWorlds LogViewer
- IBM CrossWorlds Process Designer
- IBM CrossWorlds Business Object Designer
- IBM CrossWorlds Object Discovery Agent Development Kit (ODK)
- IBM CrossWorlds Map Designer
- IBM CrossWorlds Relationship Designer
- IBM CrossWorlds Relationship Manager
- IBM CrossWorlds Connector Development Kit (CDK)

IBM CrossWorlds Connectors
The connectivity options are listed below. For in-depth information, click on this link for a Comparison of IBM CrossWorlds Connectors to typical adapters.

**Connectivity - e-business**
- IBM CrossWorlds Serverless Trading Agent
- IBM CrossWorlds Access Framework
- IBM CrossWorlds Access Framework for Enterprise JavaBeans
- IBM CrossWorlds Connector for Web Services
- IBM CrossWorlds Trading Partner InterChange On-Ramp
- IBM CrossWorlds Trading Partner InterChange for Trading Networks
- IBM CrossWorlds Trading Partner InterChange for ASPs and Exchanges
- IBM CrossWorlds Trading Partner InterChange Solo
- IBM CrossWorlds Resource Adapter for InterChange Server
- IBM CrossWorlds XML Data Handler
- IBM CrossWorlds EDI Data Handler 1.1.1

**Connectivity - applications**
- IBM CrossWorlds Connector for BroadVision 4.1
- IBM CrossWorlds Connector for BroadVision 5.0
- IBM CrossWorlds Connector for BroadVision 5.5
- IBM CrossWorlds Connector for Clarify 8
- IBM CrossWorlds Connector for Clarify 8.1
- IBM CrossWorlds Connector for Clarify 8.5
IBM CrossWorlds Connector for Clarify 9
IBM CrossWorlds Connector for Clarify 10
IBM CrossWorlds Connector for i2 Active Data Warehouse 4.x
IBM CrossWorlds Connector for i2 Active Data Warehouse 5.x
IBM CrossWorlds Connector for MetaSolv TBS 4.x
IBM CrossWorlds Connector for MetaSolv TBS 5.x
IBM CrossWorlds Connector for Oracle Applications 11i
IBM CrossWorlds Connector for Oracle Applications 11
IBM CrossWorlds Connector for Oracle Applications 10.7
IBM CrossWorlds Connector for PeopleSoft 8.x
IBM CrossWorlds Connector for PeopleSoft 7.x
IBM CrossWorlds Connector for Portal Infranet 6.1
IBM CrossWorlds Connector for SAP R/3 3.x
IBM CrossWorlds Connector for SAP R/3 4.50 to 4.60
IBM CrossWorlds Connector for Siebel 2000
IBM CrossWorlds Connector for Trilogy 3.0
IBM CrossWorlds Connector for Vantive 7.0
IBM CrossWorlds Connector for Vantive 8.x

**Connectivity - technology**
- IBM CrossWorlds Connector for JMS
- IBM CrossWorlds Connector for e-Mail
- IBM CrossWorlds Connector for FIX Protocol (Financial Information eXchange)
- IBM CrossWorlds Connector for MQSIV2
- IBM CrossWorlds Connector for XML
- IBM CrossWorlds Connector for IBM MQSeries
- IBM CrossWorlds Connector for Jtext
- IBM CrossWorlds Connector for JDBC
- IBM CrossWorlds Connector for IBM MQSeries Workflow
- IBM CrossWorlds Connector for SWIFT 1.0

**Connectivity - mainframe**
- IBM CrossWorlds Mainframe Connector for CICS
- IBM CrossWorlds Mainframe Connector for IMS Transaction Manager
- IBM CrossWorlds Mainframe Connector for IMS Database
- IBM CrossWorlds Mainframe Connector for VSAM
- IBM CrossWorlds Mainframe Connector for DB2
- IBM CrossWorlds Mainframe Connector for ADABAS

**IBM CrossWorlds implementation**
The IBM CrossWorlds system is a suite of software integration products that supply connectivity for leading e-business technologies and enterprise applications. The system includes:
The IBM CrossWorlds documentation describes how to install, start up, and set up the IBM CrossWorlds system. In addition, it describes the features and components common to all installations, and includes reference materials on specific collaborations and connectors.

The documentation is available to consultants and system administrators who install, deploy and administer the IBM CrossWorlds system in a Microsoft Windows NT or Microsoft Windows 2000 environment.

To access the documentation, go to the directory where you installed the IBM CrossWorlds product and open the documentation subdirectory. If a welcome.html file is present, open it for hyperlinked access to all documentation. If no documentation is present, you can install it or read it directly from the IBM CrossWorlds documentation Web site:

http://www.ibm.com/websphere/crossworlds/library

### 2.6.2 Business Integration: Application Connectivity

The WebSphere Application Connectivity products provide flexible and reliable links between applications.

IBM WebSphere MQ (formerly known as IBM MQSeries) is responsible for dynamic integration. As a member of the WebSphere software platform for e-business, WebSphere MQ is a fundamental player in conducting dynamic e-business. Other MQSeries products will be renamed as part of the WebSphere family with each new release.

When information technology is applied to improving the business, the result is often a collection of independent systems, each addressing the needs of one aspect of the business. Unfortunately, the real business doesn't operate in neatly partitioned silos, and so the problem that remains is how to connect IT systems so that information flows without requiring expensive, slow, and error-prone human involvement. Building reliable links that are flexible enough to accommodate the inevitable changes to systems and business requirements can be difficult and expensive.
WebSphere MQ (formerly MQSeries)

WebSphere MQ, the de facto standard in messaging middleware, connects applications through a simple consistent programming interface or non-invasive adapters on over 35 platforms across all of the major networking systems. WebSphere MQ allows systems to operate independently, but assures delivery of information. The latest version adds a number of new features including message encryption through SSL for extra security, enhanced performance and further exploitation of zSeries hardware features for total resilience. Because of its reliability and robustness, WebSphere MQ is used in mission-critical, high-value solutions across all industries today. For more information, visit:


WebSphere MQ Everyplace

WebSphere MQ Everyplace (formerly known as MQSeries Everyplace) extends application connectivity to mobile devices with the same robustness and reliability available for traditional applications. It provides functionality particularly suited to lightweight platforms, devices and unmanaged networks, and is the ideal way to implement application connectivity in a world of fragile communications. For more information, go to:


WebSphere MQ Brokers

With WebSphere MQ Brokers, you can easily scale up your integration solution to potentially thousands of connected systems, even reaching out across the Internet, wireless devices, and telemetry devices. WebSphere MQ Event Broker can distribute messages to applications that register an interest in certain message topics or content. The broker forwards messages only to applications that have registered their interest, thereby conserving network bandwidth, and exerts centralized and granular control over dissemination of information to only those appropriately privileged recipients. WebSphere MQ Integrator Broker (formerly known as IBM MQSeries Integrator) provides an entry-level solution to manipulate messages as they are routed so that applications are unaware of each other's data formats. One application can be upgraded or replaced without affecting any others by reconfiguring the broker. WebSphere MQ Integrator Broker is a powerful information broker that applies business-based reasoning on message-based data, enabling intelligent routing that selects and distributes information to the applications, databases, and people who need it. Building a solution with the scalability and flexibility of WebSphere MQ Brokers would cost many times their license price. For more information, visit the following Web site:

WebSphere Data Interchange
To handle the specific requirements of EDI message formats, there is IBM WebSphere Data Interchange. This product works with the WebSphere MQ family of products to transform between all of the current EDI standards, XML, and user-defined formats. WebSphere Data Interchange helps you to take advantage of new, more cost-effective approaches to EDI, such as EDI-INT, by linking your existing EDI-aware applications to new solutions. For more information, visit the following Web site:


WebSphere connectors and adapters
A key element in any business integration is the code that enables data to move between an application and the underlying transport infrastructure and hence to communicate with other applications. This enabling code is referred to as a connector or adapter, the latter term usually implying that some transformation of the data is also involved. IBM provides a variety of adapters, in some cases supplemented by reselling offerings from other vendors. Toolkits are also available for people wanting to build their own adapters or connectors within the given framework. IBM CrossWorlds Connector and IBM WebSphere Adapter software makes connecting to application packages even easier. For more information, visit the following Web site:


Process Integration
With greater access to information within applications comes the opportunity to change the way your IT systems support your business. By capturing business processes - the sequences of actions that applications and people perform - and by using WebSphere software to help you take control of those processes, your business can become more efficient and agile. With a dynamic WebSphere MQ e-business solution, you can update processes without having to change the resources you use today. For more information, visit the following Web site:

2.7 Transaction Servers and Tools

Success is achieved by capitalizing on existing investments. As new technology revolutionizes the way people work and interact, companies are left wondering what they will do with their traditional software assets: the existing systems, applications, and data that run their businesses today. Representing significant capital investments, these proven systems are relied upon every day to keep the business running smoothly. Yet, companies may not be leveraging these existing assets to achieve dynamic e-business.

WebSphere Transaction Servers and Tools provide the products and offerings needed to integrate traditional core assets into a new technology infrastructure. It updates existing systems and leverages applications by transforming them into e-business components that can result in a new integrated e-business solution.

Leveraging core applications to drive success today provides a competitive advantage over the risks, costs, and longer implementation time associated with developing new applications. You can reduce e-business adoption time frames with shorter development and test times, while providing a common tool set to enhance development skills for both Web and legacy developers.

Transaction Servers and Tools enhance your e-business by leveraging existing software assets to create dynamic e-business components. The WebSphere portfolio delivers dynamic e-business by enabling Foundation and Tools to build and deploy integrated applications, Business Integration to integrate applications and processes, and Reach and User Experience to provide a single interactive user experience.

2.7.1 Transaction Servers and Tools: Enterprise Modernization

Enterprise Modernization addresses a significant integration issue: how to leverage and integrate traditional core assets, which are the existing systems, applications, and data that run businesses today. These are the systems that are proven, reliable and are counted on daily to keep the business running smoothly. Yet, these systems may not be entirely applicable to the new e-business requirements. Enterprise Modernization offers tools and services to update your existing systems and leverage the applications by transforming them into e-business components that can then be built into a new integration-ready e-business solution. Reusing the applications that are running the business provides shorter development and test times, and provides the qualities of service that IBM enterprise customers count on to ensure a smooth-running business.
Today's e-business demands speed. To meet business objectives, it's critical that diverse development groups across your enterprise are enabled to deliver high-quality applications in record time, communicate effectively, and work together efficiently to meet goals. These groups need the technology and a collaborative environment that enable them to share common tools, application components, and practices, so they don't duplicate efforts. Your entire team can work smarter, helping you reduce development time and save money. But if you're still relying on mainframe computers to run your core business processes, as many companies do, your developers and programmers can be tied to disparate, independent systems. These enormous, complex systems might be more than 20 years old, but contain vast, rich stores of valuable data, including historical business data, customer information, and legacy application code. To harvest and leverage - not lose - your wealth of business information, and to extend your information technology (IT) investments, you need to tap into those resources.

Enterprise Modernization is the reuse of core business assets to accelerate new e-business application development. With Enterprise Modernization you can:

- Leverage existing systems, applications and skills to create dynamic e-business with excellent returns on investment.
- Reduce the e-business adoption time frame for competitive advantage.
- Bridge the development skills gap with a common tool set for both Web and Legacy programmers.

IBM Enterprise Modernization solutions leverage IBM WebSphere software to help you develop the process, tooling, and infrastructure you need to strategically transform your enterprise so you can effectively compete in the world of e-business. With technology and tools that enable quick, tight integration of back-end systems, fast migration of core process applications, and advanced Web application development, IBM can help you stay in step with the pace of change.

The Enterprise Modernization products are:

- WebSphere Host Integration Solution
- WebSphere Studio Enterprise Developer
- WebSphere Studio Asset Analyzer
- WebSphere Developer Studio for iSeries
- CICS Transaction Gateway

For information, visit the following Web site:

2.7.2 Transaction Servers and Tools: transaction processing

Today’s transaction processing software embraces the world of e-business, enabling customers to rapidly adapt to changing needs while maintaining the integrity of their core business systems.

The heritage and rock-solid reliability of IBM transaction servers and transaction processing software is well known in the industry. With over 490 of IBM’s top 500 customers relying on IBM’s transaction processing software to run their businesses, these and many more customers are assured of high-volume transaction processing with products such as IBM’s CICS Transaction Server for zSeries and S/390, IMS, TPF and TXSeries for Multiplatforms.

IBM’s transaction processing software can handle more than 30 billion transactions per day, processing more that $1 trillion in transactions. With support for over 900,000 concurrent users, these highly scalable, reliable solutions provide affordable 24/7 availability.

The Transaction Processing products are:
- CICS Transaction Server
- CS for OS/390
- TXSeries for Multiplatforms
- TPF

For information, visit the following Web site:

2.7.3 Transaction Servers and Tools: traditional tools

IBM provides a wide array of enterprise application development and operational tools to help improve user productivity and effectiveness during the development, testing, and production stages for both new and existing applications. These tools provide the potential of lowering the total cost of operation for z/OS and OS/390 customers.

IBM is continually offering new products and tools to address your needs throughout the development cycle:
- Discovery, where applications are designed, built, and integrated.
- Quality assurance, where applications are debugged and tested prior to being deployed.
- Production, where applications are monitored.
By helping to shorten the development cycle and offer seamless application deployment, IBM tools are well situated to help you create and maintain a competitive advantage in the world of e-business, as well as lower the total cost of operation.

The traditional tools are:

- Application Monitor for z/OS and OS/390
- Workload Simulator for z/OS and OS/390
- Debug Tool for z/OS and OS/390
- Fault Analyzer for z/OS and OS/390
- File Manager for z/OS and OS/390
- CICS Performance Analyzer
- CICS Interdependency Analyzer
- CICS Online Transmission Time Optimizer
- COBOL Family
- COBOL for OS/390 and VM
- COBOL for VSE
- COBOL Set for AIX
- Enterprise COBOL for z/OS and OS/390
- VisualAge COBOL
- VisualAge C++
- VisualAge Enterprise Suite
- VisualAge Generator
- VisualAge for Java
- VisualAge Pacbase
- VisualAge PL/I
- VisualAge Smalltalk
- WebSphere Studio Enterprise Developer
- WebSphere Studio Asset Analyzer

For information visit the following Web site:

2.8 Distributed computing and WebSphere Application Server

WebSphere Application Server provides an environment for open distributed computing. Users and processes on a wide variety of platforms can interact by using the facilities provided by WebSphere. Both the Advanced Edition and the Enterprise Edition of the WebSphere Application Server provide a distributed computing environment. This section provides an overview of the basic concepts involved in distributed computing.

2.8.1 Three-tiered client/server computing

A common way of organizing software to run on distributed systems is to separate functionality into two parts, clients and servers. A client is a program that uses services provided by other programs called servers. The client makes a request for a service, and a server performs that service. Server functionality often involves some sort of resource management, in which a server synchronizes and manages access to the resource, responding to client requests with either data or status information. Client programs typically handle user interactions and often request data or initiate some data modification on behalf of a user.

For example, a client can provide a form on which a user (a person using a Web browser, for example) can enter orders for a product. The client sends this order information to the server, which checks the product database and performs tasks needed for billing and shipping. A single server is typically used by multiple clients. For example, dozens or hundreds of clients can interact with a handful of servers that control database access.
A common design of client/server systems uses three tiers: a client that interacts with the user, an application server that contains the business logic of the application, and a resource manager that stores data. This approach is shown in Figure 2-1. In this model, the client is isolated from having to know anything about the actual resource manager. If you change the database you are using, the server may have to be modified, but the client does not need to be modified. Because there are usually fewer copies of the server than the client, and because the servers are often in locations that are easier to update (for example, on central machines rather than on PCs running on users' desks), the update procedure is also simplified. Furthermore, this approach provides additional security. Only the servers, not the clients, need access to the data controlled by the resource manager.
WebSphere Application Server provides the middle tier in this architecture, allowing clients (applets, Visual Basics clients, C++ clients, and so on) to interact with data resources (relational databases, MQSeries, and so on) as well as with existing applications. This architecture is also used by two major components of WebSphere Application Server Enterprise Edition: Component Broker and TXSeries.

2.8.2 Transactions

A transaction is a set of operations that transforms data from one consistent state to another. This set of operations is an indivisible unit of work, and in some contexts a transaction is referred to as a logical unit of work (LUW). A transaction is a tool for distributed systems programming that simplifies failure scenarios.

Transactions provide the ACID properties:

- **Atomicity**: A transaction’s changes are atomic: either all operations that are part of the transaction happen, or none happen.
- **Consistency**: A transaction moves data between consistent states.
- **Isolation**: Even though transactions can run (or be executed) concurrently, no transaction sees another's work in progress. The transactions appear to run serially.
- **Durability**: After a transaction completes successfully, its changes survive subsequent failures.

As an example, consider a transaction that transfers money from one account to another. Such a transfer involves deducting money from one account and depositing it in another. Withdrawing the money from one account and depositing it in the other account are two parts of an atomic transaction: if both parts cannot be completed, neither must happen. If multiple requests are processed against an account at the same time, they must be isolated so that only a single transaction can affect the account at one time. If the bank's central computer fails just after the transfer, the correct balance must still be shown when the system becomes available again: the change must be durable. Note that consistency is a function of the application; if money is to be transferred from one account to another, the application must subtract the same amount of money from one account that it adds to the other account.

Transactions can be completed in one of two ways: they can commit or roll back. A successful transaction is said to commit. An unsuccessful transaction is said to roll back. Any data modifications made by a rolled-back transaction must be completely undone. In the above example, if money is withdrawn from one
account but a failure prevents the money from being deposited in the other account, any changes made to the first account must be completely undone. The next time any source queries the account balance, the correct balance must be shown.

A distributed transaction is one that runs in multiple processes, usually on several machines. Each process works for the transaction.

Distributed transactions, such as local transactions, must adhere to the ACID properties. However, maintaining these properties is greatly complicated for distributed transactions because a failure can occur in any process, yet even in the event of such a failure, each process must undo any work already done on behalf of the transaction.

A distributed transaction processing system maintains the ACID properties in distributed transactions by using two features:

- **Recoverable processes**
  Recoverable processes log their actions and thus can restore earlier states if a failure occurs.

- **A commit protocol**
  A commit protocol enables multiple processes to coordinate the committing or aborting of a transaction. The most common commit protocol, and the one used throughout WebSphere Application Server, is the two-phase commit protocol.

### 2.8.3 Security

When enterprise computing was handled solely by a few powerful mainframes located in information systems (IS) sites, ensuring that only authorized users obtained access to computing services and information was a fairly straightforward task. In distributed computing systems, where users, application servers, and resource managers can be spread out across the world, securing computing system resources has become a much more complicated task.

Although there are many issues associated with providing security in a distributed computing system, the underlying issues have not really changed very much. A good security service provides two main functions: authentication and authorization.
Authentication takes place when a principal (a user or a computer process) initially attempts to gain access to a computing resource. At that point, the security service challenges the principal to prove that the principal is who it claims to be. Human users typically prove who they are by entering their user IDs and passwords; whereas a process normally presents an encrypted key. If the password or key is valid, the security service gives the user a token or ticket that identifies the principal and indicates that the principal has been authenticated.

After a principal is authenticated, it can then attempt to use any of the resources within the boundaries of the computing system protected by the security service; however, a principal can use a particular computing resource only if it has been authorized to do so. Authorization takes place when an authenticated principal requests the use of a resource and the security service determines if the user has been granted the privilege of using that resource. Typically, authorization is handled by associating access control lists (ACLs) with resources that define which users or processes (or groups of users or processes) are authorized to use the resource. If the principal is authorized, the principal gains access to the resource.

In a distributed computing environment, principals and resources must be mutually suspicious of each other's identity until both have proven that they are who they say they are. This is necessary because a principal can attempt to fake its identity to get access to a resource, and a resource can be a Trojan horse, attempting to get valuable information from the principal. To solve this problem, the security service contains a security server that acts as a trusted third party, authenticating principals and resources so that these entities can prove their identities to each other.

### 2.9 Competitive comparison

In Table 2-2 are the strengths of IBM's competitors and the differentiators that set IBM apart from the group.
<table>
<thead>
<tr>
<th>Competitive Strengths</th>
<th>IBM Differentiators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft:</strong></td>
<td><strong>Unrivaled multiplatform support</strong></td>
</tr>
<tr>
<td>▶ Addresses all states of e-business adoption</td>
<td>▶ Supports open standards and open versions of XML</td>
</tr>
<tr>
<td>▶ Portfolio of solution packages (for example, Application Center)</td>
<td>▶ Most comprehensive portfolio</td>
</tr>
<tr>
<td>▶ Existing OS/IIS install base - de facto standard</td>
<td>▶ More secure platform</td>
</tr>
<tr>
<td>▶ Extensive partnerships</td>
<td>▶ IBM offers anytime, anywhere, any language support 24X7</td>
</tr>
<tr>
<td>▶ Army of developers building on their platform</td>
<td>▶ Flexibility of choice of industry-standard Web servers on all platforms</td>
</tr>
<tr>
<td>▶ Strategy to deliver a suite of hosted applications</td>
<td></td>
</tr>
<tr>
<td>▶ Dominant vendor in small and low-medium segments, targeting larger enterprises</td>
<td></td>
</tr>
<tr>
<td><strong>BEA:</strong></td>
<td><strong>Comprehensive middleware solution</strong></td>
</tr>
<tr>
<td>▶ Ease of download and install</td>
<td>▶ Full support for zSeries and Linux</td>
</tr>
<tr>
<td>▶ Broad range of partnerships</td>
<td>▶ Lower TCO and vertical scalability</td>
</tr>
<tr>
<td>▶ Aggressive Web-lead follow-up</td>
<td></td>
</tr>
<tr>
<td><strong>Oracle:</strong></td>
<td><strong>Single applications server for all environments</strong></td>
</tr>
<tr>
<td>▶ Leveraging their database leadership</td>
<td>▶ Develops applications in wide range of environments</td>
</tr>
<tr>
<td>▶ Application offerings targeted at SMB</td>
<td>▶ Runs on a wide range of platforms</td>
</tr>
<tr>
<td>▶ Targeting with aggressive pricing and promise of quick ROI</td>
<td>▶ Full support for a broad range of databases</td>
</tr>
</tbody>
</table>
IBM and ISV e-business applications and offerings

This chapter provides information to help you seek the appropriate e-business solution to address the needs of your customers.
3.1 Setting the stage and foundation for stages of e-business adoption

Over the past year, IBM has done a lot of work understanding and identifying how customers are adopting e-business technologies to meet their tactical and strategic long-term business needs and requirements. IBM has worked with McKenna Group and some of its internal market research resources to interview over 21,000 customers to understand their e-business processes and associated systems to support their customer's changing business strategies and tactics.

They categorized e-business adoption into six distinct stages:

- There is an initial state of Web access, with users just accessing the Internet to find information. However, this is not a real use of e-business.
- The first real step of e-business is Web publishing, using the Web as a marketing channel for information about the company and/or its products, etc. and making that available to the outside world.
- The second stage is called e-business transactions, where external users, through Web applications, are allowed to connect to applications and data that were previously reserved for internal users. These transactions involve full update mode, full read/write modes, and read-only modes.
- The third stage is where companies start to focus more and more on internal integration, optimizing their internal processes to make sure that as their processes become more visible to the outside world, they become increasingly more integrated and more effective.
- Stage 3 evolves into stage 4, external integration or creation of value networks, which are external application integration points where companies work together with other companies to deliver more value to their customers than they would be able to do alone.
- Where we see all this evolving towards is a model we call dynamic e-business. Dynamic e-business is a business model where a company can focus on its core activity and outsource all surrounding activities in a dynamic fashion over the Internet - this is the ability for one application to communicate with another application function over an Internet network and leverage and integrate with that application function. Basically what we're seeing is a long-term trend towards digital businesses, the creation of increasingly more automated and more integrated business processes that are transforming the way business is done right now.
The business scenarios outlined in this guide are targeted at these stages of e-business adoption, using the stages as a foundation, and expressed as solution scenarios that map out to different customer pains from a business consultative perspective. A “Whole Product Concept” incorporates everything that a customer needs to achieve the business goals that drive its purchase decisions, including consultation, design, configuration, implementation, OEM products and services, and on-going support.

What does all this “road to e-business” and “stages of e-business adoption” mean from a “requirements for Web applications” perspective?

Web applications will evolve from just doing static Web serving and e-mail with limited use of dynamic content into applications where there is increasingly more of a separation of business logic and presentation logic and higher degrees of transactional integrity and integration with databases or existing transaction systems. As we move into the stage of internal integration, we see the need for applications that can coordinate transactions between different in-house applications, and this need evolves into the coordination of transactions between in-house and external applications. As we move into the world of dynamic e-business, there is a need for applications that can coordinate transactions between in-house applications and outsourced applications that are linked dynamically.

We clearly see a trend towards increasingly intelligent transactions. Transactions that can coordinate resources across a variety of systems and that can be long lived, not just a couple of seconds, and can actually take weeks or even months to complete. They’re also self-conscious. Transactions that contain decisions on business logic as to which external provider should be leveraged in certain scenarios, for example. Being able to develop these intelligent transactions will require much more integration work, tied together systems, applications, databases, etc., and all of this relies on a real solid e-business infrastructure for all of these transactions to perform appropriately.

### 3.1.1 Whole Product Concept

The Whole Product Concept is based on everything the customer needs to achieve its business goals that drive its purchase decisions. It includes not only the core technology, products and services you offer, but the on-going support and third-party products and services necessary to solve the customer’s business problem.
3.1.2 Business scenario: Getting started in e-business

This business scenario applies to customers just getting started or customers moving from stage 1 to stage 2 of e-business adoption and the recommended product for this particular situation.

In the early stages of e-business adoption, the WebSphere Application Server Express V5 is the product that best meets their current needs while at the same time providing a platform of products that will grow as they grow.

The WebSphere Application Server Express V5 is for customers that need to provide a more valuable experience for their customers as well as more efficient business processes, thereby attracting new customers, growing customer loyalty, and reducing operating expenses.

This scenario applies to customers looking for a solution that will:

- Enable simple integration between their back-end business systems and Web sites
- Provide a total solution that meets their specific needs
- Allow them to implement this solution with their resources and skill base currently in house
- Provide them with the most value for their money on a solution and total cost of ownership basis

Why WebSphere Application Server Express V5?

IBM’s experience as one of the leading database providers makes it uniquely able to build a smooth link between core business systems and Web sites.

The WebSphere Application Server Express V5 includes an application server, development tools, and application technology such as customized end-user experiences, cataloging, and search capability, all paired with award-winning IBM support and three years of product updates.

It allows application development through JavaScript and wizards and requires no administration of the application server resulting in self implementation and easy maintenance. In addition, WebSphere Application Server Express V5 includes basic applications for immediate functionality, everything you need to get up and running to provide an immediate return on investment with no new skills development necessary.
Chapter 3. IBM and ISV e-business applications and offerings

### Table 3-1  Getting started in e-business

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting started in e-business</td>
<td>▶ Primary = SMB ▶ Secondary = departments in large enterprises</td>
<td>Customers just getting started -or- Customers moving from stage 1 to stage 2 of e-business adoption</td>
<td>Multiple offerings - hardware platform dependent 1. pSeries: StartNow based 2. pSeries: WDS, CA, iSeries wireless 3. zSeries</td>
<td>WebSphere Application Server AEs</td>
</tr>
</tbody>
</table>

**Key message:** WebSphere Application Server Express V5.0 has everything you need to get up and running with dynamic Web site development and deployment

**Value proposition:** With WebSphere Application Server Express V5.0, you realize an immediate return on your investment by being able to utilize the resources and skill base you currently have.

### 3.1.3 Business scenario: Dynamic e-business

This business scenario applies to the building of Web applications that include the integration to a relational database, usually only requiring a single server environment.

This scenario may include two-way transactions, integrate to back-end data sources, with a focus on high-performance and scalability. Can and often does includes more than one application server requirement with fail-over and high availability a business requirement. Other requirements by the customer could include the need to personalize and customize the user’s experience during Web transaction.
Table 3-2  Dynamic e-business

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic e-business</td>
<td>Primary = Large and SMB</td>
<td>Customers/ISVs that need infrastructure upon which to build dynamic and transactional applications (stages 2a and 2b)</td>
<td>WebSphere Application Server AEs/AE, WebSphere Studio Application Developer, DB, WCM</td>
<td>Personalization, Portal, performance tools, Edge, Site analyzer</td>
</tr>
</tbody>
</table>

**Key Message:** WebSphere Application Server, V5.0 is a market-leading J2EE 1.3 compatible application server offering the highest quality of service and flexible deployment options.

**Value proposition:** Improve time-to-value by building new integration-ready applications which leverage existing software assets.

### 3.1.4 Business scenario: High-volume Web site

This business scenario applies to customers whom business requirements dictates a fast transaction occur, with a demand for transactions that would fluctuate by use and the type of information needed. The solution would need to be able to provide a more guaranteed response time regardless of the time of day, or number of users.

WebSphere Application Server is a proven high-availability enterprise application platform ready today for 7x24 operations. WebSphere Application Server scales horizontally and vertically to leverage native features of enterprise platforms. Integrated Edge Server functionality provides extreme scalability of Web applications with advanced workload management and caching across LANs and WANs. Support for enterprise databases and transactions adds a further dimension to WebSphere Application Server's scalability. WebSphere Application Server vertical scalability on a single JVM can take advantage of up to 24 CPUs on a single box.

eBay is a recent WebSphere Application Server high-volume Web site success story.

WebSphere Application Server, V5.0 offers:
Dynamic WLM
- Broad operating system platform support
- Single application server with multiple deployments
- Load balancing advisors and consultants
- Application profiling
- Tivoli performance viewer
- Dynamic caching
- Content Distribution Framework
- High availability LDAP
- Multi domain availability failover
- Transactional QoS

Table 3-3  High-volume Web site

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-volume Web site</td>
<td>Primary = Large enterprise</td>
<td>Customers in stages 2 through 4 of e-business adoption requiring a high performance, scalable infrastructure</td>
<td>WebSphere Application Server AE, WebSphere Studio Application Developer, DB, Edge, WCM</td>
<td>Portal, Personalization, Performance tools</td>
</tr>
</tbody>
</table>

Key Message: WebSphere Application Server, V5.0 is a market-leading J2EE application server offering the highest performance and lowest cost to deploy, integrate, and manage highly available e-business applications.

Value proposition: With WebSphere Application Server, V5.0, you will build loyalty and avoid costly downtime by allowing customers to rely on your business with system reliability 24x7x365.

3.1.5 Business scenario: High-volume Web site for z/OS

This section describes the business scenario for a high-volume Web site for z/OS.
Table 3-4  High-volume Web site

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-volume Web site (z/OS)</td>
<td>Primary = Large enterprise</td>
<td>zSeries customers with high-volume and high-availability pains</td>
<td>WebSphere Application Server z/OS, VisualAge, Enterprise Suite, DB2</td>
<td>Portal, Personalization, Performance tools</td>
</tr>
<tr>
<td>-include server consolidation msg</td>
<td></td>
<td>zSeries customers, with pains managing large server farms</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Key message:** WebSphere Application Server, V5.0 is a market-leading J2EE application server offering the highest performance and lowest cost to deploy, integrate and manage highly available e-business applications.

**Value proposition:** With WebSphere Application Server, V5.0, you will build loyalty and avoid costly downtime by allowing customers to rely on your business with system reliability 24x7x365.

### 3.1.6 Business scenario: Enhancing your e-business with Web services

This business scenario applies to the integration to back-end systems and application architectures that are required to interact with disparate environments, operating systems, and hardware. Leading edge e-business customers often have this business requirement.

WebSphere Application Server, V5.0 includes powerful Web services for interoperability across disparate application frameworks and business-to-business (B2B) applications, a rich set of open-standards implementations, and virtually any-to-any connectivity with transaction management and application adaptivity.

WebSphere Application Server, V5 offers industry-leading integrated support for key Web services open standards, such as simple object access protocol (SOAP), Web Services Description Language (WSDL), and a private Universal Description, Discovery and Integration (UDDI) Registry. Web Services Invocation Framework (WSIF) offers support across transport protocols. The Web services
gateway allows external applications requesting Web services to securely access an internal Web services provider application. It also offers preview technologies of AXIS V3.0 and JSR 109 - making WebSphere Application Server the first production-ready Web application server for the deployment of enterprise Web services solutions for dynamic e-business.

**Table 3-5  Enhancing your e-business with Web services**

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhancing your e-business with Web services</td>
<td>Primary = Large enterprise and SMB</td>
<td>Customers in stages 3 or 4 of e-business adoption requiring internal and partner applications integration to existing back-end systems</td>
<td>WebSphere Application Server AE or EE, DB, Edge</td>
<td>Web Services, MQSI, Crossworlds, Host Integration</td>
</tr>
</tbody>
</table>

**Key Message:** WebSphere Application Server, V5.0 is the only J2EE application server offering a complete Web Services solution to deploy, integrate and manage application assets across platforms and application frameworks.

**Value proposition:** Get to market faster, by quickly designing new applications that are ready to be integrated as Web services, security leveraging existing internal assets or assets available via partners.
3.1.7 Business scenario: Enterprise modernization/integration

This business scenario applies to the ability of a business to integrate existing core business assets into the new J2EE e-business environment by extending the life of those assets. This is accomplished by the ability to quickly build new, flexible e-business applications that easily integrate with existing assets such as message-oriented middleware, CORBA assets, and Microsoft assets.


Table 3-6 Enterprise modernization/integration

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise modernization/integration</td>
<td>Primary = Medium or large enterprise</td>
<td>Requirement to extend existing applications to Web; lack of integration in legacy systems will use Internet standards</td>
<td>WebSphere Application Server EE, VisualAge enterprise suite plus upgrade to WebSphere Studio Application Developer IE (Feb), z/OS with appropriate adapters, WebSphere Application Server for iSeries</td>
<td>BMC, Candle, service offerings, education, for z/OS Wildfire workshops</td>
</tr>
</tbody>
</table>

Key message: A richly integrated development environment with WebSphere Studio Application Developer Integration Edition, V5.0. Seamlessly integrated with WebSphere Application Server Enterprise V5.0, WebSphere Studio Application Developer provides the ability to build and deploy complex e-business integration applications quickly and easily. WebSphere Studio Application Developer compliments key technologies in WebSphere Application Server Enterprise V5.0.
**Value proposition:** Simplify the integration of heterogeneous applications and assets with a powerful integration framework. WebSphere Application Server Enterprise V5.0 allows businesses to accomplish the goal and realize a higher return on investment and increased profitability. These are key capabilities that will allow customers to move their businesses to the next level of e-business.

### 3.1.8 Business scenario: Enhance ROI through improved programmer productivity

This business scenario applies to a customer gaining the flexibility required to compete in the dynamic e-business environment. The requirement to lower development cost buys increased programmer productivity getting the same amount of work done with fewer resources. If applications are written more quickly and efficiently, customers are adjusting to changing e-business market conditions by creating innovative solutions. This leads to increased revenue and ROI, for example, the ability to develop code for international applications with EE's Internationalization capabilities.

- *Shared workareas.* Ability to quickly write complex transactions using a quick and efficient shared workarea.
- *Message Beans.* The ability to allow programmers to have architectural flexibility for application integration without having to write the integration code themselves.

Table 3-7  Enhance ROI through improved programmer productivity

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhance ROI through improved programmer productivity</td>
<td>Primary = Large and very large enterprise</td>
<td>Customers in stages 3 and 4 of e-business adoption who need to realize high ROI, with constrained development budget</td>
<td>AE or EE</td>
<td>AE/WebSphere Studio Application Developer</td>
</tr>
</tbody>
</table>

**Key message:** WebSphere Application Server Enterprise supports the ability to create new applications with flexible intra-application flows and behaviors that can be changed dynamically. These capabilities offer the ability to simplify business processes by quickly defining them as a sequence of steps that utilize resources and execute directly in applications and organizations. Developers can quickly build, deploy, and manage complex, automated business processes.

**Value proposition:** Manage the complexity of building and deploying enterprise applications through visual and logical process flow capabilities.
3.1.9 Business scenario: Gain flexibility to compete in the dynamic e-business environment

This section describes the business scenario for competing in a dynamic e-business environment.

Table 3-8 Gain flexibility to compete in the dynamic e-business environment

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain the flexibility required to compete in the dynamic e-business environment</td>
<td>Primary = Large and very large enterprise</td>
<td>Customers in stages 3 and 4 of e-business adoption who need to quickly respond to constantly changing e-business market conditions</td>
<td>EE</td>
<td>WebSphere Studio Application Developer-IE</td>
</tr>
</tbody>
</table>

Key Message: WebSphere Application Server, V5 is a market-leading J2EE 1.3 compatible application server offering the highest quality of service and flexible deployment options.

Value proposition: Improve time-to-value by building new integration-ready applications that leverage existing software assets.

3.1.10 Business scenario: Rational offering- liberated development

This section describes the business scenario regarding the Rational offering.
This business scenario applies to a customer building sophisticated enterprise applications in today’s demanding business environment, with major resources required to design, build, and maintain them. The business logic underlying these applications introduces an unprecedented level of technical complexity to the development process. If you can accelerate and simplify the way the business logic for enterprise applications is developed, managed, and maintained, keeping pace with the rapid speed of dynamic e-business is easier and less expensive.

The Versata Logic Suite and WebSphere Application Server can help you capitalize on market opportunities, deter competitors, reduce costs, and collaborate effectively with customers, employees, suppliers, and partners.

For example, by accelerating and simplifying the way business logic for enterprise applications is created, executed, reused, and changed, the Versata Logic Suite for WebSphere together with WebSphere Application Server, Advanced Edition offers the following:

- Simplifies J2EE and enterprise application development by enabling development and maintenance to occur at a higher level of abstraction and therefore shortens development time associated with strategic Web-based applications.
Enables IT staff to focus on business requirements rather than system-level tasks, allowing them to instantly change and update applications, enterprise-wide.

Reduces time and cost of application maintenance and testing compared to hand-coded applications. By requiring fewer developers to service change requests, Versata Logic Suite for WebSphere provides quicker turnaround time for end-user requests.

Maximizes IT resources and augments existing skill sets and helps reduce costs associated with training, outsourcing, application management, and staffing.

Table 3-10  Accelerating and simplifying enterprise application development

<table>
<thead>
<tr>
<th>Offering name</th>
<th>Target audience</th>
<th>Audience profile, in terms of e-business stages of adoption</th>
<th>Core products, those most often in the buying vision</th>
<th>Optional products, added based on customer pains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise modernization/integration</td>
<td>Primary = Medium or large enterprise</td>
<td>Customers moving from stage 2 to stage 3 of e-business adoption</td>
<td>Versata LogicSuite - made up of Versata Logic Studio (Development Tool) and Versata Logic Server (Runtime) WebSphere Application Server, Advanced Edition</td>
<td>WebSphere Studio Application Developer or WebSphere Studio Application Developer-IE, MQSeries, MQSI, MQWF</td>
</tr>
</tbody>
</table>

Key message: WebSphere Application Server Enterprise supports the ability to create new applications with flexible intra-application flows and behaviors that can be changed dynamically. These capabilities offer the ability to simplify business processes by quickly defining them as a sequence of steps that utilize resources and execute directly in applications and organizations. Developers can quickly build, deploy and manage complex, automated business processes.

Value Proposition: Manage the complexity of building and deploying enterprise applications through visual and logical process flow capabilities.

3.2 IBM PartnerWorld for Software

IBM's PartnerWorld for Software program is designed to make sure Business Partners get the most out of their relationship with IBM. The program has three levels of membership: Member, Advanced, and Premier. At each successive level, IBM makes a greater commitment to the Business Partners' success and
the Business Partner makes a greater commitment to IBM. PartnerWorld for Software offers not-for-resale code, volume discounts, tuition reimbursement, enhanced post-sales technical support, compensation for influencing the sale of IBM software, and a host of other benefits.

Ready to start growing your business with WebSphere? Go to the following:

- For general information about WebSphere: http://www.ibm.com/websphere
- For information about IBM Business Partner programs designed to drive new software revenues through innovative co-marketing, visit PartnerWorld for Software: http://www.ibm.com/partnerworld/software
- To access the IBM WebSphere Innovation Connection Online: http://www.ibm.com/websphere/partners
- To access IBM WebSphere course information: http://www.ibm.com/services/learning
- For information on IBM Professional Certification: http://www.ibm.com/certify

### 3.3 Developer partnership programs

Independent software vendors (ISVs) and individual developers collectively drive the software industry. IBM Developer Relations’ mission is to drive IBM market share, revenue growth, technology adoption, and mindshare throughout the developer community. These results are achieved through the developer partnership program, PartnerWorld for Developers, and through outreach to individual developers, developerWorks. PartnerWorld for Developers provides world-class technical support and services, porting and enablement, education and communications, and go-to-market programs for ISVs. developerWorks reaches new developers who may not currently view IBM as relevant by offering rich resources for individual developers that are linked to IBM product Web sites.

IBM offers the broadest, deepest array of developer programs in the industry, from technical support to go-to-market alliances. PartnerWorld for Developers is IBM's “one voice” for developers, consolidating the “look and feel” of all programs across IBM and simplifying navigation across IBM offerings. developerWorks provides individual developers with the best technical information on Java technology, Linux, XML, and other topics from both IBM experts and industry leaders in an exciting, heavily visited site.
3.3.1 PartnerWorld for Developers (PWD)

PartnerWorld for Developers is one of four integrated tracks under IBM PartnerWorld. PartnerWorld is IBM's worldwide marketing and enablement program designed to provide customers with e-business solutions encompassing the entire portfolio of IBM products, technologies, services and financing.

The PartnerWorld for Developers track provides a single point of entry into IBM's global resources for developers who invest in IBM solutions, products, services, and technologies with a focus on delivering e-business solutions. IBM's commitment to relationships with developers for mutual success is the basis for IBM's developer support.

Developer support starts with developerWorks, a collection of technical content and resources for individual developers, and culminates with PartnerWorld for Developers, the Business Partner track for commercial developers. It supports developers worldwide who develop and sell software in the commercial marketplace.

PartnerWorld for Developers features a value strategy that recognizes developers who invest in IBM solutions, products, services, and technologies with a focus on delivering e-business solutions.

In becoming a PartnerWorld for Developer's member you will be able to take advantage of the following services:

  This will give you a summary of the many services offered as member of PWD.

- **Access to the Global Solution Directory.**
  This directory enables developers to promote their application(s) to end users and other developers on a Web site. For more information see 3.4, “Global Solutions Directory” on page 64 or go to the following Web site: [http://www8.software.ibm.com/solutions/isv/igssg.nsf/LanguageSelecto</OpenForm>

- **Access to technical support via IBM Solution Partnership Centers (SPCs).**
  The SPC provides programs and services for developers to port, enable, and test their code across a variety of platforms. The SPC's also host technical seminars and education. For more information go to the following Web site: [http://www.developer.ibm.com/spc/index.html](http://www.developer.ibm.com/spc/index.html).

- **Several information services: PartnerWorld for Developers newsletters (you can subscribe and select the categories that interest you on the latest development activity), developer toolbox technical magazine, management directions magazine, etc.**
The Software Mall.

This is an online ordering system that commercial members of PartnerWorld for Developers can use to obtain the latest level of IBM software products at exceptionally low prices. Members must purchase the IBM Value Package for Developers to access the Software Mall. For more information, go to the following Web site: http://www.developer.ibm.com/welcome/softmall.html.

Note: This software may be used only for the express purposes of evaluation, development, testing, or demonstration.

Depending on your membership level (member, advanced, premier, strategic alliance), you will have access to value packs, technical consultants, etc.

To join PartnerWorld in Development, visit the Web site: https://www.developer.ibm.com/cgi-bin/register?option=individual_reg&data_src=WWW_NEWS

3.3.2 developerWorks: Outreach to individual developers

There are over 9,000,000 developers across the globe who influence almost one third of IT industry sales. These developers make choices every day on which platforms to build on, and which products to buy. Whether it's a Web services application designed to run on WebSphere or an application supporting Microsoft's .NET, developerWorks is here to help shift the balance in favor of IBM, because only developerWorks is focused on serving the needs of professional developers.

Through the Technology Zones, developerWorks attracts professional developers worldwide who are not aware of IBM's products and services, and influences these individuals to consider IBM products and services.

Through the Developer Domains, developerWorks helps move professional developers from considering IBM's products and services to effectively using IBM's products and services and getting technical support.

developerWorks offer tools, code, and education for open, standards-based development. Over 90% of developerWorks' customers have some influence over purchase decisions for their company; 42% make the final recommendation.
developerWorks impact in the war for developer mindshare
In year 2000, 40% of IBM’s 900,000 registered developers were not yet considering IBM products. Getting these tough customers to consider IBM product is a priority. To meet this important objective, we focus on presenting a rich collection of vendor-neutral and IBM-specific content, brand offers, and tools to satisfy this broad community’s wants and needs, answers their questions, and solves their problems. By getting developers to trust IBM, by making it easy and compelling for developers to build on IBM platforms and buy IBM products, IBM is developing relationships that will have a major impact on its bottom line as well as on its partners and customers.

Top five reasons to work with developerWorks
Here are the top five reasons why you should work with developerWorks:

1. developerWorks leads customers to IBM products shown by over 160,000 click-throughs to product Developer Domains per month, over 65 million pages viewed (in year 2000), 7.8 million peak pages viewed per month (in year 2001), and close to 700,000 unique registrations.

2. developerWorks is reaching the exploding number of developers worldwide with 42% of visitors coming to developerWorks global from Asia Pacific or Europe and translated sites in China, Japan, Korea and Taiwan.

3. developerWorks is the highest rated developer resource along with Microsoft's developer resource, MSDN, and far surpasses competitor resources from Oracle, Sun and BEA with developerWorks leading in five categories, including overall value to developers and ease-of-use, and tied for best-of-breed in five others in a total of 11 categories (Summit Strategies, 1Q 2001 report).

4. developerWorks is the leading site on ibm.com exhibiting the highest level of goal achievement (89%) and the highest opinion rating of ibm.com's overall visiting experience, according to the 2001 ibm.com survey. More importantly, developerWorks customers are the most likely to say ibm.com does a good job at providing useful content and are more likely to evaluate IBM offerings.

5. developerWorks is providing unique, respected content leveraging IBM expertise: 48,000 external links to developerWorks, top 10 results on Google for Java/XML/Web Services/Linux developers, 4.1 out of 5 article rating by customers, and has received over 15 awards such as “Best of Show 2001” at XML, one for its XML zone, the Java Developers Journal Award for its alphaWorks Java technologies, and the John Caples International Award for direct marketing creativity for the second year in a row.
3.4 Global Solutions Directory

The Global Solutions Directory is an online directory containing thousands of developer applications, tools, and services using IBM technologies. The listing in the Global Solutions Directory is a developer's best opportunity to market their solutions on a global scale. This directory is available in nine native languages, 24 hours a day, seven days a week, and each listing includes product descriptions and company information. A JavaScript-based search interface allows for both simple and advanced searches on criteria such as industry, hardware platform, technology, operating system, and country of availability.

Find solutions for your business
If you are seeking solutions to your business challenges, search the Global Solutions Directory any time, day or night. The state-of-the-art search capabilities let you define the criteria for your business solutions, and instantly links you to the applications, tools, and services that meet your needs. Choose from thousands of listings from developers around the world.

Market your solutions to a worldwide audience
If you are a developer or IBM Business Partner, the Global Solutions Directory is your best opportunity for marketing your solutions on a global scale. The Global Solutions Directory delivers sales leads to you via e-mail and provides direct links from IBM to your Web site. Plus, you have the ability to customize your listing with your company and contact information, logo, certification marks, and more.

Search on a variety of criteria
The Global Solutions Directory allows you to define specific search criteria for finding your business solutions.

Choose from the following categories:

<table>
<thead>
<tr>
<th>Table 3-11 Global Solutions Directory specific search criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Solution types</strong></td>
</tr>
<tr>
<td>Operating systems</td>
</tr>
<tr>
<td>Hardware platforms</td>
</tr>
<tr>
<td>Technologies</td>
</tr>
<tr>
<td>Industries</td>
</tr>
</tbody>
</table>
Maximize the benefits
The Global Solutions Directory is a valuable resource to maximize promotional impact for your solutions. Customers seeking the latest solutions for their businesses will come directly to you.

Benefits of the Global Solutions Directory
Listed are the benefits achieved by utilizing the Global Solutions Directory:

- Promoted to thousands of worldwide IBM sales representatives, customers, resellers, and system integrators to help them find your industry specific solutions.
- Provides developers with the ability to generate e-mail leads.
- Allows customers to link to the developers Web page and e-mail directly from the solution description.
- Provides developers with the ability to participate in a closed-loop lead management tracking system, the BP Connections program (with industry or business applications) and the Value Added Enhancement Program.

To access the Global Solutions Directory, perform the following steps:

1. Go to http://www.developer.ibm.com
2. In the Marketing and Business Resources section, click Global Solutions Directory.
3. When you're at the GSD welcome page, the left navigation bar has a Login - Submit Solutions tab that will take you to the area where developers can submit solutions.

Note: In order to submit solutions, they must be PWD members to submit their solutions. The welcome page also describes the GSD in detail. In the meantime, here's a quick overview of it.

http://www.developer.ibm.com will lead you to the PWD Web site main page. The PWD member benefits overview will give you a nice summary of many of the services offered as part of PWD. Here are some favorites you should check out:

- Solution Partnership Centers (SPCs). The SPC provides programs and services for developers to port, enable, and test their code across a variety of platforms. The SPCs also host technical seminars and education. Again, look under Features and click SPCs for more info.
- Information Services. These include biweekly developer newsletter (they select the categories in which they are interested in hearing the latest developments), developer toolbox technical magazine, management directions magazine, etc.
> **Software Mall.** Developers can get evaluation code for the cost of shipping and handling. Depending on their level (member, advanced, premier, strategic alliance), they will have access to value packs, technical consultants, etc.

You should bookmark this page as well:


Here's a synopsis of what this page spells out for member benefits.

- **Marketing and sales support:** Marketing education, a marketing resource center, co-marketing and product promotion on the Web, and other opportunities.

- **Education:** Technical education discounts, business seminars and developer workshops, professional certification opportunities, online tutorials, and calendar of education events.

- **Technical support:** Software fixes, frequently asked questions, sample code, integration starter kits for e-business, white papers and articles, how-to guides, developer tools, technical chat sessions and bulletin boards, access to cross-platform porting centers, and industry-leading technical support for developers.

- **Incentives and business support:** Software discounts, hardware discounts and leases, global financing for your customers, and discounts on business services such as express mail, pagers, insurance, and car rentals.

- **Financing:** Flexible financing to help you and your customers acquire hardware, software, and services with affordable monthly payments.

- **Relationship management and membership communications:** Electronic access to timely, consistent information and tools based on interests you define, plus additional relationship management services including tele-coverage and/or face-to-face support, based on your level of membership.
Planning considerations

When preparing for the development and implementation of an e-business solution, you need to consider requirements such as your customer’s business needs or problems to be resolved, the design and features of your application, who will use your application, the software and hardware required to support your solution, security, and system management, and so on. Outlined in this chapter are topics to be considered when developing and implementing a WebSphere application solution. In the Preface of this book, we mentioned that the purpose of this implementation and integration guide is to simplify the planning and implementation of IBM Business Partners’ and independent software vendors’ e-business applications that are enabled for WebSphere Application Server. With this in mind, approach and use the sections in this chapter as if you had acquired an e-business application from one of IBM independent software vendors’ and you have teamed with the ISV or Business Partner to begin the implementation of this solution on WebSphere Application Server.
4.1 Assessment

If you were equipped to build an e-business application to address a specific business need for a company, you would consider following a set of application development guidelines to produce such a solution. However, it is quite possible that the solution you seek to build and implement may already have been developed and may only require some customization to implement within your customer's environment. To find an e-business solution that addresses your customer's business requirements, you should consider IBM Global Solution Directory (see 3.4, “Global Solutions Directory” on page 64). If you are seeking solutions to your business challenges, search the Global Solutions Directory any time, day or night. Its state-of-the-art search capabilities let you define the criteria for your business solutions, and instantly links you to the applications, tools and services that meet your needs. You will choose from thousands of listings from developers around the world.

4.2 Do you need a development environment?

When you've chosen an application solution from an IBM Business Partner or ISV for your WebSphere Application Server, it is quite possible that you may need to build a development environment. The building of this development environment may or may not require you to customize the application solution selected for your customer environment. Some questions you should ask to determine if you need to set up a Development environment may be:

1. Is the application for WebSphere Application Server an AS-IS application?
2. Is there any maintenance to be performed by the supplier?
3. Are you (the Business Partner, customer, etc.) going to maintain the application yourself?
4. Does this package require customization?

If you answer Yes to any of these questions, then you may need to set up a Development environment.

We strongly recommend that you take the time to plan out your environment and put in place the infrastructure to support your development effort. This is true now more than ever in the environments where WebSphere is typically deployed, with rapidly changing goals, high staff turnover and constrained deadlines. A well-designed environment will save you time and money, and allow you to cope with the demands of developing applications today. In particular, you should aim to:
Plan for productivity

– Provide tools to simplify and speed-up common tasks
– Make use of frameworks and off-the-shelf components where appropriate.
– Reduce ramp-up time for new staff by using standard tools and processes wherever possible, and by documenting the complete environment.
– Automate wherever possible.

Plan for flexibility

– Structure your code into stand-alone modules that can be re-used if requirements change or the project grows.

Plan for deployment

– Make sure you can build and deploy your code quickly and easily.
– Include configurable logging and tracing in your code from day one.
– Consider application performance during every activity.

Steps to set up a Development environment can be found in Chapter 6, “Build your WebSphere development environment” on page 125. For additional details on building a Development environment, go to the IBM Redbook Web site:

http://www.redbooks.ibm.com


Note: Under the Development environment, you must be able to control your process and maintain a set procedures for source control, change control, and maintenance control.

4.2.1 Build a staging/test environment

The test environment must resemble your production environment. You should develop a staging/test environment for the following reasons:

– To perform scientific analyses of problems observed in your production environment.
– To validate developed applications and verify new WebSphere software before applying it to the production environment.
– To perform problem determination on custom code and applications in a controlled environment.
To determine how your developed application and WebSphere software may affect the operations of your network.

**Note:** Testing custom code and applications in a production environment should never happen.

**Note:** Your e-business solution must undergo an acceptance test (end user) in addition to a system test.

If you are testing different applications that require different resources, you may be required to set up multiple test environments.

Whether or not you must set up a test environment for Enterprise Edition will determine what features/functions from the Enterprise Edition are used by the e-business application.

Steps to set up a staging/test environment can be found on Chapter 7, “Build your WebSphere staging environment” on page 201. For additional details on building a staging/test environment, go to the IBM Redbook Web site:


Search for the *WebSphere Application Server Test Environment Guide*, SG24-6817.

### 4.3 Build and implement the solution

In this section, we review the integral components we need to build our WebSphere Application Server solution.

#### 4.3.1 IBM @server solutions

IBM WebSphere Application Server, V4.0 is a Java-based Web application server. Application services include transaction management, security, clustering, performance, availability, connectivity, and scalability. IBM WebSphere Application Server, V4.0 leverages open technologies and APIs. IBM WebSphere Application Server, V4.0 is offered on all IBM @server platforms.
We were able to verify that WebSphere Application Server is supported on all IBM servers by using the IBM Solution Connection tool. We used WebSphere as our keyword to search and find information on xSeries, pSeries, iSeries and zSeries servers.

The IBM Solution Connection tool used by PartnerWorld for Developers members integrate solution information with hardware resellers, customer experiences, promotional offerings, and resources to help developers win with IBM servers. Go to the following Web site:


You will see a window similar to Figure 4-1.

![Figure 4-1  Search for a solution window](image)

In the window shown in Figure 4-1, we clicked the **Search by Name** tab, then entered the keyword WebSphere and clicked **Search Now**. A window similar to Figure 4-2 appeared.
Figure 4-2   Search results window

This window presented a list of solutions with the WebSphere name. If the solution you are seeking is listed, click the server series for more information. For our example, we clicked **xSeries** under WebSphere Application Server. A window similar to Figure 4-3 appeared.
From this window, you can access more information on WebSphere Application Server and @server Series at the http://www.ibm.com Web site. In addition, you can contact the IBM Sales Contacts directly or peruse this site for additional information. In Figure 4-4, we took a different approach to look for developer solutions that use WebSphere for all @server Series.
In the window shown in Figure 4-4, we clicked **Technology** and selected **Application Flexibility** from the pull-down menu. Next, we selected **Solution uses WebSphere** from the pull-down menu and then clicked **All Series**. A window similar to Figure 4-5 appeared. In this window, you see multiple developers and companies that use WebSphere for their solution offerings on **IBM @server Series**.
### Search Results

*SP* next to the series name indicates that the solution is IBM ServerProven® on that series.

<table>
<thead>
<tr>
<th>Solution Company</th>
<th>IBM® server series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accord FinancialNet Release 4.6</td>
<td>xSeries SP</td>
</tr>
<tr>
<td>Yole Inc.</td>
<td></td>
</tr>
<tr>
<td>ACCPAC Pro Series 6.5</td>
<td>xSeries SP</td>
</tr>
<tr>
<td>ACCPAC International, Inc.</td>
<td></td>
</tr>
<tr>
<td>ACCPAC VisionPoint 10 (tm)</td>
<td>xSeries</td>
</tr>
<tr>
<td>ACCPAC International, Inc.</td>
<td></td>
</tr>
<tr>
<td>Acu4GL for Informix</td>
<td>pSeries</td>
</tr>
<tr>
<td>Acucorp, Inc.</td>
<td></td>
</tr>
<tr>
<td>ACUCOBOL-GT</td>
<td>xSeries</td>
</tr>
<tr>
<td>Acucorp, Inc.</td>
<td>pSeries xSeries zSeries</td>
</tr>
<tr>
<td>ACUCOBOL-GT Web Browser Plug-in.</td>
<td>xSeries</td>
</tr>
<tr>
<td>Acucorp, Inc.</td>
<td></td>
</tr>
<tr>
<td>Aniba Buyer</td>
<td>xSeries SP</td>
</tr>
<tr>
<td>Aniba, Inc.</td>
<td></td>
</tr>
<tr>
<td>ATG Dynamo</td>
<td>pSeries xSeries</td>
</tr>
<tr>
<td>ATG</td>
<td></td>
</tr>
<tr>
<td>Bean Live</td>
<td>xSeries</td>
</tr>
<tr>
<td>Invensis</td>
<td></td>
</tr>
<tr>
<td>BEA WebLogic Server</td>
<td>xSeries</td>
</tr>
<tr>
<td>BEA Systems</td>
<td></td>
</tr>
<tr>
<td>Biometric Detainee Management System</td>
<td>xSeries pSeries zSeries</td>
</tr>
<tr>
<td>Unilink Computers Plc.</td>
<td></td>
</tr>
<tr>
<td>BlueZone</td>
<td>xSeries pSeries zSeries</td>
</tr>
<tr>
<td>SEA GULL Software Systems Inc.</td>
<td></td>
</tr>
<tr>
<td>BroadVision One-To-One Enterprise</td>
<td>pSeries</td>
</tr>
<tr>
<td>BroadVision, Inc.</td>
<td></td>
</tr>
<tr>
<td>Corner Millennium</td>
<td>pSeries zSeries</td>
</tr>
<tr>
<td>Corner Corp.</td>
<td></td>
</tr>
<tr>
<td>CMS/400 Version 5.8</td>
<td>xSeries</td>
</tr>
<tr>
<td>CMS Manufacturing Systems</td>
<td></td>
</tr>
<tr>
<td>Cognos DecisionStream 6.5</td>
<td>xSeries</td>
</tr>
<tr>
<td>Cognos, Incorporated</td>
<td></td>
</tr>
<tr>
<td>Cognos PowerPlay Enterprise Server 6.04</td>
<td>xSeries</td>
</tr>
<tr>
<td>Cognos, Incorporated</td>
<td></td>
</tr>
<tr>
<td>COLLECTIONS (Delinquent Loan Collection System)</td>
<td>xSeries zSeries</td>
</tr>
<tr>
<td>Shaw Systems Associates Inc.</td>
<td></td>
</tr>
<tr>
<td>COMMERCIAL (Loan Servicing)</td>
<td>xSeries zSeries</td>
</tr>
<tr>
<td>Shaw Systems Associates Inc.</td>
<td></td>
</tr>
<tr>
<td>Common Sense(TM)</td>
<td>xSeries</td>
</tr>
<tr>
<td>SSA Service Information Access Inc.</td>
<td></td>
</tr>
<tr>
<td>COMPTA 400 3.7</td>
<td>pSeries</td>
</tr>
<tr>
<td>EUROSYS</td>
<td></td>
</tr>
<tr>
<td>DataBilder</td>
<td>xSeries pSeries SP zSeries</td>
</tr>
<tr>
<td>CommNIT Systems, Inc.</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 4-5  Search results window*
We scrolled down the list and for our example, we selected **Magic eDeveloper** (Figure 4-6) for iSeries to bring up its solution description and the business problem it resolves.

![Magic eDeveloper window](image)

**Figure 4-6  Magic eDeveloper window**
4.3.2 Why IBM platforms for the e-business infrastructure?

IBM e-business solutions combine the strengths of IBM hardware, software, middleware, financing and services, along with the strengths of our Business Partners and independent software vendors, to provide customers with new ways to develop, manage, and sustain flexible e-business infrastructures that are adaptable to unpredictable change.

4.3.3 IBM xSeries

With its famous reliability and capacity for rapid growth, IBM xSeries is the premier line of Intel processor-based servers built with e-business in mind.

An outline of the featured xSeries solutions for e-business infrastructure is found in the following sections.

A maximum-security solution
Check Point on xSeries and IBM offer market-leading firewall and VPN solutions. Make budget dollars count by lowering costs of connecting mobile workers, telecommuters, and the branch office, thereby easing network security management and reducing administrative overhead.

A complete, fully integrated e-business solution
IBM WebSphere on xSeries is a development platform providing a complete, tightly integrated environment for building, delivering, and modifying e-business applications that handle high-volume transactions. It is compatibility tested on a wide range of xSeries server configurations under the IBM ServerProven program.

A solution for developing new business systems now
Citrix Metaframe on xSeries, a product of Citrix Systems Inc., running on xSeries, delivers virtually any application to virtually any client device over virtually any connection - all from the same server. xSeries servers supply the reliability, availability, and manageability to let you assert control over your networked business system.

For more xSeries e-business information, visit the following Web site:


For xSeries hardware information, visit the following Web site:

4.3.4 IBM @server pSeries

IBM @server pSeries, the most technologically advanced UNIX server, provides the highest available levels of Web security, systems management, and Web performance for e-business applications.

An outline of the featured pSeries solutions for e-business infrastructure follows.

A solution for building highly functional e-commerce sites fast
IBM WebSphere Commerce Suite on pSeries can help customers quickly build secure, high-performance electronic storefronts and marketplaces, and create, deploy, and grow sophisticated, scalable e-commerce sites with high functionality.

A solution for attracting and retaining customers across retail channels
Net Perceptions and pSeries help multi-channel retailers drive and implement informed, profit-focused efforts to attract, retain, and up-sell the best customers, and meet their retail needs across call centers, catalogs, stores, Web sites.

A high-security anti-hacker solution
Check Point FireWall-1/VPN-1 on pSeries, a product of Check Point Software Technologies Ltd., a leading firewall and VPN security solution running on pSeries, offers central management and control of multiple firewall gateways, intrusion monitoring and detection, intuitive user interfaces, and user, client, and session authentication.

For more pSeries e-business information, visit the following Web site:


For pSeries hardware information, visit the following Web site:


4.3.5 IBM @server iSeries

IBM @server iSeries is the premier integrated business server built to help reduce the complexity of managing an advanced e-business environment.

The featured iSeries solutions for e-business infrastructure are covered in the following sections.
Tools for developing e-business solutions
WebSphere Development Studio for iSeries gives customers and solution providers rapid and cost-effective ways to increase the number of Web-enabled, e-business applications for the iSeries server.

An application deployment solution
IBM WebSphere Application Server for iSeries provides core hardware and software for deploying, integrating, and managing e-business applications. It supports the full range of applications, from dynamic Web presentation to sophisticated transaction processing whether custom-built, based on WebSphere platform products, or provided by an IBM Business Partner.

A next-generation e-commerce solution
IBM WebSphere Commerce Suite for iSeries means confident e-commerce. Open, industry-accepted standards make it easy to increase customer value globally, collaborate with customers, suppliers, partners, and create targeted-marketing programs. It offers proven market-leading solutions and a winning track record.

For more iSeries e-business information, visit the following Web site:

For iSeries hardware information, visit the following Web site:
http://www-1.ibm.com/servers/eserver/iseries/

4.3.6 IBM @server zSeries
IBM @server zSeries is an enterprise class e-business server, optimized for the integration of business data and transactions. It is built to meet the demands of the explosive and unpredictable landscape of e-business.

The featured zSeries solutions for e-business infrastructure are outlined in the following sections.

An end-to-end security solution
Entrust/PKI security, a product of Entrust Inc., runs on zSeries, through Entrust/Toolkit for Java (OS/390 Edition). From browser to server to mainframe, from opening a transaction to storing data on the back end, digital signatures and encryption are designed to keep credit-card numbers, medical data, etc., secure at every stage.
A solution for supporting increasing numbers of B2B users
Walker and zSeries offer e-procurement, e-revenue, e-technology, and e-insight to help companies become e-businesses. Critical buying, selling, and financial functions are provided in an open, standard component architecture based on zSeries, to support hundreds even thousands of users. It is designed to assure fast response times with outstanding availability.

A solution for Web-enabling access to existing applications and data
zSeries e-business Software and Tools supplies everything you need to Web-enable existing applications, increasing return on investment. It has been estimated that about 70% of the world's business data resides on IBM servers, many of them zSeries servers. IBM lets you quickly and easily link this data to the Web.

For more zSeries e-business information, visit the following Web site:


For zSeries hardware information, visit the following Web site:

http://www-1.ibm.com/servers/eserver/zseries/

4.3.7 Requests for sizing and capacity planning

The HVWS Simulator for WebSphere is a performance estimation and sizing tool for multi-tier Web infrastructures. It can be used to project the performance and utilization by tier of an existing Web infrastructure or a planned Web infrastructure. It can also help estimate future workload requirements such as traffic burstiness and traffic growth. It is also used to perform "what-if" analyses to reach an optimal configuration based on customer inputs. This is the most comprehensive performance estimation and sizing tool available on the market today. It covers a very broad range of servers, WebSphere products, and all kinds of clients, from PCs to hand-holds. It is used by trained IBM Architects and Consultants worldwide to help customers and Business Partners today.

There are a number of ways for customers or Business Partners to request a performance estimation or sizing of a WebSphere Application Server solution. The choices are as follows:

- Customer requests should go through their IBM Representatives. The IBM Representative can engage the IBM Techline organization by submitting a sizing and planning questionnaire via the SPC icon on Lotus Notes or by visiting the Web site:

Scroll down and under the header Supported Application System, select **WebSphere Application Server**. You will see a window similar to Figure 4-7.

![WebSphere Application Server Sizing and Planning Questionnaire window](image)

- Business partners who have purchased the PartnerWorld for Software value package can call Partnerline at 1-800-426-9990 to engage the Techline organization.
- For customers or Business Partners that have more complex environments and need special attention or longer term engagements, they can contact IBM Performance Management, Testing and Scalability Services at 1-888-426-4343 or e-mail to express@us.ibm.com and ask for WebSphere performance and capacity planning.

### 4.3.8 IBM @server planning, installation and configuration tools

There are several tools and resources to help you streamline the technical planning and support for your xSeries, pSeries, iSeries and zSeries servers. These tools allow for planning, education, installation, upgrading, and capacity planning of your @server solution.

For more information on the planning and installation of the xSeries, pSeries, iSeries, and the zSeries systems, visit the following Web site and select your eServer:

http://techsupport.services.ibm.com/server/planning
## 4.3.9 Operating systems

Table 4-1 describes the minimum product levels you should have installed for your operating system.

*Table 4-1  WebSphere Application Server V4.0.2 Advanced Edition Single Server required operating system versions*

<table>
<thead>
<tr>
<th>Operating System (Required) See note.</th>
<th>WebSphere App Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>AIX 4.3.3 4330-07 Maintenance Level + APAR IY19277</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIX 4.3.3 4330-08 Maintenance Level + APAR IY19277</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIX 5.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS/400 4.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS/400 5.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Linux 7.1 2.4 Kernel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Linux 7.2 2.4 Kernel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux for Intel 7.1 2.4 Kernel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux for Intel 7.2 2.4 Kernel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 2000 Advanced Server 2000 SP1 or SP 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 2000 Server 2000 SP1 or SP 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: On UNIX platform, WebSphere Application Server is supported in 32-bit mode only. 64-bit mode is not exploited, and 32-bit compatibility mode on 64-bit systems has not been tested.
### 4.3.10 Web servers

Table 4-2 describes the minimum product levels you should have installed for your Web server.

<table>
<thead>
<tr>
<th>Web servers (required)</th>
<th>WebSphere App Server platform</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>Apache Server 1.3.20</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ HTTP Server 1.3.19.1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HTTP Server for iSeries 4.6.2.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTTP Server for iSeries 2.0.18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internet Information Server 5.0</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>iPlanet Web Server, Enterprise Edition 4.1 SP7 or SP8</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Domino Enterprise Server (as HTTP server) 5.0.5</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Domino Enterprise Server (as HTTP server) 5.0.6</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Lotus Domino Enterprise Server (as HTTP server) 5.0.8</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

+ Product is included with this edition of WebSphere
4.3.11 Databases

Table 4-3 describes the minimum product levels you should have installed for your database.

<table>
<thead>
<tr>
<th>Databases (required)</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>DB2 400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DB2 for 390 6.1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 for 390 7.1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 Connect 7.2 FP6</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 Connect 7.2 FP6</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 Enterprise -Extended Edition 7.2 FP5</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 Enterprise-Extended Edition 7.2 FP6</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 Enterprise Edition 7.2 FP5</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DB2 Enterprise Edition 7.2 FP6</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Note: Continue to check the following Web site for the latest updates for Web servers requirements:

### Databases (required)

<table>
<thead>
<tr>
<th>Databases (required)</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 Workgroup Edition 7.2 FP5</td>
<td>X X X</td>
<td>FP6 is recommended see DB2 APAR IY26608</td>
</tr>
<tr>
<td>DB2 Workgroup Edition 7.2 FP6</td>
<td>X X X</td>
<td></td>
</tr>
<tr>
<td>Informix Dynamic Server 9.21 aka 2000</td>
<td>X X</td>
<td>Requires Informix driver</td>
</tr>
<tr>
<td>Informix Dynamic Server 9.3</td>
<td>X X</td>
<td>Requires Informix driver</td>
</tr>
<tr>
<td>InstantDB 3.2.6</td>
<td>X X X</td>
<td>Requires Informix driver</td>
</tr>
<tr>
<td>Oracle 8i Enterprise Release 3 (8.1.7)</td>
<td>X X X</td>
<td>SuSE 7.1 is the only Linux distribution supported.</td>
</tr>
<tr>
<td>SQL Server Enterprise 2000</td>
<td>X</td>
<td>Requires Merant Driver</td>
</tr>
<tr>
<td>Sybase Adaptive Server Enterprise 12.0</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Continue to check the following Web site for the latest updates for database requirements:


### 4.3.12 Third-party JDBC driver managers

Table 4-4 and Table 4-5 describe the minimum product levels you should have installed for your JDBC driver managers.
### Table 4-4  WebSphere Application Server 4.0.2 Advanced Edition Single Server - required JDBC driver managers

<table>
<thead>
<tr>
<th>Third-party JDBC driver managers (For vendor-supplied drivers, see Figure 4-5.)</th>
<th>WebSphere App Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>+ Merant Sequelink 5.1</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

*+ Product is included with this edition of WebSphere*

### Table 4-5  Supported JDBC driver types

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Driver</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM</td>
<td>DB2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>OS/400 Toolbox 2.1</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>OS/400 Native 2.1</td>
<td>2</td>
</tr>
<tr>
<td>Merant</td>
<td>Sequelink 5.1</td>
<td>3</td>
</tr>
<tr>
<td>Data Direct</td>
<td>Connect JDBC 2.1</td>
<td>4</td>
</tr>
<tr>
<td>Oracle</td>
<td>OCI</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Thin</td>
<td>4</td>
</tr>
<tr>
<td>Informix</td>
<td>2.20 JC2</td>
<td>4</td>
</tr>
<tr>
<td>Sybase</td>
<td>JConnect 5.2</td>
<td>4</td>
</tr>
</tbody>
</table>

*Note: Continue to check the following Web site for the latest updates for third-party JDBC driver manager requirements:*


### 4.3.13 Web browsers

Table 4-6 describes the minimum product levels you should have installed for your Web browsers.
Table 4-6  WebSphere Application Server 4.0.2 Advanced Edition Single Server - required Web browsers

<table>
<thead>
<tr>
<th>Web browsers (required)</th>
<th>WebSphere App Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>Internet Explorer 5.5 SP 1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Netscape Communicator 4.73</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Netscape Communicator 4.76</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Netscape Communicator 4.76i</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Continue to check the following Web site for the latest updates for Web browsers requirements:


### 4.3.14 Java

Table 4-7 describes the minimum product levels you should have installed for Java.

Table 4-7  WebSphere Application Server 4.0.2 Advanced Edition Single Server - required Java

<table>
<thead>
<tr>
<th>Java (The WebSphere-supplied Java 2 SDK is required for both the runtime and any remote Java clients)</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>+ Java 2 SDK - IBM 1.3 PTF 10w</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Java 2 SDK - IBM (AS/400) 1.3.1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4.3.15 Java specifications

Table 4-8 describes the minimum product levels you should have installed for Java specifications.

<table>
<thead>
<tr>
<th>Java specifications</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K</td>
<td>AIX</td>
</tr>
<tr>
<td>+ EJB 1.1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ J2EE 1.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JClass 4.5J</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ JClass 4.5K</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JDB 2.0</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JMS 1.0.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JNDI 1.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>JRAS 1.0</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JSDK (servlet) 2.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JSP 1.1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JTS 1.0</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JavaBeans Activation Framework 1.0.1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ JavaMail 1.1.3</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ Rhino JavaScript 1.5.1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ SOAP 2.2.2</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>+ UDDI4J 1.0.3</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Note: Continue to check the following Web site for the latest updates for Java requirements:


+ Product is included with this edition of WebSphere
### 4.3.16 XML/XSL

Table 4-9 describes the minimum product levels you should have installed for XML/XSL.

#### Table 4-9  WebSphere Application Server 4.0.2 Advanced Edition Single Server - XML/XSL

<table>
<thead>
<tr>
<th>XML/XSL</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K AIX Linux 400 z/OS</td>
<td></td>
</tr>
<tr>
<td>+ XML 4J (Xerces) 3.2.1</td>
<td>X X X X</td>
<td>Contains Xerces 1.4.2</td>
</tr>
<tr>
<td>+ XSL (Xalan) 2.2</td>
<td>X X X X</td>
<td>Contains Xalan 2.2; WebSphere e-fix required.</td>
</tr>
</tbody>
</table>

+ Product is included with this edition of WebSphere

### Note:
Continue to check the following Web site for the latest updates for Java specifications requirements:


### 4.3.17 MQSeries

Table 4-10 describes the minimum product levels you should have installed for MQSeries.

#### Table 4-10  WebSphere Application Server 4.0.2 Advanced Edition Single Server - MQSeries

<table>
<thead>
<tr>
<th>MQSeries</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K AIX Linux 400 z/OS</td>
<td></td>
</tr>
<tr>
<td>MQSeries 5.2</td>
<td>X X X X</td>
<td></td>
</tr>
</tbody>
</table>

### Note:
Continue to check the following Web site for the latest updates for XML/XSL requirements:

4.3.18 Security

Table 4-11 describes the minimum product levels you should have installed for Security.

<table>
<thead>
<tr>
<th>Security</th>
<th>WebSphere Application Server platform:</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>W2K AIX Linux 400 z/OS</td>
<td></td>
</tr>
<tr>
<td>+ CertPath 1.0</td>
<td>X X X X</td>
<td></td>
</tr>
<tr>
<td>+ GSKIT 5.0d</td>
<td>X X X X</td>
<td></td>
</tr>
<tr>
<td>+ Public Key Cryptography</td>
<td>X X X X</td>
<td></td>
</tr>
<tr>
<td>Standards 1.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ SOAP-Sec 1.0</td>
<td>X X X X</td>
<td></td>
</tr>
<tr>
<td>WebSeal 3.6</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>+ XML Digital Signature 0.9.0</td>
<td>X X X X</td>
<td></td>
</tr>
</tbody>
</table>

Note: Continue to check the following Web site for the latest updates for MQSeries requirements:

## 4.3.19 WebSphere Application Server Advanced Edition hardware and software requirements

### Table 4-12  Windows NT and Window 2000 operating environments

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>Intel Pentium 500 MHz</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>384 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td><strong>Hard Disk:</strong> WebSphere Application Server AE (including the Software Developer Kit)</td>
<td>180 MB</td>
<td></td>
</tr>
<tr>
<td><strong>Screen Resolution</strong></td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td><strong>CD-ROM drive</strong></td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
</tbody>
</table>

**Note:** Continue to check the following Web site for the latest updates for XML/XSL requirements:


A static IP address is recommended if other users will be testing the application on the development machine.
### Table 4-13  AIX operating environment

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>604e RS/6000 - 375 MHz or faster</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td>RAM</td>
<td>384 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard Disk: WebSphere Application Server AE (including the Software Developer Kit)</td>
<td>200 MB</td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Ethernet or token-ring connection (Support for TCP/IP)</td>
<td></td>
<td>A static IP address is recommended if other users will be testing the application on the development machine.</td>
</tr>
</tbody>
</table>

### Table 4-14  Linux operating environment

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Pentium 500 MHz</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td>RAM</td>
<td>384 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard Disk</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Ethernet or token-ring connection (Support for TCP/IP)</td>
<td></td>
<td>A static IP address is recommended if other users will be testing the application on the development machine.</td>
</tr>
</tbody>
</table>
### Table 4-15  Linux on IBM @server zSeries operating environment

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Pentium 500 MHz</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>150 MB</td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Ethernet or token-ring connection (Support for TCP/IP)</td>
<td></td>
<td>A static IP address is recommended if other users will be testing the application on the development machine.</td>
</tr>
</tbody>
</table>
Table 4-16  OS/400 for IBM iSeries system

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>System hosting applications using enterprise beans:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ AS/400 server 170 with processor feature 2385</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ AS/400 server 720 with processor feature 2062</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ iSeries server 270 with processor feature 2252</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ iSeries server 820 with processor feature 2396</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>1 GB RAM (for above systems)</td>
<td>same</td>
</tr>
<tr>
<td></td>
<td>System hosting applications using servlets and JavaServer Pages components only:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ AS/400 server 170 with processor feature 2385 or feature 2292</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ AS/400 server 720 with processor feature 2062 or feature 2061</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ iSeries server 270 with processor feature 2252 or feature 2250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ iSeries server 820 with processor feature 2396 or feature 2395</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB RAM (for above systems)</td>
<td>same</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>500 MB</td>
<td>same</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Ethernet or token-ring</td>
<td>Required</td>
<td>A static IP address is recommended if other users will be testing the application on the development machine. You must use one of these methods to connect the client workstations.</td>
</tr>
</tbody>
</table>
### 4.3.20 WebSphere Application Server Enterprise Edition hardware and software requirements

**Table 4-17  Windows NT and Windows 2000 operating environments**

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Pentium 500 MHz</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td>RAM</td>
<td>384 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard Disk: WebSphere Application Server EE (including the Software Developer Kit)</td>
<td>280 MB</td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM drive</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Ethernet or token-ring connection (Support for TCP/IP)</td>
<td></td>
<td>A static IP address is recommended if other users will be testing the application on the development machine.</td>
</tr>
</tbody>
</table>

**Table 4-18  AIX operating environment**

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>604e RS/6000 - 375 MHz or faster</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>384 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard Disk: WebSphere Application Server AE (including the Software Developer Kit)</td>
<td>300 MB</td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM drive</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Ethernet or token-ring connection (Support for TCP/IP)</td>
<td></td>
<td>A static IP address is recommended if other users will be testing the application on the development machine.</td>
</tr>
</tbody>
</table>
4.3.21 IBM MQSeries V5.2.1 (WebSphere MQ)

MQSeries is the core of the MQSeries family. The base messaging servers and clients provide once, and once only, message and queuing capabilities on over 35 platforms.

Listed in the following tables are the software and hardware requirements for IBM MQSeries according to operating systems.

Table 4-19  Windows NT and Windows 2000 operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
</table>
| IBM MQSeries for Windows NT and Windows 2000, V5.2.1 | - Microsoft Window NT V4.0 to include TCP/IP, NetBIOS, and SPX with Service Pack 6a  
  - Microsoft Windows 2000 (Professional, Server, or Advanced Server Editions)  
  - IBM DB2 Universal Database, V7.2, V7.1, and V6.1 (Server only) | - Any Year-2000-ready Intel processor-based hardware that is explicitly compatible and fully capable of running the specified operating system, the corresponding supporting software, and associated applications unmodified.  
  - IBM @server xSeries  
  - Screen: resolution SVGA 800x600 (minimum), 256 colors (minimum) |
### Table 4-20 Linux operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM MQSeries for Linux, V5.2</td>
<td>▶ Any distribution running on Linux Kernel V2.2 with glibc V2.1&lt;br&gt;▶ Red Hat Package Manager&lt;br&gt;▶ libstdc++V2.8 (for C++ programming).&lt;br&gt;The following Linux distributions have been tested and are known to meet the prerequisite levels&lt;br&gt;▶ Red Hat V6.2 or later&lt;br&gt;▶ Caldera OpenLinux V2.2 or later&lt;br&gt;▶ SuSE V6.4 or later&lt;br&gt;▶ TurboLinux V3.6 or later&lt;br&gt;▶ IBM DB2 Universal Database, V7.2, or V7.1</td>
<td>Any Year 2000 compliant 32-bit Intel processor-based IBM Netfinity or xSeries hardware that is explicitly compatible and fully capable of running the specified operating system.</td>
</tr>
</tbody>
</table>

### Table 4-21 AIX operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM MQSeries for AIX, V5.2</td>
<td>▶ AIX V4.3.3 with relevant Year 2000 fixes&lt;br&gt;▶ AIX V4.3.2 with relevant Year 2000 fixes&lt;br&gt;▶ Software requirements are identical for server and client AIX environments unless otherwise stated.&lt;br&gt;▶ IBM DB2 Universal Database, V7.2, and V7.1 (Server only)</td>
<td>▶ Any Year 2000 compliant RS/6000 or pSeries hardware that is explicitly compatible and fully capable of running the specified operating system.&lt;br&gt;▶ Any hardware capable of running other trademarked AIX systems from IBM or other vendors that have passed a set of certification tests for compliance with the AIX application binary and programming interfaces.</td>
</tr>
</tbody>
</table>
Table 4-22  OS/400 operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM MQSeries for AS/400, V5.2</td>
<td>▶ IBM OS/400 V4.5</td>
<td>Any Year 2000 compliant AS/400 or iSeries hardware that is explicitly compatible and fully capable of running the specified operating system.</td>
</tr>
<tr>
<td></td>
<td>▶ IBM OS/400 V4.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ IBM DB2 Universal Database, V7.2 (Server only)</td>
<td></td>
</tr>
</tbody>
</table>

4.3.22 MA88: MQSeries classes for Java and MQSeries classes for Java Message Service requirements

The SupportPac provides support for developing MQSeries applications in Java (for development on MQSeries V5.2) through the following Java-based APIs:

▶ MQSeries classes for Java
▶ MQSeries classes for Java Message Service (JMS)

The following software is required to run MQSeries classes for Java:

▶ An MQSeries server.
  - For JNI connections, this must be MQSeries V5.2
  - For OS/390, z/OS environments, MQSeries for MVS/ESA V1.2, MQSeries for OS/390 V2.1 and MQSeries for OS/390 V5.2 are supported.

▶ Java Developers Kit or Java Runtime Environment for the server and client platforms

Supported Java Development Kit versions for @server Series:

- AIX - IBM Developer Kit for AIX, Java Technology Edition, V1.3.1
- iSeries - IBM iSeries Developer Kit for Java, V1.2.2 and V1.3.0
- Linux - IBM Developer Kit for Linux, Java Technology Edition, V1.3.1
- OS/390 or z/OS - IBM Developer Kit for OS/390, Java Technology Edition, V1.2.2 and V1.3.0
- Windows 95, 98, NT, 2000 - IBM Developer Kit for Windows, Java, Technology Edition, V1.3.0

The update provides:

▶ Improved performance for client connections to MQSeries using publish/subscribe facilities of WebSphere MQ Integrator or MQSeries SupportPac MA0C, when used in conjunction with MQSeries CSD4.
- Support for WebSphere MQ Event Broker.
- Support for server connections on Linux for Intel.

For information on MA88, go to the following Web site:


4.3.23 IBM MQSeries Integrator (WebSphere MQ Integrator)

MQSeries Integrator combines a one-to-many connectivity model, plus transformation, intelligent routing and information flow modeling. It facilitates the development of new application services that comprise the functions of multiple, disparate existing business systems.

Listed in the following tables are the software and hardware requirements for IBM MQSeries by operating system.

**Table 4-23 Windows NT and Windows 2000**

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
</table>
| WebSphere MQ Integrator for Windows NT and Windows 2000, V2.1 | - IBM MQSeries for Windows NT and Windows 2000, V5.2.1 (included with product)  
- Microsoft Windows NT, V4.0 with Service Pack 6a or Microsoft Windows 2000 with Service Pack 2  
- IBM DB2 Universal Database, V7.2, V7.1, and V6.1 | - Any Year-2000-ready Intel processor-based hardware - that is explicitly compatible and fully capable of running the specified operating system, the corresponding supporting software and associated applications unmodified.  
- IBM @server xSeries  
- Screen: resolution SVGA 800x600 (minimum), 256 colors (minimum) |
### Table 4-24  AIX operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSphere MQ Integrator for AIX, V2.1</td>
<td>▶ IBM MQSeries for AIX, V5.2 (included with product)</td>
<td>▶ Any Year-2000-ready hardware that is explicitly compatible and fully capable of running the specified operating system</td>
</tr>
<tr>
<td></td>
<td>▶ IBM AIX, V4.3 or V5.1 (5L)</td>
<td>▶ IBM iSeries Server (using the IBM I ntegrated ^@server xSeries Server)</td>
</tr>
<tr>
<td></td>
<td>▶ IBM DB2 Universal Database, V7.2, V7.1, and V6.1 with ODBC driver</td>
<td>▶ IBM RS/6000 processor machines</td>
</tr>
</tbody>
</table>

### Table 4-25  iSeries connectivity

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSphere MQ Integrator for Windows NT and Windows 2000, for IBM eServer iSeries, V2.1</td>
<td>▶ IBM MQSeries for Windows NT and Windows 2000, V5.2.1 (included with product)</td>
<td>▶ Any Year 2000 compliant 32-bit Intel processor-based IBM Netfinity or xSeries hardware that is explicitly compatible and fully capable of running the specified operating system, the corresponding supporting software and associated application unmodified</td>
</tr>
<tr>
<td></td>
<td>▶ Microsoft Window NT, V4.0 with Service Pack 6a or Microsoft Windows 2000 with Service Pack 2</td>
<td>▶ IBM iSeries Server (using the IBM Integrated ^@server xSeries Server)</td>
</tr>
<tr>
<td></td>
<td>▶ IBM DB2 Universal Database, V7.2, V7.1, and V6.1</td>
<td>▶ IBM RS/6000 processor machines</td>
</tr>
</tbody>
</table>
4.3.24 IBM MQSeries Workflow (WebSphere MQ Workflow)

MQSeries Workflow is a business process management system that facilitates the rapid development and management of the business processes that integrate the IT and organizational infrastructure of a company.

Listed in the following tables are the software and hardware requirements for IBM MQSeries by operating system.

### Table 4-27  Windows NT and Windows 2000 operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
</table>
| IBM MQSeries Workflow for Windows 2000 and Windows NT, V3.3.2 | ▶ Microsoft Windows 2000  
- IBM DB2 Universal Database Enterprise Edition, V7.2, V7.1 or V6.1; or Microsoft Jet Engine  
- Microsoft Windows NT Workstation, V4.0 with Service Pack 6a  
- IBM DB2 Universal Enterprise Edition, V7.2, V7.1 or V6.1; or Microsoft Jet Engine | ▶ Any Year-2000-ready Intel processor-based hardware - that is explicitly compatible and fully capable of running the specified operating system, the corresponding supporting software and associated applications unmodified.  
- IBM xSeries  
- Screen: resolution SVGA 800x600 (minimum), 256 colors (minimum) |
Table 4-28  AIX operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM MQSeries Workflow for AIX, V3.3.2</td>
<td><strong>AIX</strong>&lt;br&gt;- IBM DB2 Universal Database Enterprise Edition, V7.2, V7.1 or V6.1; or Microsoft Jet Engine&lt;br&gt;MQSeries Workflow, V3.3.2 includes IBM DB2 Universal Database Enterprise Edition</td>
<td><strong>Any Year-2000-ready hardware that is explicitly compatible and fully capable of running the specified operating system.</strong>&lt;br&gt;- IBM @server pSeries&lt;br&gt;- IBM RS/6000 processor machines</td>
</tr>
</tbody>
</table>

Table 4-29  z/OS operating system

<table>
<thead>
<tr>
<th>Components</th>
<th>Software Requirements</th>
<th>Hardware Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM MQSeries Workflow for z/OS, V3.3</td>
<td><strong>z/OS</strong>&lt;br&gt;- IBM DB2 Universal Database Enterprise Edition, V7.2, V7.1 or V6.1; or Microsoft Jet Engine&lt;br&gt;MQSeries Workflow, V3.3.2 includes IBM DB2 Universal Database Enterprise Edition</td>
<td><strong>Any Year-2000-ready hardware that is explicitly compatible and fully capable of running the specified operating system, the corresponding supporting software and associated applications unmodified.</strong>&lt;br&gt;- Any server (zSeries) capable of running one of the listed OS/390 or z/OS releases.</td>
</tr>
</tbody>
</table>

**General recommendations**
To ensure performance and safety, keep database and log files (table spaces) on separate disks when the servers are being set up.

The demand for main memory and hard disk space is affected by:

- Number and size of process models and process instances residing in the runtime database
- Number of clients attached to the server concurrently

Less memory may be required for systems not used for production processes, for example, systems involved in development, testing, or demonstrations.

The performance of IBM MQSeries Workflow, V3.3.2 depends on:

- Usage characteristics of the process models and organization definitions
4.3.25 IBM development server hardware and software prerequisites

In this section, we list the hardware and software prerequisites for IBM WebSphere Studio Application Developer Integration Edition and IBM DB2 Personal Developer's Edition.

- Average and maximum size of the worklists
- Capacity and utilization of the MQSeries Workflow and database server machines
- Speed and memory size of the server and client machines
- Transmission speed and load on communication channels
Listed are the hardware and software requirements for a typical development environment:

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Pentium 500 MHz</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td>RAM</td>
<td>384 MB RAM</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Hard Disk</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Windows 2000 Professional, Server or Advanced Server with Service Pack 2</td>
<td>800 MB</td>
<td></td>
</tr>
<tr>
<td>WebSphere Studio Application Developer-Integration Edition V4.0</td>
<td>800 MB</td>
<td></td>
</tr>
<tr>
<td>IBM DB2 Personal Developer's Edition 7.2</td>
<td>720 MB</td>
<td></td>
</tr>
<tr>
<td>Netscape Navigator, V4.7.3 or Microsoft Internet Explorer 5.5, Service Pack 1 or later</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tape Backup or CD-RW Drive</td>
<td>Refer to requirements of tape backup software used or CD-RW use to back up files.</td>
<td></td>
</tr>
<tr>
<td>Ethernet or token-ring connection</td>
<td>A static IP address is recommended if other users will be testing the application on the development machine. You must use one of these methods to connect the client workstations.</td>
<td></td>
</tr>
</tbody>
</table>
4.3.26 IBM staging server hardware and software prerequisites

In this section, we list the hardware and software prerequisites for IBM WebSphere Application Server Enterprise Edition.

Listed are the hardware and software requirements for a typical staging environment:

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Pentium</td>
<td>Intel Pentium III</td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB</td>
<td>500 MB</td>
</tr>
<tr>
<td>Hard Disk</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>800 x 600</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Required</td>
<td>32x speed or above</td>
</tr>
<tr>
<td>Windows 2000 Professional, Server or Advanced Server with Service Pack 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WebSphere Application Server - Enterprise Edition</td>
<td>800 MB</td>
<td></td>
</tr>
<tr>
<td>IBM DB2 UDB Enterprise Edition</td>
<td>720 MB</td>
<td></td>
</tr>
<tr>
<td>Microsoft Internet Explorer 5.5, Service Pack 1 or later</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tape Backup or CD-RW Drive</td>
<td>Refer to requirements of tape backup software used or CD-RW use to back up files.</td>
<td></td>
</tr>
</tbody>
</table>
In this section, we list several tools to help you sizing and monitor your Web server.

**Web Performance Tools (WPT)**

Web Performance Tools (formerly known as AKtools) is a set of applications that allow a user to test a Web server, a Web site, and a Web application. The two current applications are akstress and akrecord. akstress is a high-performance, simple, threaded HTTP engine that is capable of simulating hundreds or even thousands of HTTP clients, using a highly configurable set of directives in a human readable and easily modified configuration file. akrecord is a simple eavesdropping proxy that will record a user's session against a Web server for later playback in akstress.

When the two applications are combined, it becomes very easy to quickly build an akstress configuration that, with minor tuning, allows a user to evaluate the usability of a server, site, or Web application.

akstress is built on the code used in cVerify, and prior to that, rVerify. Those tools have been used for the last several years for such things as HTTP/1.1 verification testing, large Web site stress analysis, HTTP Server SVT testing, and Web server unit testing efforts.

Here is a short list of the functions that make these tools useful:

- Fully configurable HTTP headers
- SSL support
- Support for HTTP/1.1 functions, including persistent connections and chunked-transfer encoding

### Notes

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum Requirements</th>
<th>IBM Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet or token-ring connection</td>
<td></td>
<td>A static IP address is recommended if other users will be testing the application on the development machine. You must use one of these methods to connect the client workstations.</td>
</tr>
</tbody>
</table>

Note: To guarantee the pristine quality of the software, and to protect the performance of operational systems during the installation process, this system is dedicated only for staging.
Chapter 4. Planning considerations

- Built-in cookie cache (for session testing)
- Result verification
- Full logging
- Overall and request-level statistics
- Capable of issuing proxy request
- Simple to use, no requirement for third-party interpreters, etc.

**Note:** WPT is not a replacement for LoadRunner, Silk Performer or other tools that cost tens to hundreds of thousands of dollars in very high-end environments. It is meant to be used as a quick and easy testing tool, or to be used in environments where purchasing of high-end tools is prohibitive.

For more information, visit the Web site:

http://aktools.raleigh.ibm.com/

**RS/6000 Solution Sizer**

This Web-based sizing tool will help you size RS/6000 server models, number of processors, memory, disk and other considerations for WebSphere Application Server, WebSphere Commerce Suite, WebSphere Commerce Suite - Service Provider Edition, and Domino R5 at initial release. With this release, V1.2, you can estimate the capacity of the IBM @server pSeries products, as well as the existing RS/6000 models. The tool was developed by the International Technical Support Organization in Austin, TX, with support from the RTP and Toronto development labs.

For more information, visit the Web site:

http://w3-1.ibm.com/sales/systems/ibmsm.nsf/mainframeset?readform&geo=AM&cdoc=rs6ksizer

**Resource Analyzer for WebSphere 4.0 AEs/Single Server**

The Resource Analyzer for WebSphere 4.0 is a GUI and command-line version performance monitoring tool. You can download this tool from the following Web site:

4.5 Security

Implementing and managing a secure e-business environment is one of the most challenging tasks today. The security paradigm has changed rapidly and nowadays it has influence on every aspect of an IT solution. More and more businesses are running on an IT infrastructure or are supported by IT solutions. Running a business in any environment means that it has to be protected and secured completely. Enabling security means enabling e-business, because users, customers, and companies all need to be sure that their data cannot be corrupted or misused. Companies need to come up with their solutions quickly, but on the other hand they also have to ensure a highly secure environment for operation. The redbook, *WebSphere Application Server Advanced Edition Security*, SG24-6520, will show you how to use the security features within the WebSphere Application Server to satisfy the required security needs in an e-business solution. It goes further and covers some of the end-to-end security solutions tightly related to the WebSphere Application Server. For more information go to the following Web site:


To understand the WebSphere Application Server V4.0, Advanced Edition security concepts and components used to secure enterprise applications, go to the ITSO Web site and review Chapter 7 of the IBM redbook, *IBM WebSphere V4.0 Advanced Edition Handbook*, SG24-6176-00.

4.6 System management

In this section, we’ve provided several system management solutions to help manage your WebSphere Application Server production environment. For more information on each product, go to the following Web site:

http://www.tivoli.com

4.6.1 IBM Tivoli Monitoring for Web Infrastructure

IBM Tivoli Monitoring for Web Infrastructure was formerly Tivoli Manager for WebSphere Application Server.
Web infrastructure includes the underlying resources that comprise the middle-tier of today's e-business applications, Web servers, and application servers. These resources are common elements of all Web-based applications that demand extremely high performance and availability, as these are often customer-facing applications. Poor performance not only impacts end-user productivity, but also the image of the organization presenting the application. Web infrastructure must be managed.

IBM Tivoli Monitoring for Web Infrastructure is a critical tool to help ensure the optimal performance and availability of both application servers and the associated Web servers that feed them. It provides a single point of control to enable IT organizations to understand the health of the key elements of a Web-based environment. It allows administrators to quickly identify problems, alert appropriate personnel as required, and offer a means for automated problem correction. In addition, Tivoli Monitoring for Web Infrastructure provides a real-time view of performance health and feeds a common data warehouse for historical reporting and analysis. Ultimately this tool increases the effectiveness of an IT organization and helps ensure optimal performance and availability of critical Web infrastructure.

4.6.2 IBM Tivoli Storage Manager for Application Servers

IBM Tivoli Storage Manager for Application Servers was formerly Tivoli Data Protection for WebSphere Application Server 1.1.

IBM Tivoli Storage Manager for Application Servers is a software module that works with IBM Tivoli Storage Manager to better protect the infrastructure and application data and improve the availability of WebSphere Application Servers. It works with the WebSphere Application Server software to provide reproducible, automated online backup of a WebSphere Application Server environment, including the WebSphere administration database (DB2 Universal Database), configuration data, and deployed application program files. Changes to the WebSphere environment, such as the addition of applications, are automatically detected and included in the data backup schedule to help keep backed-up data current. If data loss or data corruption occurs, Storage Manager for Application Servers can automatically restore the necessary data from offline storage to the WebSphere Application Server environment's online storage.

4.6.3 IBM Tivoli Access Manager for Business Integration

IBM Tivoli Access Manager for Business Integration was formerly Tivoli Policy Director for MQSeries.
IBM Tivoli Access Manager for Business Integration is a comprehensive security solution for IBM WebSphere MQ, also known as MQSeries. It provides access control services to restrict which applications can open an MQSeries resource and then “put” or “get” messages on specific queues. It also allows customers to set a specific quality of protection policy that will be enforced on each message. All of these services are provided transparently to both applications and MQSeries itself.

On Windows servers, IBM Tivoli Access Manager for Business Integration can even control access down to specific users of an application. Quality of protection options include three choices: none, message integrity, or privacy. Message integrity services are done using digital signatures that are based on public keys associated with the sending and receiving applications.

Administration of these security policies is done via a Web-based, central administration tool that replaces the need to have an administrator set these access control rules locally at each server's console. This administration tool also supports multiple levels of delegation allowing a resource owner to maintain and manage control of their own resources. All of these services are provided transparently to both applications and MQSeries itself. This means that you do not need to make changes to your existing applications or to the general MQSeries environment to make use of all the functions of IBM Tivoli Access Manager for Business Integration.

Customers can deploy a single security management solution for MQSeries that covers the messaging associated with their core line of business applications as they traverse across both mainframe and distributed servers.

4.6.4 IBM Tivoli Access Manager for e-business

The following products were consolidated to form IBM Tivoli Access Manager for e-business: Tivoli Policy Director and Tivoli Policy Director-Application Servers.

IBM Tivoli Access Manager for e-business is a policy-based access control solution for e-business and enterprise applications. It uniquely addresses the challenges of e-business security, enabling new and rapidly scaling e-business initiatives to reach new markets and customers. It also addresses managing growth and complexity and controlling escalating management costs, and directly tackles the difficulties of implementing security policies across a wide range of Web and application resources. IBM Tivoli Access Manager for e-business helps companies by reducing deployment time and cost for new e-business applications.
IBM Tivoli Access Manager for e-business lets organizations control both wired and wireless access to applications and data, keeping unauthorized users out. IBM Tivoli Access Manager for e-business integrates e-business applications to deliver a secure personalized e-business experience for authorized users. IBM Tivoli Access Manager V3.9 includes integrated security for key CRM, ERP, and SCM e-business solutions, as well as enhancements for securing J2EE-conforming applications running on WebSphere Application Server or BEA WebLogic Server. With Tivoli Access Manager for e-business, Business Partners, customers, suppliers, and employees can secure access to business-critical applications and data for highly available and capable transactions.

IBM Tivoli Access Manager for e-business enables you specifically to:

- Achieve superior return on investment by eliminating the need to manage user identities and security policies within each application
- Improve customer relationships through unified access management and secure single sign-on
- Avoid proprietary and unwieldy solutions and achieve rapid time to value through standards-based access control and J2EE support
- Leverage out-of-the-box integration with CRM applications from Siebel and ERP solutions from mySAP.com, as well as key portal solutions from Plumtree, Epicentric, WebSphere and BEA
- Manage Web security in a way that conforms to your operation, both in terms of delegation of user, group, role, policy and application access provisioning tasks, and in terms of the choice of user registry (with options including Microsoft Active Directory, iPlanet Directory Server, and IBM SecureWay Directory)
- Achieve high availability, with a solution that scales to millions of users

### 4.6.5 IBM Tivoli Web Site Analyzer

Two products were consolidated to form IBM Tivoli Web Site Analyzer: Tivoli Web Services Analyzer and WebSphere Site Analyzer.

IBM Tivoli Web Site Analyzer is an enterprise-level Web analytics tool that transforms random Web data into valuable e-business intelligence. It provides a clear picture of the overall health and integrity of the e-business infrastructure supporting business outcome management.
By capturing, analyzing, storing and reporting on Web site usage, health, integrity and site content, IBM Tivoli Web Site Analyzer can shed light on visitor site interactions and the site’s overall performance. You can leverage this insight to optimize the site for increased customer loyalty and e-business effectiveness. Web Site Analyzer can track the popularity of page content and product purchases for targeted offers or for campaigns to specific visitors or customer segments. It can indicate where a decrease in investment or possible change in Web navigation should occur due to less visited Web or product pages. And IBM Tivoli Web Site Analyzer can help you determine the appropriate investment in online advertising campaigns versus other channels, for example identify which e-business partners to work with, based on generated referral traffic and realized profits. Its multi-channel data collection model consolidates globally distributed Web server log files into a single open data warehouse.

And to provide a more real-time approach, Web page information can be captured dynamically via IBM Tivoli Web Site Analyzers Web Tracker feature. Together they can simplify reporting on Web server activity, Web visitor statistics and customer behavior, pushing Web Site Analyzer beyond simple analysis by integrating the critical end-user experience dimension.

The information generated by IBM Tivoli Web Site Analyzer provides you with a deeper understanding of both the user Web experiences and the performance of your e-business. As a result, you can accurately evaluate trends and make proactive decisions on managing your e-business infrastructure. IBM Tivoli Web Site Analyzer can help optimize business-to-customer, business-to-business, and business-to-employee Web site effectiveness by correlating Web usage and traffic information with performance and availability metrics. Its broad capabilities and comprehensive analysis assist IT, marketing and sales decision makers alike. Its component architecture and scalable analysis engine supports high transaction volume. IBM Tivoli Web Site Analyzer’s comprehensive analysis capabilities meet the needs of even the largest multinational Web site, and its published schema easily supports third-party data visualization and exploration tools.

IBM Tivoli Web Site Analyzer enables you to:

- Transform random Web data into information that supports successful e-business operations
- Analyze how customers experience and interact with your Web site
- Capture Web information from multiple sources and locations in real-time and batch modes (Web Tracker, Web logs, ALS API)
- Simplify the Web analytic data extraction, transformation, loading and reporting process
Integrate with IBM Tivoli products and IBM WebSphere platform components to maximize e-business results
Skills planning and education

IBM recognizes that the key to profitable services engagements is repeatability; so a host of classes are offered to help your technical resources skill-up on the various components of the WebSphere platform. Your technical people can become certified in a variety of WebSphere family products (such as the WebSphere Application Server or WebSphere Host Integration to name just two) by completing a prescribed series of technical courses and then passing the appropriate exams. WebSphere certification tells your customers that the technical resources you send out to work on their projects are trained experts, and clients expect to pay extra for such expertise. According to early surveys by IBM, 64% of IBM Business Partners indicated that having their IT professionals IBM certified for e-business increased their ability to close a sale; 59% reported an increase in sales volume.

For more information on WebSphere certification, visit:

http://www.ibm.com/certify

**WebSphere Sales University 101 Workshop**

This two-day sales workshop, available to qualified Business Partners, is an opportunity for your sales people to learn about the key products in the WebSphere portfolio, how to position them against the competition and, most importantly, how you can make more money by leveraging the strength of IBM.
For more information:

**WebSphere Solution Sales 201 Workshop**
This interactive one-day selling workshop, based on IBM’s Signature Selling Methodology, helps Business Partners recognize customer pains, qualify opportunities, develop solutions with their customers, and quickly close the deal. This workshop is available to qualified Business Partners who have completed the prerequisite courses (IBM’s two-day Signature Selling Methodology and WebSphere Sales University 101 Workshop).

For more information:
http://www.ibm.com/software/info/websphere/partners/ws201.html

A more complete listing of WebSphere courses is available at:
http://www.ibm.com/services/learning

5.1 Installers and system administrators

If you need to install, configure, or manage a version of the WebSphere Application Server, read one or more of the following:

- To learn the basics of installing and configuring the Advanced Application Server, read *Getting Started with Advanced Edition*. This document is designed for first-time users of the Advanced Application Server who want to get a simple system up and running quickly.
- To learn about managing the Advanced Application Server, access the Documentation Center and the online help available with the WebSphere Administrative Console.
- To learn the basics of installing Component Broker, read *Getting Started with Component Broker*; to learn the basics of installing and configuring TXSeries, read *Getting Started with TXSeries*. These documents are designed for first-time users of Enterprise Application Server who want to get either Component Broker or TXSeries up and running quickly.
- To learn about installing, configuring, and managing a more complicated system with the Enterprise Application Server, start with the *Planning, Performance, and Installation Guide for Component Broker* or the *Planning and Installation Guide for TXSeries*.
- To learn how to use the adapters available with Component Broker, start by reading one or more of the following:
  - *MQSeries Application Adapter Development Guide*
5.2 Application developers and system architects

If you need to design business systems or develop applications using a version of the WebSphere Application Server, read one or more of the following documents:

- To learn the basics of developing enterprise beans and related components in compliance with the Sun Microsystems Enterprise JavaBeans Specification, start with Writing Enterprise Beans in WebSphere. This document provides instructions for developing enterprise beans in both the Advanced Application Server and the Enterprise Application Server.

- To learn about the broader issues involved in designing and developing systems and applications in the WebSphere family, read Building Business Solutions with WebSphere.

- To learn about developing applications in Component Broker, start by reading the Application Development Tools Guide and then read the Component Broker Programming Guide. Programmers on OS/390 should also read OS/390 Component Broker Assembling Applications Guide.

- To learn about developing applications in TXSeries CICS, start by reading the CICS Application Programming Guide.

- To learn about developing applications in TXSeries Encina, start by reading Writing Encina Applications (for general development) or Writing Encina Applications on Windows (for development on Windows NT, Windows 95, or Windows 98 systems).

5.3 Developing solutions for e-business

In this section, we discuss the roadmaps available for those resources venturing along various WebSphere paths.

5.3.1 Course roadmaps

Course roadmaps guide you on your path to knowledge. Roadmaps identify courses in their logical sequence to complete a specific curriculum or certification program.
WebSphere Software Platform: Foundations

In Figure 5-1 is the roadmap for WebSphere Foundations.

![WebSphere Software Platform: Foundation window]

WebSphere Administrator

In Figure 5-2 is the roadmap for the WebSphere Administrator.
WebSphere Developer Curriculum
In Figure 5-4 is the roadmap for the WebSphere Developer.
Figure 5-3  WebSphere Developer Curriculum window
WebSphere Developer: Integration

In Figure 5-4 is the roadmap for WebSphere Developer for Integration.

Figure 5-4  WebSphere Developer: Integration curriculum window
WebSphere MQ

In Figure 5-5 is the roadmap for WebSphere MQ.
IBM MQSeries Workflow (WebSphere MQ Workflow)

In Figure 5-6 is the roadmap for IBM MQSeries Workflow.

**MQSeries Workflow**

START HERE...

MW010 -- MQSeries Workflow Introduction and Overview (1 Day)

Classroom

CONTINUE HERE...

MW300 -- MQSeries Workflow Modeling and API (5 Days)

Classroom

ADVANCE TO...

You may be ready for:
Certification Test 092: IBM Certified Solutions Expert - MQSeries Workflow

Figure 5-6  MQSeries Workflow curriculum window
Chapter 6. Build your WebSphere development environment

This chapter provides instructions for installing and configuring a typical development environment. The environment includes the following components running on Microsoft Windows 2000 Server:

- WebSphere Studio Application Developer V4.1 Integration Edition (IE)
- IBM DB2 Universal Database V7.2 Personal Developer's Edition (PDE)

The following optional components can be installed and configured depending on your specific needs.

- IBM MQSeries (WebSphere MQ)
- IBM MQSeries Integrator (WebSphere MQ Integrator)
- IBM MQSeries Workflow (WebSphere MQ Workflow)

For detailed information on developing applications for WebSphere Application Server V4.0, please refer to the *WebSphere V4.0 Application Development Handbook*, SG24-6134-00, at:

6.1 Development environment setup

In this chapter, we outline the software and hardware products used to set up our development environment. Although this book is written mostly about the use of ISV and Business Partner e-business applications for WebSphere Application Server, we felt it was important to cover the development environment for those applications that may need to be modified or customized for a specific business environment.

6.1.1 Software used for our development environment

We used the following software for our development machine:

- Microsoft Windows 2000 Server, Service Pack 2, Build 2195
- IBM WebSphere Studio Application Developer V4.1 Integration Edition
- IBM DB2 Universal Database V7.2 Personal Developer’s Edition with FP6
- IBM MQSeries (WebSphere MQ) Java classes - SupportPac MA88

6.1.2 Hardware used for our development environment

This section describes the hardware used in our development environment running Microsoft Windows 2000 Server with Service Pack 2.

- IBM Netfinity 5100 (Model 8658-51Y)
  - CPU: Pentium III (933 Mhz)
  - Memory: 1 GB
  - Hard drive: 18 GB
  - 100 Mb Ethernet

6.2 Websphere Studio Application Developer Integration Edition installation

WebSphere Studio Application Developer is an easy-to-use integrated development environment. WebSphere Studio Application Developer provides an integrated development environment (IDE) to build, test, and deploy J2EE applications. WebSphere Studio Application Developer Integration Edition builds upon WebSphere Studio Application Developer.

In order to take full advantage of the WebSphere Application Server Enterprise Edition (WebSphere Application Server EE), we will install WebSphere Studio Application Developer Integration Edition. This installation process is identical to WebSphere Studio Application Developer.
To install WebSphere Studio Application Developer Integration Edition, perform the following steps:

1. Insert the WebSphere Studio Application Developer Integration Edition CD into your CD-ROM drive.

2. Allow the auto launcher to start or use your explorer to locate the Setup.exe file on the CD. You will see a window similar to Figure 6-1.

![Figure 6-1 Welcome window](image)

3. Click Next. You will see a window similar to Figure 6-2.
4. When the WebSphere Studio Application Developer license agreement window is displayed, select **I accept the terms in the license agreement**.

5. Click **Next**. You will see a window similar to Figure 6-3.
6. Click **Next** to install into the default folder. However, if you would like to install your code into a different folder, you may click **Change**. You will see a window similar to Figure 6-4.

![Destination Folder window](image)

*Figure 6-3  Destination Folder window*
7. WebSphere Studio Application Developer allows you to select the default environment based on the type of development you plan to use. For our example, accept the default **Enterprise Services Developer**. If necessary, you can change this later within the IDE.

8. Click **Next**. You will see a window similar to Figure 6-5.
9. Select the appropriate value for the type of version control system you want to use. In our example, we chose the default CVS.

10. Click Next. You will see a window similar to Figure 6-6.
11. WebSphere Studio Application Developer is now ready to begin copying files to your development system. Click **install**.

**Note:** During installation, a status window will be displayed and a command prompt window will also be displayed briefly while the resource adapters are installed. This installation may take several minutes to an hour.

When WebSphere Studio Application Developer has finished copying its files, you will see a window similar to Figure 6-7.
Leave the check boxes checked. When prompted, please take the time to register your copy of WebSphere Studio Application Developer and read the readme for pertinent information.

13. To complete the installation, click **Finish**.

### 6.2.1 Starting the WebSphere Studio Application Developer Integration Edition

You are now ready to start WebSphere Studio Application Developer Integration Edition. To do so, perform the following steps:

1. From your Windows desktop, click **Start -> Programs -> IBM WebSphere Studio Application Developer Integration Edition**. You will see a window similar to Figure 6-8.
2. Allow the splash window to run. After a few minutes, you will see a window similar to Figure 6-9.
3. To help you use the WebSphere Application Developer Integration Edition or to execute the tutorial, click Help -> Help Contents and review Getting Started in the Application Developer documentation.

4. Click File -> Exit to close the IDE.

6.3 IBM DB2 Personal Developer Edition installation

To install IBM DB2 Personal Developer’s Edition, do the following:


2. Double-click My Computer and navigate to the folder where you saved the file.
3. Double-click the .zip file you downloaded. If you have Winzip installed or another utility to uncompress the file, this tool will uncompress the contents of the .zip file into a temporary location defined on your hard drive.

4. Again, click My Computer and navigate to the temporary folder where you unzipped the DB2 file.

5. Double-click Setup.exe to start the install process. Select Install and you will see a window similar to Figure 6-10.

![DB2 Universal Database Personal Edition installation window](image)

Figure 6-10   DB2 Universal Database Personal Edition installation window

6. Click Install to launch the DB2 installer. You will see a window similar to Figure 6-11.
7. From the Select Products window, select **DB2 Personal Edition** and **DB2 Administration Client**.

   **Note:** If you need to do more than Java development against DB2 on this machine, you should also select the **DB2 Application Development Client**.

8. Click **Next**. You will see a window similar to Figure 6-12.
9. Click **Next** to install the Typical DB2 components. You will see a window similar to Figure 6-13.

**Note:** When a Typical install is done, all required components are installed in addition, ODBC support, documentation, and commonly used tools such as the Control Center, Client Configuration Assistant and the Information Center are installed. During the install, the DB2 Administration instance and the DB2 instance are created and configured also.
10. Click **Next** to have DB2 installed into the default location. You will see a window similar to Figure 6-14.

**Note:** The default installation location for DB2 is `c:\Program Files\SQLLIB`. If you choose to install to a different location, make a note of that location. You will need it when configuring JDBC2 in 6.3.2, “Configure DB2” on page 149.
11. A user ID is required for the DB2 Control Center server to log in. For the db2admin user, type a new password into the Password and Confirm password fields and DB2 will create the user ID for you.

**Note:** A user ID can be created manually. If you prefer to perform this task versus allowing DB2 to create it automatically, refer to *DB2 Personal Edition Quick Beginnings*, which can be found in the DB2 V7 manuals located at:

http://www-4.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v7pubs.d2w/en_main

12. Click **Next**. If the user ID does not exist, then you will see a window similar to Figure 6-15.
13. Click **Yes** to create the db2admin user ID. You will see a window similar to Figure 6-16.

14. Click **Next** to begin copying files to your development system.

15. Once all files have been copied, DB2 will begin the configuration process. After DB2 has been configured. You will see a window similar to Figure 6-17.
16. Click **Finish** to complete the setup of DB2. You will see a window similar to Figure 6-18.
17. Click **Exit** to close First Steps. Please take the time to register your IBM DB2 product.

18. Log off and log on as db2admin.

### 6.3.1 Updating DB2 to latest FixPak

In order to make sure you have the latest fixes applied to the DB2 Personal Edition, do the following:

**Note:** At the time of writing, FixPak 6 was the latest fixpak available (FP6_WR21299). Be sure to check for the latest fixpak before downloading.

1. Go to the Web site:
   
You will see a window similar to Figure 6-19.

2. Select **Version 7** from the DB2 Version drop-down list.
3. Select **Windows 32-bit** from the Operating System drop-down list.
4. Select **Personal** from the Product drop-down list.
5. Click **Download**. You will see a window similar to Figure 6-20.

---

**DB2 FixPaks, Clients and Trial Code**

* Before you download any FixPak read the latest [FixPak Flasher](#) for important information.

* Download the latest FixPak for DB2 Universal Database servers, clients or DB2 Connect:

<table>
<thead>
<tr>
<th>DB2 Version</th>
<th>Version 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 32-bit</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
<tr>
<td>Product</td>
<td>Personal</td>
</tr>
</tbody>
</table>

[Download] Note: FixPaks can be up to 250 MB.

---

*Figure 6-19  DB2 FixPaks, Clients and TrialCode window*

You have asked to download the following DB2 FixPak:

- **Version**: V7
- **Platform**: WINDOWS
- **FixPak Number**: 6
- **Language**: english-us

[Continue] [Cancel]

*Figure 6-20  Verification window*
6. Click **Continue** to go to the download site. You will see a window similar to Figure 6-21.

   FTP directory /ps/products/db2/fixes/english-us/db2ntv7/FP6_WR21299/ at ftp.software.ibm.com

   Please read the file README
   it was last modified on Thu Aug  9 08:15:27 2001 – 265 days ago

   Up to higher level directory
   03/22/2002 12:40PM  138,212 APALIST.TXT
   03/22/2002 12:40PM  405,466 APALIST.html
   03/22/2002 01:25PM  269,961,613 FP6_WR21299.zip
   03/22/2002 12:37PM  12,836 FixpakReadme.txt
   03/22/2002 02:24PM  65 ReleaseNotes
   03/22/2002 01:36PM  187 debug.txt
   03/22/2002 01:36PM  275,629 debug.zip
   03/22/2002 12:38PM  22,371 prunzip.exe

   Figure 6-21  File selection window

7. Click **FP6_WR21299.zip** to download the FixPak and enter a location to store the file. Remember the location where you will store the file.

8. Click **FixpakReadme.txt** to view pertinent information.

9. Once the FixPak has been downloaded, from the Windows desktop double-click **My Computer**.

10. Navigate to the location where you stored the FixPak zip file.

11. Double-click **FP6_WR21299.zip** to unzip the compressed files into a temporary folder. Remember the location of the folder where your FixPak files reside.

12. Click **My Computer** and navigate to the folder where you unzipped the files.

13. Double-click **Setup.exe**. If DB2 is currently running, you will see a window similar to Figure 6-22.
14. If DB2 is currently running, the FixPak installer will warn you that DB2 needs to be stopped prior to installing the updates. Since there have been no databases created or in use on this machine, it is OK to have the installer shut down DB2 for you. Click Yes to shut down DB2. You will see a window similar to Figure 6-23.
15. The InstallShield wizard has determined the location of DB2, so click **Next**. You will see a window similar to Figure 6-24.
16. Click **Next** to begin copying files.

17. When all files have been copied, updated and configured, you will see a window similar to Figure 6-25.
6.3.2 Configure DB2

After DB2 is installed, a couple of configuration tasks need to be performed. They are:

1. Update JDBC level
2. Stop unused DB2 Windows services

**Update JDBC level**

IBM WebSphere Application Server V4.0 requires JDBC V2.0, whereas the default installation of DB2 uses JDBC V1.2. In order to use JDBC V2.0 for DB2, do the following:

1. From a command prompt, stop the DB2 JDBC Applet Server Windows service as follows:
   
   ```
   c:\net stop “DB2 JDBC Applet Server”
   ```

2. You should see an output response similar to Figure 6-26.
3. From a command prompt, change to the `db2_install_path\java12` where you installed DB2 and execute the following:

   `db2_install_path\java12> usejdbc2.bat`

   **Note:** For our example, we used the default installation path for DB2, which is `c:\program files\sqlib\java12`.

4. You will see an output response similar to that in Figure 6-27.

   **Figure 6-27** Expected output from `usejdbc2.bat`

   ```
   Backing up java\db2java.zip to java11 directory
   1 file(s) copied.
   Copying db2java.zip to usejdbc2.bat\..\..\java
   1 file(s) copied.
   Usejdbc2.bat successful
   ```

   **Note:** If the output of `usejdbc2` indicates that any of the files failed to copy successfully, then the JDBC2 update failed. If this occurs, stop all DB2 services and then repeat the above steps. If you see any “access denied” or “process cannot access...” errors and the JDBC Applet Server is indeed not running, then some other (non-DB2) process has locked the `db2java.zip` file for some reason.

5. Start the DB2 JDBC Applet Server Windows service as follows:

   `c:>net start “DB2 JDBC Applet Server”`

6. You should see an output response similar to Figure 6-28.

   **Figure 6-28** Expected output from starting DB2 JDBC Applet Server

   ```
   The DB2 JDBC Applet Server service was started successfully.
   ```

7. Check the contents of the `db2_install_path\java12\inuse` file. If JDBC2.0 is being used, the file will contain JDBC2.0.
Stop unused DB2 Windows services

To conserve system memory and CPU cycles, you can choose only those DB2 Windows services that are needed for your particular development environment. A service can be set to start automatically or manually or be disabled.

Table 6-1 lists the services settings as they appear after installation, as well as our recommended settings.

<table>
<thead>
<tr>
<th>Service name</th>
<th>Startup mode after installation</th>
<th>Recommended startup mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 - DB2</td>
<td>Automatic</td>
<td>Automatic</td>
</tr>
<tr>
<td>DB2 - DB2DAS00</td>
<td>Automatic</td>
<td>Automatic</td>
</tr>
<tr>
<td>DB2 Governor</td>
<td>Manual</td>
<td>Manual</td>
</tr>
<tr>
<td>DB2 JDBC Applet Server</td>
<td>Automatic</td>
<td>Automatic</td>
</tr>
<tr>
<td>DB2 JDBC Applet Server - Control Center</td>
<td>Manual</td>
<td>Manual</td>
</tr>
<tr>
<td>DB2 Remote Command</td>
<td>Automatic</td>
<td>Manual</td>
</tr>
<tr>
<td>DB2 Security Server</td>
<td>Automatic</td>
<td>Manual</td>
</tr>
</tbody>
</table>

To change the startup settings of one or more of these DB2 Windows services, use the Windows 2000 services Control Panel. Click Start -> Programs -> Administrative Tools -> Services. Right-click the service name and click Properties.

6.4 Install IBM MQSeries classes for Java and MQSeries classes for Java Message Service

The IBM MQSeries classes for Java and MQSeries classes for Java Message Service consist of multiple JAR files and libraries that allow Java programs to connect to an IBM MQSeries (WebSphere MQ) server. Included in the JAR files are classes to connect to MQ directly (either using a TCP connection or using the MQ client libraries if installed) or that use Java Messaging Service (JMS). Our sample application will connect directly to the MQ server using a TCP connection. To install the MQ Java classes (SupportPac MA88), do the following:

1. Download the SupportPac MA88 for Windows 2000 from:

The SupportPac provides support for developing MQSeries applications in Java for development on MQSeries V5.2.

2. Locate the file for Windows and download it to a temporary directory. If you have not already registered at the IBM site you will need to register to download the file.

3. Click My Computer and navigate to the directory where you stored the ma88_win.zip file.

4. Double-click ma88_win.zip to launch your unzip utility and unzip the contents to a temporary directory.

5. Navigate to the directory you unzipped the files to.

6. Start the installer by double-clicking setup.exe. You will see a window similar to Figure 6-29.

![Choose Setup Language window](image)

Figure 6-29 Choose Setup Language window

7. Choose the installation language and click OK. You will see a window similar to Figure 6-30.
8. Click **Next** to proceed. You will see a window similar to Figure 6-31.
9. Read the license agreement and click **I accept the terms in the license agreement**.

10. Click **Next** to proceed. You will see a window similar to Figure 6-32.
11. In the Customer Information window, we accepted the defaults. Click Next to continue. You will see a window similar to Figure 6-33.
12. Accept the default setup type, **Complete**, and click **Next**. You will see a window similar to Figure 6-34.
13. Click **Install** to begin copying files. When the installation is complete, you will see a window similar to Figure 6-35.
14. The installation is complete. Click **Finish** to close the installer.

### 6.4.1 Configure SupportPac MA88

Once the SupportPac MA88 has been installed, the lib directory needs to be added to the System path in order for WebSphere Studio Application Developer to access the libraries. To add the directory to the path, do the following:

1. Right-click **My Computer** and select **Properties**.
2. Click the **Advanced** tab.
3. Click the **Environment Variables** button.
4. In the System variables box, scroll down and select the **Path** variable.
5. Click **Edit**.
6. In the pop-up window, add the following text to the end of the line:
   
   ```
   ;c:\program files\ibm\mq\java\lib
   ```
7. Click **OK** to close the Edit System Variable window.
8. Click **OK** to close the Environment Variables window.
9. Click **OK** to close the System Properties window.

### 6.5 Sample application

This section includes the steps necessary to create a sample application that will utilize WebSphere Application Server and WebSphere MQ. The Web-based application allows you to enter information for a purchase order (PO) by clicking the **Submit PO** link. The PO information is formatted into an XML message and submitted to MQ. While no processing will be done on the PO, you can list all the POs that you have submitted to MQ by clicking the **List POs** link. The sample application requires that your development machine have the following programs installed:

- WebSphere Studio Application Developer Integration Edition
- MA88 - IBM MQSeries classes for Java and MQSeries classes for Java Message Service

**Note:** In the next section, you will be required to create a queue. To create a queue, you need to install and configure MQSeries. It is necessary to create the POENTRY queue at this time because it will be used as an entry to test our sample application (see 6.5.4, “Setting up environment variables for WSADMQDemoWeb” on page 191.)

In our example, we stopped at this time to build our staging environment and created a queue on our staging server, since this will resemble our production environment. To follow our procedures on building the staging environment, go to Chapter 7, “Build your WebSphere staging environment” on page 201 and at the end complete the steps in 6.5.1, “Create POENTRY queue”.

After we set up and configured our staging environment, we returned to 6.5.2, “Create WebSphere Studio Application Developer projects” on page 160 and continued the development of our sample application.

#### 6.5.1 Create POENTRY queue

On your MQ server, do the following:

1. Start the MQSeries Explorer by clicking **Start -> Programs -> IBM MQSeries V5.2.1 -> MQSeries Explorer**.

2. Click + next to IBM MQSeries to expand the folder.

3. Click + next to Queue Managers to expand the folder.

4. Click + next to the default Queue Manager (QM_hostname) to expand the Queue Manager.
5. Right-click **Queues** and select **New -> Local Queue**.
6. Enter **POENTRY** as the Queue Name.
7. Type **Purchase order entry test queue** in the Description field.
8. Click **OK**.
9. If your Queue Manager is a member of a cluster, you will be prompted to share the queue in the cluster; click **Don’t Share in Cluster**.
10. Close the MQSeries Explorer.

### 6.5.2 Create WebSphere Studio Application Developer projects

In this section, we will create two projects within WebSphere Studio Application Developer. When creating the Enterprise Application project, WebSphere Studio Application Developer will automatically create the Web application `WSADMQDemoWeb` for us. In J2EE terms, the Enterprise Application project corresponds to an EAR file, while the Web Application project corresponds to a WAR file. To create the enterprise application and automatically generate the Web application project, do the following:

1. Click **File -> New -> Other**.
2. In the left pane, select **J2EE**.
3. In the right pane, select **Enterprise Application Project**.
4. Click **Next**. You will see a window similar to Figure 6-36.
Figure 6-36 Enterprise Application Project window

5. Type WSADMQDemo in the Enterprise application project name field.
6. Uncheck the Application client project name.
7. Uncheck the EJB project name.
8. Click Finish.

9. Click Perspective -> Open -> Web from the WebSphere Studio Application Developer menu bar to open the Web perspective.

10. Right-click WSADMQDemoWeb and select properties. You will see a window similar to Figure 6-37.
11. In the left pane, select **Java Build Path**.

12. In the right pane, select the **Libraries** tab.

13. Click **Add External JARs**.

14. Locate and select the `com.ibm.mq.jar` file and click **OK**.

   **Note:** `com.ibm.mq.jar` is installed with MA88, IBM MQSeries (WebSphere MQ) Java classes. The default location is `c:\program files\ibm\mqseries\java\lib`.
6.5.3 Coding WSADMQDemoWeb application

In this section, we code the following items:

- WSADMQBean - a Java Bean to handle communications with MQ.
- GetMessages servlet - a Java Servlet to read all the messages from the queue.
- PutMessage servlet - a Java Servlet to format and submit the PO to the queue.
- error.jsp - a JavaServer Page to display error information.
- listMessages.jsp - a JavaServer Page that formats the resulting XML from the POs on the queue for display.
- success.jsp - a JavaServer Page to display when PO is submitted successfully to the queue.
- index.html - a standard HTML page that is displayed at startup.
- sendPO.html - a standard HTML page for entering PO information.

To create these items do the following:

1. Switch to the Web Perspective by clicking Perspective -> Open -> Web.
2. Right-click WSADMQDemoWeb project and select New -> Other. You will see a window similar to Figure 6-38.
3. In the left pane, select **Java**.
4. In the right pane, select **Java Class**.
5. Click **Next**. You will see a window similar to Figure 6-39.
6. Type WSADMQBean in the Name field.

7. Click Finish.

8. Cut and paste the code from Example 6-1 into the WSADMQBean.java window that is displayed, overwriting the existing code. (This code is available from the IBM Redbooks Web site: http://www.redbooks.ibm.com.)

Example 6-1  WSADMQBean.java

```java
import com.ibm.mq.*;
import javax.naming.*;

public class WSADMQBean {
    private MQQueueManager qm = null;
    private MQQueue producerQueue = null;
    private MQQueue readerQueue = null;
```
private MQPutMessageOptions queue_pmo = null;
private int QOptions = MQC.MQOO_OUTPUT + MQC.MQOO_FAIL_IF_QUIESCING;
private int QOptions_reader =
    MQC.MQOO_INQUIRE + MQC.MQOO_BROWSE + MQC.MQOO_INPUT_SHARED + MQC.MQOO_FAIL_IF_QUIESCING;
private int expiry = MQC.MQEI_UNLIMITED;
private int messageWaitTimeout = 0;
private java.lang.String producerQueueName;
private java.lang.String receiverQueueName;

public void init()
    // String hostName,
    // String timeOut,
    // String queueManager,
    // String channel,
    // String theProducerQueueName,
    // String port)*/
    throws Exception {
    String queueManager = null;
    try {
        Context ctx = (javax.naming.Context) new javax.naming.InitialContext();
        messageWaitTimeout = ((Integer) ctx.lookup("java:comp/env/MessageTimeOut")).intValue();
        producerQueueName = (String) ctx.lookup("java:comp/env/Queue");
        queueManager = (String) ctx.lookup("java:comp/env/QueueManager");
        MQEnvironment.hostname = (String) ctx.lookup("java:comp/env/HostName");
        MQEnvironment.channel = (String) ctx.lookup("java:comp/env/Channel");
        MQEnvironment.properties.put(MQC.TRANSPORT_PROPERTY, MQC.TRANSPORT_MQSERIES);
    } catch (Exception e) {
    }

    /*
    messageWaitTimeout = new Integer(timeOut).intValue();
    producerQueueName = theProducerQueueName;
    MQEnvironment.hostname = hostName;
    MQEnvironment.channel = channel;
    */
    MQEnvironment.properties.put(MQC.TRANSPORT_PROPERTY, MQC.TRANSPORT_MQSERIES);
    try {
        qm = new MQQueueManager(queueManager);
        producerQueue = qm.accessQueue(producerQueueName, QOptions, null, null, null);
queue_pmo = new MQPutMessageOptions();
queue_pmo.options = MQC.MQPMO_FAIL_IFQUIESCING +
MQC.MQPMO_NEWCORREL_ID;
readerQueue =
qm.accessQueue(producerQueueName, QOptions_reader, null, null, null);
}
}
public String putAMessage(String body) throws java.rmi.RemoteException {
String returnedMessageText = null;
try {
MQMessage msg = new MQMessage();
msg.messageType = MQC.MQMT_DATAGRAM;
msg.format = MQC.MQFMT_STRING;
msg.expiry = expiry;
try {
msg.writeString(body);
}
} catch (java.io.IOException ioe) {
System.out.println("Error writing message body. " +
ioe.toString());
return "Error writing message body. Message not sent";
}
producerQueue.put(msg);
returnedMessageText = "Message sent. ID=" + msg.correlationId;
}
}
return returnedMessageText;
}
public String getMessageOnQueue() {
MQMessage theMessage = new MQMessage();
MQGetMessageOptions gmo = new MQGetMessageOptions();
gmo.options =
MQC.MQGMO_BROWSE_NEXT
+ MQC.MQGMO_NO_WAIT
+ MQC.MQGMO_FAIL_IFQUIESCING
+ MQC.MQGMO_CONVERT;
try {
int num_msg = readerQueue.getCurrentDepth();
String data = "";
if (num_msg == 0)
return "No Messages on Queue";
System.out.println("Getting message");
for (int j = 0; j < num_msg; j++) {
}
theMessage = new MQMessage();
readerQueue.get(theMessage, gmo);
System.out.println("Got message");
data =
    data
    + "<message id="
    + theMessage.correlationId
    + ">
    + theMessage.readString(theMessage.getMessageLength())
    + "">
    + theMessage.clearMessage();
}
return data;
} catch (MQException mqe) {
    return "Error accessing message on queue: " + mqe.toString();
} catch (Exception e) {
    return "Error parsing message: " + e.toString();
}

public String getQueueName() {
    return producerQueueName;
}

9. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-40.
10. Click X on the tab to close the window.

11. Right-click WSADMQDemoWeb and select New -> Servlet. You will see a window similar to Figure 6-41.
12. Type GetMessages in the Servlet Name field.
13. Click Finish.
14. In the GetMessages.java tab that is displayed, replace the code with the code in Example 6-2. (This code is available from the IBM Redbooks Web site: http://www.redbooks.ibm.com.)

**Example 6-2  GetMessages.java**

```java
import javax.servlet.*;
import javax.servlet.http.*;
import com.ibm.mq.*;

public class GetMessages extends HttpServlet {
```
private String channel;
private String hostName;
private String port;
private String producerQueueName;
private String queueManager;
private String timeOut;
private String iiopaddress;
private String iiopport;
private WSADMQBean mqbean = null;
private String customer_number;
private String item_no;
private String qty;

/**
 * Constructor for WSADMQServlet
 */
public GetMessages() {
    super();
}

public void init() throws javax.servlet.ServletException {
    hostName = getInitParameter("HostName");
    timeOut = getInitParameter("MessageTimeOut");
    queueManager = getInitParameter("QueueManager");
    channel = getInitParameter("Channel");
    producerQueueName = getInitParameter("ProducerQueue");
    port = getInitParameter("Port");
}

public void doPost(
    javax.servlet.http.HttpServletRequest request,
    javax.servlet.http.HttpServletResponse response)
    throws javax.servlet.ServletException, java.io.IOException {
}

public void destroy() {
    super.destroy();
}

public void doGet(
    javax.servlet.http.HttpServletRequest request,
    javax.servlet.http.HttpServletResponse response)
    throws javax.servlet.ServletException, java.io.IOException {
    RequestDispatcher rd = null;
    try {
        if (this.mqbean == null)
            mqbean = new WSADMQBean();
mqbean.init();
//hostName, timeOut, queueManager, channel, producerQueueName, port);
String reply = null;
request.setAttribute("mqbean", mqbean);
// Dispatching the request to the JSP if everything was successful
rd = getServletContext().getRequestDispatcher("listMessages.jsp");
rd.forward(request, response);
} catch (Exception e) {
    // Reporting any error during the process
    request.setAttribute("exceptionText", e.toString());
    request.setAttribute("helperMessage", "");
    rd = getServletContext().getRequestDispatcher("error.jsp");
    rd.forward(request, response);
}

15. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-42.
16. Click X on the tab to close it.

17. Right-click WSADMQDemoWeb and select New -> Servlet. You will see a window similar to Figure 6-43.
174 WebSphere Solution Bundles: Implementation and Integration Guide

Figure 6-43  Create the Servlet Class window

18. Type PutMessage in the Servlet Name field.

19. Click Finish.

20. In the PutMessage.java tab that is displayed replace the code with the code in Example 6-3. (This code is available from the IBM Redbooks Web site: http://www.redbooks.ibm.com.)

Example 6-3  PutMessage.java

```java
import javax.servlet.*;
import javax.servlet.http.*;
import com.ibm.mq.*;

public class PutMessage extends HttpServlet {
```
private String channel;
private String hostName;
private String port;
private String producerQueueName;
private String queueManager;
private String timeOut;
private String customer_number;
private String item_no;
private String qty;
private WSADMQBean mqbean = null;
/**
 * Constructor for WSADMQServlet
 */
public PutMessage() {
    super();
}

public void init() throws javax.servlet.ServletException {
    hostName = getInitParameter("HostName");
    timeOut = getInitParameter("MessageTimeOut");
    queueManager = getInitParameter("QueueManager");
    channel = getInitParameter("Channel");
    producerQueueName = getInitParameter("ProducerQueue");
    port = getInitParameter("Port");
}

public void doPost(
    javax.servlet.http.HttpServletRequest request,
    javax.servlet.http.HttpServletResponse response)
    throws javax.servlet.ServletException, java.io.IOException {
    String POmessage = null;
    RequestDispatcher rd = null;
    // Getting the parameters form the request
    customer_number = request.getParameter("customer_number");
    item_no = request.getParameter("item_no");
    qty = request.getParameter("qty");
    String reply = null;
    // Generating the XML message
    POmessage = "<po>";
    POmessage += "<customer_number>" + customer_number + 
    "</customer_number>";
    POmessage += "<item_no>" + item_no + "</item_no>";
    POmessage += "<qty>" + qty + "</qty>";
    POmessage += "</po>";
    try {
        if (this.mqbean == null)
            mqbean = new WSADMQBean();
        mqbean.init();
        //hostName, timeOut, queueManager, channel, producerQueueName, port);
// Sending the message to the POENTRY queue using the EJB
reply = mqbean.putAMessage(POmessage);
} catch (Exception e) {
    // Reporting the error if messaging failed
    request.setAttribute("helperMessage",
        "<p>Invoking the messaging method failed.");
    request.setAttribute("exceptionText", e.toString());
    rd = getServletContext().getRequestDispatcher("error.jsp");
    rd.forward(request, response);
    return;
} // Dispatching the request to the JSP if everything was successful
rd = getServletContext().getRequestDispatcher("success.jsp");
rd.forward(request, response);

public void destroy() {
    super.destroy();
}

public void doGet(
    javax.servlet.http.HttpServletRequest request,
    javax.servlet.http.HttpServletResponse response
) throws javax.servlet.ServletException, java.io.IOException {
}

21. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-44.
22. Click X on the tab to close it.

23. Click + to expand the WSADMQDemoWeb project (Figure 6-45), if it is not already expanded.
24. Right-click the webApplication folder and select New -> JSP. You will see a window similar to Figure 6-46.

![Create a JSP File (Dynamic Web Page) window](image)

**Figure 6-46  Create a JSP File (Dynamic Web Page) window**

25. Type error.jsp in the Filename field and click Finish.

26. In the error.jsp tab that is displayed, replace the code with the code in Example 6-4. Make sure your Source tab is active when pasting the code. (This code is available from the IBM Redbooks Web site: [http://www.redbooks.ibm.com](http://www.redbooks.ibm.com).)

**Example 6-4  error.jsp**

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<title>IBM WSAD MQ Demo</title>
<META name="GENERATOR" content="IBM WebSphere Studio">
</head>
<body>
<h2>IBM WSAD MQ Demo</h2>
```

---

178  WebSphere Solution Bundles: Implementation and Integration Guide
27. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-47.
28. Click X on the tab to close it.

29. Right-click `webApplication` folder and select `New -> JSP`. 
30. Type listMessages.jsp in the Filename field and click **Finish**.

31. In the listMessages.jsp tab that is displayed, replace the code with the code in Example 6-5. Make sure your Source tab is active when pasting the code. (This code is available from the IBM Redbooks Web site: http://www.redbooks.ibm.com.)

**Example 6-5** listMessage.jsp

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta name="GENERATOR" content="IBM WebSphere Studio">
<title>Messages On Queue</title>
</head>
<body>
<b>Messages in Queue</b>

<% WSADMQBean bean = (WSADMQBean) request.getAttribute("mqbean");
    if (bean != null) {
        String resp = bean.getMessageOnQueue();
    };
</body>
</html>
```
32. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-49.
33. Click X on the tab to close it.

34. Right-click the webApplication folder and select New -> JSP. You will see a window similar to Figure 6-50.
Figure 6-50  Create a JSP File (Dynamic Web Page) window

35. Type success.jsp in the Filename field and click Finish.

36. In the success.jsp tab that is displayed, replace the code with the code in Example 6-6. Make sure your Source tab is active when pasting the code. (This code is available from the IBM Redbooks Web site: http://www.redbooks.ibm.com.)

Example 6-6  success.jsp

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<title>IBM WSAD MQ Demo</title>
<META name="GENERATOR" content="IBM WebSphere Studio">
</head>
<body>
The message has been sent.
<br>
<br>
<center>
<table align="center">
<tr><td><a href="index.html">Welcome Page</a></td><td><a href="sendPO.html">Enter PO</a></td>
```
37. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-51.

![Web - Application Developer Integration Edition window](image)

**Figure 6-51** Web - Application Developer Integration Edition window

38. Click the X on the tab to close it.

39. Right-click `webApplication` folder and select **New -> HTML File**. You will see a window similar to Figure 6-52.
40. Type index.html in the Filename field and click Finish.

41. In the index.html tab that is displayed, replace the code with the code in Example 6-7. Make sure your Source tab is active when pasting the code. (This code is available from the IBM Redbooks Web site: http://www.redbooks.ibm.com)

Example 6-7  index.html

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
  <head>
    <meta name="GENERATOR" content="IBM WebSphere Studio">
    <title>IBM WSAD MQ Demo</title>
  </head>
  <body>
    <center>
      <b><font size="+2">IBM WSAD MQ Demo</font></b>
    </center>
    <table width="70%">
      <tr>
      </tr>
    </table>
  </body>
</html>
```
This sample application will take basic information for a Purchase Order (Customer name, Item # and quantity) and inject a message into IBM WebSphere MQ containing the information in XML format. You can also get a list of all POs that are in MQ.

42. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-53.
43. Click **X** on the tab to close it.

44. Right-click **webApplication** folder and select **New -> HTML File**. You will see a window similar to Figure 6-54.
45. Type `sendPO.html` for the file name and click **Finish**.

46. In the `sendPO.html` tab that is displayed, replace the code with the code in Example 6-8. Make sure your Source tab is active when pasting the code. (This code is available from the IBM Redbooks Web site: [http://www.redbooks.ibm.com](http://www.redbooks.ibm.com).)

Example 6-8  sendPO.html

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta name="GENERATOR" content="IBM WebSphere Studio">
</head>
<body>
<b><font size="+2">IBM WSAD MQ Demo</font></b><br>
<form action="PutMessage" method="post">
<table width="70%">
<tr><td>customer name:</td>
```

Figure 6-4  Create and HTML File window

Figure 6-54  Create and HTML File window
47. Press Ctrl+S to save the changes. You will see a window similar to Figure 6-55.
48. Click X on the tab to close it.

6.5.4 Setting up environment variables for WSADMQDemoWeb

Prior to running the application, you need to set some environment variables for the Web application. The environment variables are stored in a file called web.xml that is deployed with the Web application. These environment variables contain the information needed to contact your MQ server and submit the PO. To set these variables do the following:

49. If WSADMQDemoWeb folder (in Figure 6-56) has not been expanded, then click + next to WSADMQDemoWeb to do so.
50. Click + to expand the webApplication folder.
51. Click + to expand the WEB-INF folder.
52. Double-click web.xml to open the file.
53. Click the Environment tab.
54. Click Add to add an environment variable.
55. Type MessageTimeOut for the variable name.
56. In the type column, select Integer.
57. Click once in the Value column and type 1000. You will see a window similar to Figure 6-57.
58. Repeat steps 6 - 9 for all variables listed in Table 6-2. Replace the values in () with values correct for your environment.

Table 6-2  Environment variables for WSADMQDemoWeb

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MessageTimeOut</td>
<td>Integer</td>
<td>1000</td>
</tr>
<tr>
<td>HostName</td>
<td>String</td>
<td>(your MQ hostname) For our example, we used M23x2673.</td>
</tr>
<tr>
<td>QueueManager</td>
<td>String</td>
<td>(your Queue Manager name). For our example, we used QM_m23x2673.</td>
</tr>
<tr>
<td>Queue</td>
<td>String</td>
<td>POENTRY</td>
</tr>
<tr>
<td>Channel</td>
<td>String</td>
<td>SYSTEM.DEF.SVRCONN</td>
</tr>
</tbody>
</table>
6.5.5 Configuring the WebSphere Application Server in WebSphere Studio Application Developer

WebSphere Studio Application Developer includes WebSphere Application Server Advanced Single Server edition for testing applications. To include the SupportPac MA88 JAR files in the Classpath for WebSphere Application Server, do the following:

1. Open the Server Perspective by doing the following:
   a. From the menu bar, click **Perspective -> Open -> Other**.
   b. Select **Server** and click **OK**.
2. In the Navigator window, right-click **WSADMQDemo** and click **Run on Server**. The WebSphere Application Server V4.0 Test Environment is created and starts to run (see Figure 6-58).

**Note:** Our HostName, QueueManager, and POENTRY queue exist on our staging server (staging/test environment). This is where our MQSeries (WebSphere MQ) resides. Also, the QueueManager name, Queue name, and Channel are case sensitive and these entries must match the names created on the MQSeries (WebSphere MQ) server.
3. At this time, we must stop the WebSphere V4.0 Test Environment to continue configuring the WebSphere Application Server in WebSphere Studio Application Developer. From the Server - Application Developer Integration Edition window, click the **Servers** tab. You will see a window similar to Figure 6-59.
4. In the Servers window (Figure 6-59) under Server Instance, right-click WebSphere V4.0 Test Environment and select Stop.

5. In the Navigator window (Figure 6-59), click + to expand the Servers folder. You will see a window similar to Figure 6-60.
6. Open the WebSphere V4.0 Test Environment editor by double-clicking `defaultInstance.wsi`.

7. In the right-hand frame, click the **Paths** tab. You will see a window similar to Figure 6-61.

8. Scroll down to the Classpath section.

9. Click **Add External JARs...** to add a JAR file to the Classpath.

10. Navigate to the `c:\program files\ibm\mq\java\lib` directory and select `com.ibm.mq.jar`. Click **OK**.

---

Figure 6-60  Navigator window

Figure 6-61  WebSphere V4.0 Test Environment editing window
11. Repeat steps 9 and 10 for com.ibm.mqjms.jar and jta.jar. Afterwards, you will see a window similar to Figure 6-62.

![Figure 6-62 WebSphere V4.0 Test Environment window](image)

12. Press Ctrl+S to save the changes and click X in the tab to close the configuration editor.

### 6.5.6 Running the application

WebSphere Studio Application Developer includes WebSphere 4.0.2 Advanced Single Server Edition for testing your Enterprise Applications with the IDE. To run the application do the following:

1. Right-click the **WSADMQDemo** project and click **Run on Server**.
2. A new perspective called Server Perspective will be opened.
4. Right-click **WSADMQDemoWeb** and click **Run on Server**.
5. A browser window will be opened in WebSphere Studio Application Developer with the URL: [http://localhost:8080/WSADMQDemoWeb](http://localhost:8080/WSADMQDemoWeb/).
Chapter 6. Build your WebSphere development environment

6. Click EnterPO.

7. Enter a customer name, item number, and quantity and click Send order.

8. Once the message has been submitted to MQ, you will be directed to a page stating The message has been sent.

9. Click List POs to view all entries on the MQ queue.

10. Click SubmitPO to add another entry to the queue. Once submitted, click List POs to view all entries on the MQ queue.

6.5.7 Exporting the demo application to an .ear file

In order to deploy the demo application to a WebSphere Application Server, you need to export the application from WebSphere Studio Application Developer into an Enterprise Archive (EAR) file. The EAR file can then be deployed on the WebSphere Application Server server using the WebSphere Application Server Administrative Console. To export the application to an EAR file, do the following:

1. In the left pane of WebSphere Studio Application Developer, right-click WSADMQDemo.

2. Select Export EAR file...

3. In the Where do you want to export resources to? field, enter the directory and name of the file to create. The file name must end in .ear. In our example, we used c:\temp\WSADMQDemo.ear.

4. If you want the source code packaged in the EAR file, then select Export Source Files.

5. Click Finish to start the export.

6. If a file with the name indicated already exists and you did not select Overwrite existing resources without warning, you will be prompted to overwrite the file. Click Yes to overwrite it.

Note: If you receive a DNS error, check the proxy settings for Microsoft Internet Explorer to make sure you are not using a proxy or SOCKS server.

Note: You must use Internet Explorer 5.x to display XML data islands from the List POs link.

Note: Exporting the source code in the EAR file provides an excellent way to transport the whole project to another system or share it.
7. When the export is complete, you will be returned to the WebSphere Studio Application Developer workspace.
Chapter 7. Build your WebSphere staging environment

This chapter provides instructions for installing and configuring a typical staging or testing environment. The configured environment includes the following components running on Microsoft Windows 2000 Server:

- WebSphere Application Server V4.0.2 Advanced Edition (AE)
- IBM DB2 Universal Database V7.2 Enterprise Edition (DB2 EE)
- IBM MQSeries V5.2.1
- IBM WebSphere MQ Integrator V2.1
- IBM MQSeries WorkFlow V3.3.2
- WebSphere Application Server V4.1 Enterprise Edition (EE)

WebSphere Application Server V4.1 Enterprise Edition is composed of four principal elements:

- WebSphere Application Server V4.0.1, Advanced Edition
- Enterprise Services
- IBM TXSeries software
- MQSeries software

The use of IBM TXSeries is not a requirement for our configuration. Therefore, it will not be discussed in this chapter. IBM TXSeries is used in a CICS environment (which generally requires a high transactional context).
7.1 Staging environment setup

In this chapter, we outline the software and hardware products used to set up our staging server.

**Note:** While the sample application developed in Chapter 6, “Build your WebSphere development environment” on page 125 does not utilize WebSphere MQ Integrator or MQSeries Workflow, we chose to simulate the necessary steps to install and configure these products.

IBM WebSphere MQ by itself provides the functionality to manage, store, and retrieve messages from a queue or queues. This functionality, while robust, does not provide rule-based routing, workflow, or process flow functionality. By integrating WebSphere MQ with WebSphere Process Manager, you get the added functionality of workflow and process flow, or intelligent message routing based on message content. Add WebSphere MQ Integrator to the mix and you have a robust system for programatically transforming and augmenting messages, applying rules to message-based data, and routing and distributing data between high performance systems.

An enterprise class architecture built for high-performance messaging, database back end, and J2EE application hosting is the core of a modern e-business. The goal of this chapter is to give you the basic installation and configuration of the components needed to achieve this core functionality. In this chapter, we install IBM DB2, which serves as the central repository for WebSphere Application Server, WebSphere MQ Integrator, and WebSphere Process Manager. Once DB2 is installed and configured, IBM WebSphere MQ will be demonstrated. The WebSphere MQ server is the core messaging application upon which WebSphere MQ Integrator and WebSphere Process Manager add their functionality. In order to provide a high-performance J2EE application server and to host the sample application, we will install and configure IBM WebSphere Application Server. All of these components will be run on top of Microsoft Windows 2000 Server.
The staging or test environment created in this chapter will be applied to the production environment. However, this environment will exist on an AIX platform as described in Chapter 8, “Build your WebSphere production environment” on page 331.

7.1.1 Software used for our staging environment

We used the following software on our staging machine:
- Microsoft Windows 2000 Server, Service Pack 2, Build 2195
- IBM WebSphere Application Server V4.0.2 Advanced Edition
- IBM DB2 Universal Database V7.2 Enterprise Edition with FixPak6
- IBM MQSeries V5.2.1 (WebSphere MQ)
- IBM WebSphere MQ Integrator V2.1, with CSD1 and CSD2
- IBM MQSeries Workflow V3.3.2

7.1.2 Hardware used in our development environment

The hardware used in our staging environment running on Windows 2000 Server with Service Pack 2 was IBM @server xSeries 330 (Model 8654-11Y) with the following specs:
- CPU: Pentium III (933 Mhz)
- Memory: 866 MB
- Hard drive: 8 GB
- 100 Mb Ethernet

7.2 DB2 Universal Database Enterprise Edition V7.2 installation

The steps for installing DB2 UDB EE v7.2 are as follows:
1. Log in to Windows as an administrator or user with equivalent privileges.
2. Insert the IBM DB2 Universal Database EE V7.2 CD.
3. Double-click Setup.exe and you will see a window similar to Figure 7-1.
4. Click **Install** to launch the DB2 installer. You will see a window similar to Figure 7-2.
5. From the Select Products window, select **DB2 Enterprise Edition** and **DB2 Administration Client**. Click **Next** and you will see a window similar to Figure 7-3.
6. In the Select Installation Type window, select **Typical** and click **Next**. You will see a window similar to Figure 7-4.
7. Choose a destination directory for installing the DB2 Server. In our example, we accepted the default destination folder. Click **Next** and you will see a window similar to Figure 7-5.
8. A user ID is required to log into the DB2 Control Center. For the db2admin user, type a new password into the Password and Confirm password fields and DB2 will create the user ID for you.

Check the Use the same values for the remaining DB2 Username and Password settings option, which is the default.

9. Click Next. You will see a window similar to Figure 7-6.

10. Click Yes. You will see a window similar to Figure 7-7.
11. In the Start Copying Files window, review the Current Settings to verify the components you have selected. Click Next to start the installation process. The installation process will take several minutes.
12. The user is given an option to install the On-Line Analytical Processing (OLAP) Starter Kit. For our example, select **Do not install the OLAP Starter Kit** and then click **Continue**. You will see a window similar to Figure 7-9.
DB2 has been installed successfully. Click **Finish** and then restart Windows to complete configuration.

7.2.1 **DB2 FixPak installation**

In 6.3.1, “Updating DB2 to latest FixPak” on page 143, perform steps 1 through 14 to install the latest DB2 FixPak for IBM DB2 Universal Database V7.2 Enterprise Edition. Then return to this section to complete the following steps. You will see a window similar to Figure 7-10.
1. The InstallShield wizard has determined the location of DB2. Click **Next**. You will see a window similar to Figure 7-11.
2. At the Define a Local Warehouse Control Database window, accept the defaults and type in the db2admin password. Click **Next** to continue. You will see a window similar to Figure 7-11.
3. Review the Current Settings shown in Figure 7-12. Click **Next** to proceed with the installation. After the installation, you will see a window similar to Figure 7-13.
Chapter 7. Build your WebSphere staging environment

4. The setup is complete. Accept the default, **Yes, I want to restart my computer now.** Click **Finish** to restart the machine.

### 7.2.2 Verifying the database is running

Check to verify that DB2 is up and running. Perform the following steps:

1. Click **Start** -> **Programs** -> **IBM DB2** -> **Command Window**.
2. Type `db2start` and press Enter. This command returns the status of whether DB2 is running.

### 7.3 WebSphere Application Server V4.0 Advanced Edition installation

In this section, we install WebSphere Application Server V4.0.1 Advanced Edition and then install the FixPak (PTF2) to bring the software product up to its current version, V4.0.2.
7.3.1 Pre-installation tasks

Prior to installing IBM WebSphere Application Server V4.0.1, the following checks and tasks need to be completed on the WebSphere server machine:

1. Create groups and users.
2. Check that IP ports are unused.
3. Stop the Web server processes.

Create groups and users

In this section, we create our groups and users. For our example, we only created the user named “wasadmin”. The wasadmin user ID will be used for WebSphere Application Server services. Note that the user ID should be locally defined and not a member of a Windows domain.

1. Create the wasadmin user ID:
   a. Click Start -> Run. Type compmgmt.msc and press Enter.
   b. Expand Systems Tools and then Local Users and Groups.
   c. Right-click Users and click New User to create the new user ID.
   d. Type wasadmin and its password. Provide a description and set the password setting. Click Create and then click Close.
   e. Under the Users folder, access the wasadmin user ID and click Properties. Make this user a member of the Administrators group.

2. Assign rights to this user:
   b. Right-click Act as part of the Operating System and click Security.
   c. Click Add twice to add wasadmin to this policy and click OK twice to return to User Rights Assignment.
   d. Right-click Log on as a Service and click Security.
   e. Click Add twice to add wasadmin to this policy and click OK twice to return to User Rights Assignment.
   f. Click X to exit.

Check that IP ports are unused

To check that the required ports are not in use, perform the following steps:

1. Check that there are no existing active services that use the following IP ports on the server:
   - 900 (bootstrap port)
Chapter 7. Build your WebSphere staging environment

2. Access a command prompt and run the following command:
   
   \( x:\> \text{netstat -an} \)

**Stop the Web server processes**

The IBM HTTP Server process must be stopped while WebSphere is installed. The WebSphere installation changes the httpd.conf configuration file as part of the Web server plug-in component installation.

Access a command prompt and run the following command if the IBM HTTP Server is installed already:

\( D:\> \text{net stop “IBM HTTP Server”} \)

### 7.3.2 Installing WebSphere Application Server V4.0.1 Advanced Edition

In this section, we install WebSphere Application Server V4.0.1 Advanced Edition. In the next section, we install the PTF to update Version 4.0.1 to 4.0.2. To perform the WebSphere Application Server Advanced Edition installation, complete the following steps:

1. Log in to Windows as administrator or a user with administrator privileges. For our example, we logged in as db2admin.

2. Insert your WebSphere Application Server-AE V4.0.1 for Windows NT and Windows 2000 CD into the CD-ROM drive. Allow it to start automatically. If the CD does not start, use Explore to access the CD install directory and double-click **Setup.exe**. You will see a window similar to Figure 7-14.
3. At the Choose Setup Language window, select the appropriate language you will use. In our example, we selected the default, English (United States).

4. Click **OK** and then click **Next** to continue. You will see a window similar to Figure 7-15.

---

**Figure 7-14**  Choose Setup Language window

**Figure 7-15**  Installation Options window
5. Select **Typical Installation**. The typical installation installs all the features you require for running and deploying a highly scalable Web application and includes IBM HTTP Server and IBM JDK 1.3.0. Click **Next** and you see a window similar to Figure 7-16.

![Security Options window](image)

**Figure 7-16  Security Options window**

6. Type in a username and a password. In our example, we use wasadmin. Click **Next**.
7. Accept the default install directories for WebSphere Application Server and IBM HTTP Server. Click **Next** and you see a window similar to Figure 7-18.
8. Since the WebSphere Application Server uses a database repository for storing information, it is required that we configure the database. Accept the defaults and type in the db2admin password. Click **Next** to continue. You will see a window similar to Figure 7-19.
9. Accept the default program folder for WebSphere Application Server V4.0 AE. Click **Next**. You will see a window similar to Figure 7-20.
10. In the Install Options Selected window (Figure 7-20), review the selected options. Click **Next** to start the installation process.

![Install Options Selected window](image)

**Figure 7-20**  Install Options Selected window

During the installation you will get the Warning window shown in Figure 7-21. Please read it and adhere to its instructions. Click **OK**.

![JDBC Drivers Warning](image)

**Figure 7-21**  JDBC Drivers Warning
11. When the installation completed window (Figure 7-22) is displayed, click <b>Finish</b> and view the README file to read relevant information.

12. When asked if you wish to restart, click <b>No</b>. You will restart your computer later. At this time, go to the directory C:\Program Files\SQLLIB\java12 and double-click the <b>usejdbc2.bat</b> file. This will configure the DB2 to use the JDBC Version 2 driver.

### 7.3.3 Installing FixPak for WebSphere Application Server V4.0 Advanced Edition (PTF2)

1. Download the WebSphere Application Server V4.0 AE PTF2 from the following Web site:
   
2. Extract the FixPak zip file to a temp folder.
3. Run the install.bat.
4. A command prompt window is opened. You will see a window similar to Figure 7-23.

![Figure 7-23 Shutdown Other Web servers](image)

5. Ensure that your servers are shut down before continuing. Press the Enter key to continue. You will see a window similar to Figure 7-24.

![Figure 7-24 Enter WebSphere Application Server installation directory window](image)
6. At the prompt, type the name of the WebSphere Application Server installation directory and press Enter to continue.

The default installation directory is C:\WebSphere\AppServer. You will see a window similar to Figure 7-25.

![Figure 7-25 Installation progress window](image)

7. The system starts installing the patch and displays the percentage of completed operations.

8. When prompted, press Enter to continue. You will see a window similar to Figure 7-26.
Chapter 7. Build your WebSphere staging environment

227

9. At this window, you are prompted to upgrade the IBM HTTP Server. Type Yes and press Enter to continue. You will see a window similar to Figure 7-26.

![Figure 7-26 IBM HTTP Server upgrade window](image1)

9. At this window, you are prompted to upgrade the IBM HTTP Server. Type Yes and press Enter to continue. You will see a window similar to Figure 7-26.

![Figure 7-26 IBM HTTP Server upgrade window](image2)

10. At the prompt, type C:\IBM HTTP Server to point to the IBM HTTP Server directory and press Enter to continue.

![Figure 7-27 IBM HTTP Server install location window](image3)
11. You are prompted to install the J2C for WebSphere. Type Yes.

12. When you see the message IBM WebSphere Application Server V4.0.2 AE FixPak install complete, press Enter.

13. Restart your computer.

### 7.3.4 Configuring WebSphere service for auto start on reboot

In this section, we configure the WebSphere Administrative Service to start automatically:

1. Go to **Start -> Settings -> Control Panel -> Administrative Tools -> Services.**

2. Right-click **IBM WS Admin Service 4.0** and click **Properties.**

3. In the Startup drop-down list, choose **Automatic** and click **OK.**

   This will automatically start the service when rebooted.
7.4 WebSphere Application Server V4.1 Enterprise Edition installation

In this section, we perform the installation of the WebSphere Application Server V4.1 Enterprise Edition.

Perform the following steps to install WebSphere Application Server EE V4.1:

1. Insert the CD into the CD-ROM drive. Use the Windows Explorer to access the CD. Go to the install directory x:\WINDOWS\ENTERPRISEEDITION.

2. Double-click Setup.exe. You will see a window similar to Figure 7-29.

3. Choose a language for installation. For our example, we chose English (United States) and click OK. You will see a window similar to Figure 7-31.
4. It is recommended that you exit all other programs before starting the installation. Click **Next** to proceed with the installation. You will see a window similar to Figure 7-31.
5. Choose an Installation type based on the service you require. For our example, select **Typical**. You will see a window similar to Figure 7-32.
6. Review the information window and click **OK**.

![Start Copying Files window](image)

**Figure 7-33   Start Copying Files window**

7. The installer detects the components and their destination directory. Click **Next** to begin copying files to your hard drive. Once completed, you will see a window similar to Figure 7-34.
8. Click **Finish** to complete the installation. Please take the time to read the readme.html for product-related information.

### 7.5 IBM MQSeries V5.2.1 (WebSphere MQ) installation

MQSeries messaging products enable application integration by helping business applications to exchange information across different platforms by sending and receiving data as messages. They take care of network interfaces, assure “once only” delivery of messages, deal with communications protocols, dynamically distribute workload across available resources, handle recovery after system problems, and help make programs portable, so programmers can use their skills to handle key business requirements instead of wrestling with underlying network complexities.

MQSeries provides a consistent multi-platform, application-programming interface. A key factor is time-independent processing. This means that messages are dealt with promptly, even if one of the recipients is temporarily unavailable.
7.5.1 Pre-installation tasks

Prior to installing IBM MQSeries V5.2.1, the following checks and tasks need to be completed on the MQSeries server machine:

1. Create a user named “mqadmin” and assign it to the Administrators group.
   Note that the user ID should be locally defined and not a member of a Windows domain.
   a. Click Start - > Run. Type \compmgmt.msc and press Enter.
   b. Expand Systems Tools and then Local Users and Groups.
   c. Right-click Users and click New User to create the new user ID.
   d. Type mqadmin and its password. Provide a description and set the password setting. Click Create and then click Close.
   e. Under the Users folder, access the mqadmin user ID and click Properties. Make this user a member of the Administrators group.

2. Assign rights to this user:
   b. Right-click Act as part of the Operating System and click Security.
   c. Click Add twice to add mqadmin to this policy and click OK twice to return to User Rights Assignment.
   d. Right-click Log on as a Service and click Security.
   e. Click Add twice to add mqadmin to this policy and click OK twice to return to User Rights Assignment.
   f. Click X to exit.

7.5.2 Installing MQSeries V5.2.1

Perform the following steps to install IBM MQSeries:

1. Insert the CD into the CD-ROM drive. Use the Windows Explorer to access the CD.

2. Double-click Setup.exe. You will see a window similar to Figure 7-36.
3. Use Launchpad to identify and load your software requirements. Click **Software Prerequisites**. You will see a window similar to Figure 7-37.
4. Setup detects the installed components and lists each item (as shown in Figure 7-36). Make sure that all the components listed are checked OK. Click **2 Network Prerequisites**. You will see a window similar to Figure 7-38.
5. Select **No** as the answer to the question “Do both conditions apply?” Click **3 MQSeries Installation** and you will see a window similar to Figure 7-39.
6. This window informs you of your pre-installation status. If there is an error, it will appear here. In our example, we had no errors. Click the Launch MQSeries Installer icon. You will see a window similar to Figure 7-39.
7. Click **Next** and you will see a window similar to Figure 7-40.

![MQSeries Setup window](image)

**Figure 7-39** MQSeries Setup window

![License Agreement window](image)

**Figure 7-40** License Agreement
8. Select I accept the terms and the license agreement. Click Next. You will see a window similar to Figure 7-41.

![Setup Type window](image)

**Figure 7-41  Setup Type window**

9. Choose Typical from the Setup Type window and click Next. You will see a window similar to Figure 7-42.
10. After reviewing the installation folders, click Install. You will see a window similar to Figure 7-43.
11. Click **Finish** to complete the installation process and use the Prepare MQ Wizard for configuring MQSeries.
12. Click **Next** in the Prepare MQSeries Wizard window. You will see a window similar to Figure 7-45.
13. Determine if there is a Windows 2000 domain controller in the network. In our example, a Windows 2000 domain controller did not exist. We chose No. Click Next. You will see a window similar to Figure 7-46.
14. Click **Setup the Default Configuration** link to launch the Default Configuration wizard. You will see a window similar to Figure 7-47.
15. Click **Next** to continue. You will see a window similar to Figure 7-48.
16. This wizard configures a Queue Manager and a Default Cluster. Click **Next**. You will see a window similar Figure 7-49.
17. MQSeries creates a Queue Manager on this computer with QM_machine name as the format. Select both the **Allow remote administration of the queue** and **Join the queue manager to the default cluster** options. Click **Next** to continue. You will see a window similar to Figure 7-50.
18. This step identifies whether to create a default cluster on the machine. Select **Yes, make it the repository for the cluster** and click **Next**. You will see a window similar to Figure 7-51.
19. Click **Finish** when you have completed reviewing the information. You will see a window similar to Figure 7-52.
20. When you see the Default Configuration Complete window (Figure 7-52), the configuration has completed successfully. Click Close to return to the main installation. You will see a window similar to Figure 7-53.
21. Click **Next**. You will see a window similar to Figure 7-54.
22. Leave the default options check (Launch MQSeries First Steps and Launch Notepad to view the release notes). Click **Finish** to complete the installation process.

### 7.5.3 Post installation task

For installing our sample application the user (mqadmin) must be a part of the groups that MQSeries creates (explained in the coming pages). To associate the user mqadmin to these groups we need to do the necessary steps:

1. Click **Start** -> **Run**. Type `compmgmt.msc` and press Enter. Expand **Systems Tools** and **Local Users and Groups**. Click **Users**. You will see a window similar to Figure 7-55.
2. Right-click `mqadmin` and select **Properties**. You will see a window similar to Figure 7-56.
3. Click the **Member Of** tab and then click **Add**. You will see a window similar to Figure 7-57.

![Figure 7-56 Member of groups window](image)

Chapter 7. Build your WebSphere staging environment
4. Select all the groups that MQSeries created for you. These include:
   - mqbrasgn
   - mqbrdevt
   - mqbrkrs
   - mqbrops
   - mqbrtpic
   - mqm

5. Click **Add**. You will see a window similar to Figure 7-58.
6. Click OK. You will see a window similar to Figure 7-59.
7. The groups you selected have now been placed under the **Member Of** tab. Click **Apply** and **OK**.
7.5.4 Installing SupportPac MA88 (MQSeries Class for Java and JMS)

SupportPac MA88 provides support for developing MQSeries applications in Java (for deployment on MQSeries V5.2) through the following APIs:

- MQSeries classes for Java
  
  The MQSeries classes for Java allow a program written in the Java programming language to connect to MQSeries as an MQSeries client using TCP/IP, or directly to an MQSeries server using the Java Native Interface (JNI). They allow Java applets, applications, and servlets access to the messaging and queuing services of MQSeries. If the client-style connection is used, no additional MQSeries code is required on the client machine. The MQSeries classes for Java enable a message-based approach to application integration using Java.

- MQSeries classes for Java Message Service (JMS)
  
  MQSeries classes for Java Message Service is a set of Java classes that implement Sun Microsystem's Java Message Service specification. A JMS application can use the classes to send MQSeries messages to either existing MQSeries or new JMS applications. An application can be configured to connect as an MQSeries client using TCP/IP, or directly using the Java Native Interface (JNI). If the client-style connection is used, no additional MQSeries code is required on the client machine.

  Use of the MQSeries classes for Java Message Service offers benefits associated with using an open standard to write MQSeries applications, such as the protection of investment both in skills and application code. In addition the JMS classes provide some additional features not present in the MQSeries classes for Java. These extra features include:
  - Explicit support for publish and subscribe
  - Asynchronous message delivery
  - Message selectors
  - Structured message classes
  - Support for XA transactions via the XAResource interface (not available for OS/390 or z/OS)

In this section, we install the MQSeries classes for Java and Java Message Service.

1. Download MA88 from the following Web site:
   

2. Extract the zip file to a temporary location.

3. Run the setup.exe. You will see a window similar to Figure 7-60.
4. In our example, we chose English (United States) as our language. Click OK.
   You will see a window similar to Figure 7-61.

5. Click Next to proceed. You will see a window similar to Figure 7-62.
6. Read through the license agreement and click **I accept the license agreement** and then click **Next**. You will see a window similar to Figure 7-63.
7. Choose the setup type. For our example, choose **Complete** and then click **Next**. You will see a window similar to Figure 7-64.
8. Click **Install** to start the installation process. After the IBM MQSeries classes for Java and MQSeries classes for Java Message Service have completed their installation process, click **Finish** to exit.
7.6 MQSeries Workflow V3.3.2 (WebSphere MQ Workflow) installation

MQSeries Workflow is used to design, document, execute, control, improve, and optimize the business processes, so you can focus on the company’s key objectives. After modeling your processes with the MQSeries Workflow Buildtime, the MQSeries Workflow Runtime runs them by navigating through the workflow models. Applications are invoked automatically, and work items are created and distributed to the worklists of people involved.

Begin the installation of MQSeries Workflow by performing the following steps:

1. Insert the CD into the CD-ROM drive.
2. Use the Explorer to locate and run the MQSeries Workflow Setup.exe file.
3. Choose the language you would like to install for MQSeries Workflow. For our example, we used the default English. Click **Next**. You will see a window similar to Figure 7-66.
4. Read through the license agreement carefully and click **Accept** to install the software. You will see a window similar to Figure 7-67.
5. Click **Next**. You will see a window similar to Figure 7-68.
6. Choose the destination location for the MQ Workflow installation. In our example, we used the default destination folder. Click Next and you will see a window similar to Figure 7-69.

![Setup Type window](image)

Figure 7-69 Setup Type window

7. Click All Components and click Next. You will see a window similar to Figure 7-70.
8. By default all components were selected. Click **Next**. You will see a window similar to Figure 7-71.
9. Type in a new folder name. For our example, we used the default program folder. Click *Next*. You will see a window similar to Figure 7-72.
10. Review the settings and click **Next**. The required components are installed. This may take a few minutes. Afterwards, you will see a window similar to Figure 7-73.
11. Select **Yes, I want to restart my computer now**. Click **Finish**.
7.6.1 Configuring MQSeries Workflow

To run our sample application, we need to perform the following steps:

1. After your computer restarts, the Workflow Configuration Utility will appear by default. You can also go to Workflow Configuration Utility by clicking Start -> Programs -> IBM MQSeries WorkFlow -> MQSeries Workflow Configuration Utility. You will see a window similar to Figure 7-74.

![Figure 7-74 MQSeries Workflow Configuration window](image)

2. Click New to open a new window. You will see a window similar to Figure 7-74.

![Figure 7-75 MQSeries Workflow Configuration ID window](image)
3. The Configuration ID will appear by default. Accept the default and click **OK**. You will see a window similar to Figure 7-75.

![MQSeries Workflow Configuration window](image)

**Figure 7-76**  MQSeries Workflow Configuration window

4. To configure installed components, check the following items in the General tab:
   - Server
   - Runtime Database Utilities
   - Buildtime
   - Client

Click **Next**. You will see a window similar to Figure 7-77.
5. In the Runtime Database tab, perform the following:
   a. Select the database instance name. For our example, click **DB2**. You will see a window similar to Figure 7-78.

*Figure 7-77  Runtime Database tab*
b. Create a new database by clicking **New**. You will see a window similar to Figure 7-79.
c. This opens up a new window. This window is configured by default. Click **OK**. You will see a window similar to Figure 7-80.

![New DB2 Database window](image)

**Figure 7-79  New DB2 Database window**
### Chapter 7. Build your WebSphere staging environment

**Figure 7-80   Runtime Database tab**

1. Select a DB2 instance already catalogued

   ![DB2 Connect parameters](Image)

2. Select an existing database or create a new database

   ![Connect Parameters](Image)

3. Select a system

   Configuration ID: FMC  
   System Group: FMCGRP  
   System: FMCSYS  

**Figure 7-81   Connect Parameters**

- Click **DB2 Connect parameters**. You will see a window similar to Figure 7-81.

Enter DB2 userid and password

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>db2admin</td>
</tr>
<tr>
<td>Password</td>
<td>**********</td>
</tr>
</tbody>
</table>

**Figure 7-81   Connect Parameters**
e. Type the DB2 user ID and password into the respective fields. Click OK. You will see a window similar to Figure 7-82.

![Runtime Database Configuration](image)

**Figure 7-82  Runtime Database Configuration**

f. Select a system from the list. In our example, we selected **FMCSYS.FMCGRP,FMC,FMCQM**. Click Next. You will see a window similar to Figure 7-83.
6. In the Queue Manager tab (Figure 7-83), check if the Queue Manager Name and Queue Prefix are all ready configured. Check the Log type as **Circular Log** and click **Next**.
7. In the Cluster tab, fill in the Cluster Name and check the first Queue Manager in the Cluster radio button. Click Next. You will see a window similar to Figure 7-85.

Note: This is the default configuration. However, in real-life applications there are a lot of performance issues that need to be handled.
Figure 7-85  Client Configuration window

8. In the Connect name field, click Add. You will see a window similar to Figure 7-86.
9. Fill in the fields System Group, System, Queue Prefix, Queue Manager (this is configured by default) as shown in Figure 7-86. Click **Add**. You will see a window similar to Figure 7-87.
10. Click **Next**. You will see a window similar to Figure 7-88.
11. In the Buildtime tab, select **IBM DB2 Universal Database** and click **Next**. You will see a window similar to Figure 7-89.

Figure 7-88  **Buildtime Configuration**
12. At the BuildTime Database tab:
   a. Select **DB2** instance. You will see a window similar to Figure 7-90.
b. Click **New** to create a new database (this is configured by default). You will see a window similar to Figure 7-91.
c. Click **OK**. You will see a window similar to Figure 7-92.
d. Click **DB2 Connect Parameters**. You will see a window similar to Figure 7-93. It is required to enter the user ID and password for the database you are connecting to.
e. Click **OK** and then click **Next**. You will see a window similar to Figure 7-94.

![Figure 7-94  Client tab](image)

13. In the Client tab, click **Done**. You see a window similar to Figure 7-95. You have successfully configured MQ Workflow.

![Figure 7-95  MQSeries Workflow Configuration window (successfully completed)](image)
7.7 WebSphere MQ Integrator V2.1 installation

WebSphere MQ Integrator (MQSeries Integrator) is a part of the MQSeries family that provides business integration and business process management (BPM) functions to the IBM WebSphere software platform for e-business. It increases the efficiency of processes such as supply chain management, enterprise resource planning, mergers and acquisitions, and straight-through processing.

As an information broker, WebSphere MQ Integrator selects and distributes information to applications and databases as needed. Users can implement real-time, application-to-application message transformation and intelligent message routing quickly and easily. Business effectiveness across the enterprise is improved by tighter integration with existing applications, leading Enterprise Resource Planning (ERP) systems and software packages.

Perform the following steps to install WebSphere MQ Integrator V2.1:

1. Log in as mqadmin
2. Insert the CD into the CD-ROM drive.
3. Use the Windows Explorer to locate and run the WebSphere MQ Integrator Setup.exe file.

![Select Setup Language window](image)

Figure 7-96 Select Setup Language window

1. Choose the language from this installation from the list and click **OK**. You will see a window similar to Figure 7-97.
2. Before you install this software, it is strongly recommended that you exit all other programs. Click **Next**. You will see a window similar to Figure 7-98.
3. Review the license agreement carefully and click **Accept** to install the software. You will see a window similar to Figure 7-99.

![Choose target directory window](image)

Figure 7-99  Choose target directory window

4. Choose a target directory for installing IBM MQ Integrator. Click **Next**. You will see a window similar to Figure 7-100.

![Setup Type window](image)

Figure 7-100  Setup Type window
5. Click **Full Install**. The setup program correspondingly lists the components that are included in the text area below. Click **Next**. You will see a window similar to Figure 7-101.

![Figure 7-101 Select program folder window](image1)

6. Accept the default folder name that appears in the window and click **Next**. This is shown in Figure 7-102.

![Figure 7-102 Ready to copy files window](image2)
7. Take some time to review your settings. If you want to change some settings, click Back. To proceed with the installation, click Next. The required components are installed.

![Image](image1.png)

Figure 7-103  NNSYRules and NNSYFormatter Installation window

8. Click Next to launch the NNSYRules and NNSYFormatter Support installation. Review your settings and click Next to proceed with the installation. When NNSY components are installed successfully, click OK.

![Image](image2.png)

Figure 7-104  Setup complete window
9. To complete the installation, click **Finish** and restart your system.

### 7.7.1 Installing CSD 00 (FPU200167) for MQ Integrator V2.1

In this section, we install the corrective service disk for WebSphere MQ Integrator. Download the CSD from either of the following Web sites and begin the installation:


![Select Setup Language window](image)

**Figure 7-105**  *Select Setup Language window*

1. Choose the language for installation and click **OK**. You will see a window similar to Figure 7-105.

![Choose Destination Directory window](image)

**Figure 7-106**  *Choose Destination Directory window*
2. Choose the destination location for the CSD installation. Ensure that you do not have any MQ Integrator process and services active and click **Next**. You will see a window similar to Figure 7-107.

![Figure 7-107](image)

**Figure 7-107** Ready to copy files window

3. Review the settings and click **Next** to proceed with the installation. After several files have been copied, you will see a window similar to Figure 7-108.

![Figure 7-108](image)

**Figure 7-108** NNSYRules and NNSYFormatter Installation window
4. Click **Next** to install NNSYRules and NNSYFormatter support. When NNSY support has been successfully installed, click **OK**.

![CSD Install Complete window](image)

*Figure 7-109  CSD Install Complete window*

5. Click **Finish** to complete the installation and restart your computer.
7.7.2 Configuring the databases for MQ Integrator V2.1

The following are the steps required to run our sample application:

1. MQ Workflow needs to have three databases named MRM, CFGm and Broker to work with our sample application. Click Start -> Programs -> IBM DB2 -> Command Window.

2. Type `db2 create database mrm`.

3. Type `db2 create database cfg`.

4. Type `db2 create database broker`.

5. DB2 indicates the result of creation of the databases in a window similar to Figure 7-110.

6. Type `Exit` to close the DB2 command window.

7. After creating the databases, we need to register the Open Database Connectivity (ODBC) names. Perform the following steps to register the databases:

   a. Click Start -> Programs -> IBM DB2 -> Client Configuration Assistant and check if the databases are created. You will see a window similar to Figure 7-111.
8. Click **Properties** and you will see a window similar to Figure 7-112.

![Figure 7-112 Database Properties - BROKER window](image)
9. Check **Register this database for ODBC** and click **OK** and you will see a window similar to Figure 7-114.

![Database Properties - BROKER window](image1)

**Figure 7-113 Database Properties - BROKER window**

![DB2 Message window](image2)

**Figure 7-114 DB2 Message window**

10. You will see a pop-up window that indicates that the database has been updated. Click **OK** and you will see a window similar to Figure 7-115.
11. The changes are reflected in the Client Configuration Assistant (for BROKER Database). Follow a similar procedure for the CFG and MRM databases you have created and register the OBDC names. This is shown in Figure 7-116.
12. Configuring the databases for MQ Integrator is complete.

### 7.7.3 Creating and configuring Configuration Manager and Broker

In this section, we need to configure another segment of the MQSI V2.1. This configuration of MQSI includes the following:

- Creating Configuration Manager
- Creating the Broker

Perform the following steps to create the Configuration Manager:

1. Log in as mqadmin.

    **Note**: mqadmin should be a member of all the groups MQSeries creates.

2. Go to Start -> Programs -> IBM WebSphere MQIntegrator 2.1 -> Command Assistant -> Create Configuration Manager. You will see a window similar to Figure 7-117.
3. Next, we must find the Queue Managers name to configure WebSphere MQ Integrator. Click Start -> Programs -> IBM MQSeries -> MQSeries Explorer. You will see a window similar to Figure 7-118. Click Queue Manager. In the right-hand pane, the Queue Manager’s name is listed. In our example, it is QM_m23x2673.

Figure 7-117   WebSphere MQ Integrator - Create Configuration Manager window
4. In the Create Configuration Manager (shown in Figure 7-119), enter the Service ID. In this case, it is the same login to the operating system. Enter the password for this service ID. Enter the Queue Manager name. For our example, we used QM_m23x2673. Click **Next**.
Figure 7-119  WebSphere MQ Integrator - Create Configuration Manager window

Note: It is mandatory to fill in the fields marked in blue. Others can be filled in if known.
5. Enter the ConfigMgr Database name and the MRM ODBC Data Source name, which we created earlier and click **Next**. For our example, it was cfg and mrm, respectively.
6. Click **Finish** to complete creating a Configuration Manager as shown in Figure 7-121. After clicking **Finish**, you will see a window similar to Figure 7-122.

7. Go to the next window.
8. When the process has been successfully completed, click **OK** to continue.

**Create a Broker**

Perform the following steps to create a Broker:

1. Click **Start -> Programs -> IBM WebSphere MQIntegrator 2.1 -> Command Assistant -> Create Broker.**

2. Enter the broker name, service user ID, password, and queue manager name and click **Next.** You will see a window similar to Figure 7-125.
3. Enter the Broker Name you want to create and the OBDC Data source name that was created for the broker database. Click **Next**. You will see a window similar to Figure 7-126.

*Figure 7-125  WebSphere MQ Integrator - Create Broker window*
4. Click Finish and the successful creation of the broker will be indicated.

7.7.4 Autostarting Broker and Configuration Manager on reboot

In this section, configure the Broker and Configuration Manager to start automatically:

2. Right-click IBM MQSeries Broker BROKER and click Properties.
3. In the Startup drop-down list, choose Automatic and click OK.
4. Right-click IBM MQSeries Broker ConfigMgr and click Properties.
5. In the Startup drop-down list, choose Automatic and click OK.
   This will automatically start the service when rebooted.
7.7.5 Configuring WebSphere MQ Integrator V2.1

Perform the following instructions to complete the configuration of the WebSphere MQ Integrator:

1. Click Start -> Settings -> Control Panel -> Administrative Tools -> Services. Start the following services:
   - IBM MQSeries Broker called "BROKER".
   - IBM MQSeries Broker called "ConfigMgr".

   Note: The names that appear are based on the name of the broker and the configuration manager you created in the previous steps.

2. Click Start -> Programs -> MQ Integrator -> Control Center. You will see a window similar to Figure 7-127.

![Configuration Manager Connection window](image)

   Figure 7-127 Configuration Manager Connection window

3. Enter the host name, port and queue manager name and click OK. You will see a window similar to Figure 7-128. (The default port is 1414.)
4. Click the **Topology** tab. You will see a window similar to Figure 7-129.
5. From the left pane, right-click **Topology -> Checkout**.

![WebSphere MQ Integrator Control Center window](image1)

Figure 7-130  WebSphere MQ Integrator Control Center window

6. In the right pane, right-click **Topology -> Create -> Collective**. You will see a window similar to Figure 7-131.

![Create a new Collective window](image2)

Figure 7-131  Create a new Collective window

7. Type **Collective** in the Name field. You will see a window similar to Figure 7-132.
8. Right-click **Topology -> Create -> Broker**. You will see a window similar to Figure 7-133.

9. Name the Broker and Queue Manager. For our example, the Broker name is “BROKER” and our Queue Manager is named “QM_m23x2673”. Click **Finish** and you will see a window similar to Figure 7-134.
10. The Broker is placed in the right pane as shown in Figure 7-134.
11. In the left-hand pane, right-click **Collective** and click **Add -> Broker**. You will see a window similar to Figure 7-136.

![Add an existing Broker window](image)

**Figure 7-136** Add an existing Broker window

12. Select **BROKER** and click **Finish**. You will see a window similar to Figure 7-137.

![WebSphere MQ Integrator Control Center window](image)

**Figure 7-137** WebSphere MQ Integrator Control Center window

13. In the right pane of the Topology tab, notice that **BROKER** has been integrated within **Collective**. Go to Figure 7-138.
14. Right-click **Topology -> Deploy -> Complete Topology Configuration**. If your configuration is correct, you will see a window similar to Figure 7-139.

15. Click **OK**.

16. From the WebSphere MQ Integrator Control Center window, click **File -> Save WorkSpace As** and type in the Filename field the name of your XML file.
7.8 Creation of the POENTRY queue

As discussed in 6.5.1, “Create POENTRY queue” on page 159, after completing the setup and configuration of our development environment we stopped to configure the POENTRY queue. The POENTRY queue is necessary to test our sample application within the development environment and our staging environment. Use the instructions in 6.5.1, “Create POENTRY queue” on page 159 to create the queue at this time.

7.9 Configuring the sample application in our WebSphere Application Server staging environment

To run our sample application, we need to perform the following steps:

1. First, check to ensure that the following services are running. If not start them:
   - IBM DB2 UDB
   - IBM HTTP Server
   - IBM WS AdminServer 4.0
   - IBM MQSeries

2. Start the WebSphere Administrative Console. From the Windows desktop, click Start -> Program Files -> IBM WebSphere -> Application Server V4.0 AE -> Start Administrative Console. You will see a window similar to Figure 7-140.
From this window, you will retrieve your .ear file (the sample application that was created in 6.5.2, “Create WebSphere Studio Application Developer projects” on page 160).
3. In order for the WSADMQDemo application to communicate with WebSphere MQ, the Classpath for WebSphere must be modified. The following are JAR files that are used for running MQSeries:
   - com.ibm.mq.jar
   - jta.jar

   To add JAR files to the class path do the following:
   a. Expand the Nodes folder by clicking + if it is not already expanded.
   b. Expand the node by clicking + if not already expanded.

Note: Enterprise Archive (EAR) files are zipped archive files that contain J2EE application components such as Web applications (packaged in WAR files) and EJBs. J2EE application containers import EAR files into the application environment at runtime and deploy the components within each EAR file as separate Web applications.
c. Expand the Application Servers folders by clicking + if not already expanded.

d. Click Default Server under the Application Servers folder.

e. In the right pane, click the JVM Settings tab.

f. Click Add to add the JAR files into the Classpaths section.

Note: By default these JAR files are found in the C:\Program Files\IBM\MQSeries\Java\lib directory.

g. After both files have been inserted into the Classpaths section, click Apply.

h. In order for the changes to the classpath to be used, you must stop the Default Server if it is running and restart it. Right-click Default Server and click Stop. Wait for message to appear that the service has stopped.

i. To restart the Default Server, right-click Default Server and click Start.

Note: Whenever you make changes to an object within WebSphere, you must stop and restart the object in order for the changes to take effect. An object includes an application server, node, etc.
4. Import the .ear file created from our development stage. Click **Console -> Wizards -> Install Enterprise Application**. You will see a window similar to Figure 7-143.
5. This opens a wizard for deploying the .ear application. Choose the machine name for the Browse for file on Node. Choose the Install Application(*.ear), and locate the .ear file by clicking Browse. Type in the Application name that you would like to appear. Click Next. You will see a window similar to Figure 7-144.

In our example, the machine name where our .ear file is located is m23bk59z. The .ear file is WASMQDEMO.ear.
6. Click **Next** several times until you see a window similar to Figure 7-144. Here you will specify the virtual host if it exists. For our example, we did not configure a virtual host. Click **Next**. You will see a window similar to Figure 7-145.
7. Click **Select Server** to select the server where your application is running. In our case, this was the default server. You will see a window similar to Figure 7-146.
Note: Our sample application is not configured for EJBs, so most of these steps are not required. However, if you are configuring EJBs, you have to fill in all the required steps.

8. Select your application server. This option is useful when we configure clustering. Click Next. You will see a window similar to Figure 7-147.
Figure 7-147  Install Enterprise Application Wizard window

9. Review your settings and then click **Finish**. When the installation has completed successfully, click **OK**.
1. Starting the demo application. Click + near Enterprise Applications if it is not already open. You will get to see the application you have just created. Right-click this test application you have created and click Start to make the application available. This is shown in Figure 7-149.

2. Click OK to continue.
3. Expand the Nodes folder. Click + to open up your current node. Right-click **m23bk59z** and click **Regen Webserver Plugin.** This should be done after you add a new application to refresh the Web server.

4. Ensure IBM HTTP Server is running. From a Windows command prompt, type `net start "IBM HTTP Server"` and press Enter, and then return to the WebSphere Advanced Administrative Console window.

### 7.9.1 Running the sample application

WebSphere Studio Application Developer includes WebSphere 4.0.2 Advanced Single Server Edition for testing your enterprise applications with the IDE. To run the application do the following:

1. Open a browser window and go to the following URL:

   http://localhost/WSADMQDemoWeb/
2. Click **EnterPO**.
3. Enter a customer name, item number, and quantity, and click **Send order**.
4. Once the message has been submitted to MQ, you will be directed to a page stating **The message has been sent**.
5. Click **List POs** to view all entries on the MQ queue.
6. Click **SubmitPO** to add another entry to the queue. Once submitted, click **List POs** to view all entries on the MQ queue.

**Note:** If you receive a DNS error, check the proxy settings for Microsoft Internet Explorer to make sure you are not using a proxy or SOCKS server.

You must use Internet Explorer 5.x to display XML data islands from the List POs link.
Build your WebSphere production environment

Based on the sizing configurator recommendations and the results obtained from your test or staging environment, you will build your production environment. Establishing a WebSphere Application Server production environment for an e-business application and transitioning a new system into operation will include the setup, configuring, and consideration of the following:

1. List hardware and software requirements.
2. Provide step-by-step instructions to install hardware and software for a production environment as well as instructions to deploy Business Partner application.

This chapter provides instructions for installing and configuring a typical production environment. For our environment, we configured our WebSphere Application Server running under IBM AIX V4.3.3 on an IBM RS/6000.
8.1 Software used in our production environment

The following software products were used on our production machine:

- IBM AIX V4.3.3 with latest fixes (ML09)
- IBM DB2 Universal Database V7.2 Enterprise Edition and FixPak 6
- IBM WebSphere MQ Integrator V2.1 (formerly MQSeries Integrator)
- IBM MQSeries Workflow V3.3.2 (WebSphere MQ Workflow)
- IBM WebSphere Application Server V4.1 Enterprise Edition

IBM WebSphere Application Server Enterprise Edition is composed of the following products:
- IBM WebSphere Application Server V4.0.1 Advanced Edition
- IBM MQSeries V5.2 (WebSphere MQ)
- IBM WebSphere Enterprise components
- IBM TX Series

Note: We did not install IBM TX Series.

8.2 Hardware used in our production environment

In our production environment running AIX V4.3.3 with FixPak ML09, we used an IBM RS/6000 44P Model 170 (7044-170) with the following:

- CPU: IBM Power3-II 333 Mhz
- Memory: 1 GB
- Hard drive: 2 x 18 GB
- 100 Mb Ethernet

8.3 IBM DB2 UDB V7.2 Enterprise Edition installation

The installation of IBM DB2 UDB V7.2 EE for AIX is accomplished via a text-based installer. To install IBM DB2 UDB V7.2 EE for AIX, perform the following procedures:

1. From the IBM WebSphere Application Server V4.1 Enterprise Edition package for AIX, insert the CD labeled IBM WebSphere Application Server Advanced Edition for AIX V4.0, which includes IBM DB2 Universal Database Enterprise Edition V7.2 - English into the CD-ROM drive.

2. As root, from a command line execute the following commands:

   a. `mount -r -v cdrfs /dev/cd0 /mnt`

   b. `cd /mnt`
3. Execute `./db2setup` to start the DB2 installer.

**Note:** If you are not currently root but know the root password, execute the `su -` command from the command line and enter the root password when prompted.

![Install DB2 V7 window](image)

Figure 8-1 Install DB2 V7 window

4. Press the Spacebar to select **DB2 Administration Client** for installation.

5. Press the Tab key twice to move the cursor to the DB2 Enterprise Edition field and press the Spacebar to select it.

6. Press the Tab key six times until **OK** is selected, then press Enter to continue with the installation.
7. Using the Tab key, move the cursor to the Create a DB2 Instance field and press the Spacebar.
8. Using the Tab key, move the cursor to the password field and enter a password for the db2inst1 ID that will be created. Remember the password you enter, since it will be needed when configuring WebSphere Application Server, MQSeries (WebSphere MQ), WebSphere MQ Integrato, and MQSeries Workflow (WebSphere Workflow).

9. Press the Tab key and re-enter the password for the db2inst1 ID.

10. Using the Tab key move the cursor to OK and press Enter.
11. Using the Tab key, move the cursor to the Password field and enter a password for the db2fenc1 ID that will be created.

12. Press the Tab key and re-enter the password for the db2fenc1 ID.

13. Using the Tab key, move the cursor to OK and press Enter.
14. Using the Tab key, move the cursor to Do not set up DB2 Warehouse Control Database and press the Spacebar.

15. Using the Tab key, move the cursor to OK and press Enter.
16. Using the Tab key, move the cursor to Create the Administration Server and press the Spacebar.
17. Using the Tab key, move the cursor to the Password field and enter a password for the db2as ID that will be created.

18. Press the Tab key to move the cursor to the Verify Password field and re-enter the password for the db2as ID.

19. Using the Tab key, move the cursor to OK and press the Spacebar.
20. The DB2 installer will set the DB2SYSTEM variable for you. Press Enter to continue.
21. Using the Tab key, move the cursor to OK and press Enter.
22. The installer will list the components to be installed. Press Enter to continue.
23. This is your last chance to cancel the installation. Press Enter to begin installing DB2.
24. The DB2 setup utility will begin installing files. Be sure to complete the registration of DB2 during the installation process. When the installation is complete, you will see a window similar to Figure 8-13.

Figure 8-12  DB2 Setup Utility window
Figure 8-13  DB2 Setup Utility window

25. DB2 installation is complete. Press Enter. You will see a window similar to Figure 8-14.
26. The DB2 installer will display a status report. Verify that all components were installed successfully by doing the following:
   a. Using the Tab key, move the cursor to More... and press Enter.
   b. Make sure that all components show Success and press Enter to show more components as needed.

27. Using the Tab key, move the cursor to OK and press Enter.
Figure 8-15  DB2 Setup Utility window

28. Press Enter to close the Setup Utility.

29. To unmount the DB2 CD, execute the following commands from the command line:

   ```
   cd
   umount /mnt
   ```

8.3.1 Updating DB2 to latest FixPak

In order to make sure you have the latest fixes applied to DB2 UDB Enterprise Edition, perform the following:

**Note:** At the time of writing, FixPak 6 was the latest FixPak available.

1. Go to the following Web site:

   ```
   ```

   You will see a window with a section similar to Figure 8-16.
2. Select Version 7 from the DB2 Version drop-down list.
3. Select AIX from the Operating System drop-down list.
4. Select Enterprise from the Product drop-down list.
5. Click Download. You will see a window similar to Figure 8-17.
You have asked to download the following DB2 FixPak:

<table>
<thead>
<tr>
<th>Version</th>
<th>V7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>AIX</td>
</tr>
<tr>
<td>FixPak</td>
<td>6</td>
</tr>
<tr>
<td>Number</td>
<td>6</td>
</tr>
<tr>
<td>Language</td>
<td>english-us</td>
</tr>
</tbody>
</table>

Figure 8-17  Download site window

6. Click **Continue** to go to the download site. You will see a window similar to Figure 8-18.
7. Select the **FP6_U481406.tar.Z** file to download the FixPak and enter a location to store the file. Remember the location where you stored the file.

8. Open the FixpakReadme.txt file to view pertinent information.

9. Once the FixPak has been downloaded, access the directory where you stored the FixPak.

10. To uncompress the file, execute the following commands:

    ```
    gzip -d FP6_U481406.tar.Z
    tar -xvf FP6_U481406.tar
    ```

**Note:** Be sure to check the Web site for the latest available FixPak FP#_XXXXXXX. Replace FP#_XXXXXXX with the name of the FixPak you downloaded.

11. Change to the directory created when you untarred the FixPak by executing `cd delta_install`.

12. Prior to installing the FixPak, you must stop all DB2 instances. To stop the admin and the db2inst2 instances that were created during installation, from a command prompt execute the following commands as root:

    ```
    su - db2as -c db2admin stop
    ```
13. To install the FixPak, execute from a command prompt .\installFixPak and follow the prompts.

14. Once the FixPak has been installed execute the following commands from a command prompt to update the DB2 instances and restart DB2:

   /usr/lpp/db2_07_01/instance/db2iupdt db2inst1
   /usr/lpp/db2_07_01/instance/dasiupdt db2as

   su - db2inst1 -c db2start

**Note:** If you do not update the instances, DB2 may not restart correctly.

su - db2inst1 -c db2start

**Figure 8-21** Expected results from su - db2inst1 -c db2start

su - db2as -c db2admin start

**Figure 8-22** Expected results from su - db2as db2admin start

### 8.3.2 Post-installation tasks

Once the installation of DB2 is complete, enter the following to set DB2 to autostart the db2inst1 instance on reboot:

/usr/lpp/db2_07_01/instance/db2iauto -on db2inst1
8.4 IBM WebSphere Application Server V4.0 Advanced Edition installation

In this section, we install IBM WebSphere Application Server V4.0.1 to continue building our production environment.

8.4.1 Pre-installation tasks

Prior to installing WebSphere Application Server, the following tasks must be completed:

1. Check ports
2. Verify free space in /usr

Check ports

The following ports are used by WebSphere Application Server or IBM HTTP Server and need to be available:

<table>
<thead>
<tr>
<th>Application</th>
<th>Port(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSphere Application Server</td>
<td>900, 9000, 9080</td>
</tr>
<tr>
<td>IBM HTTP Server</td>
<td>80</td>
</tr>
</tbody>
</table>

1. Display port usage by executing `netstat -a | more`.
2. Check the page displayed for the ports above, and press the Spacebar to move to the next page or type `q` to quit.
3. If any of the ports above are in use, you will need to stop the application that is using the port.

*Note:* Port 80 will be listed as www if in use.
Verify free space
Installation of WebSphere Application Server AE requires a minimum of 115 MB of free space in /usr if installed to the default location. To verify that you have enough free space and to extend the partition if necessary, do the following:

1. Check available space in /usr:
   a. Execute `df -k` from a command line
   b. Check the entry for /usr. The value in the Freespace column should be at least 120000.

2. Extend /usr if necessary:
   `chfs -a size=+<#blocks> /dev/hd2`

   **Note:** For the # of blocks, insert the # of 512 byte blocks to increase the file system (FS) by. For example, to increase the FS to 100M, we used 200000.

8.4.2 Installing IBM WebSphere Application Server V4.0

To install IBM WebSphere Application Server V4.0 Advanced Edition, perform the following instructions:

1. Insert the CD labeled IBM WebSphere Application Server V4.0.1 for AIX into the CD-ROM drive.

2. From a command prompt, mount the CD by executing:
   `mount -r -v cdrfs /dev/cd0 /mnt`

3. Change to the directory containing the WebSphere code by executing:
   `cd /mnt/aix`

4. Start the JAVA based installer by executing:
   `./install.sh`
   You will see a window with text similar to Figure 8-23.
5. Click **Next** to continue with the installation process. You will see a window with text similar to Figure 8-24.
6. WebSphere will validate its systems requirements against the packages installed on the machine. Verify that the list of packages displayed are at the required version or higher and click **OK**. You will see a window with text similar to Figure 8-25.

   If the packages are not at the required version, then you should cancel installation and update the required packages.
Click the type of Setup you prefer and click Next.

- **Typical Installation**
  Everything you need to support production-level, highly scalable applications intended to run on servers from single-node configurations to complex multi-node configurations; includes IBM HTTP server, IBM DB2, JDK 1.3.0.

- **Custom Installation**
  Choose to install specific components of the total install package; specify the use of other supported databases and Web servers.

`Figure 8-25 Setup type window`

7. Accept the default, Typical Installation. Click **Next** to continue. You will see a window similar to Figure 8-26.

**Note:** A typical installation will install WebSphere Application Server, IBM HTTP Server (IHS), JDK 1.3.0, the IHS WebSphere plug-in and configure WebSphere Application Server to use DB2 as its repository.
IBM WebSphere Application Server Advanced Edition uses a database repository to store information. Indicate the type of the database you would like to use, along with the location, username, and password for the database.

Database Type: DB2

Database Name (Database SID): was40

DB Home: /home/db2inst1

Server Name: 

Port Number: 

Database User ID: db2inst1

Database Password: ********

Figure 8-26  DB2 information window

8. In the Database Name field, type was40.
9. In the DB Home field, type /home/db2inst1.
10. In the Database User ID field, type db2inst1.
11. Enter the password for the db2inst1 user ID in the Database Password field.
12. Click Next to continue. You will see a window with text similar to Figure 8-27.
13. Click **Next** to accept the default installation locations. You will see a window similar to Figure 8-28.
14. Click **Install** to install the components that are listed. When installation is complete, you will see a window similar to Figure 8-29.
15. Click **Finish** to close the installer.

16. The First Steps GUI for WebSphere will be launched automatically when the installer is closed. Since we will be installing the FixPak for WebSphere Application Server, close the First Steps GUI.

17. Unmount the CD. From a command prompt, type `umount /mnt`.

### 8.4.3 Installing IBM WebSphere Application Server FixPak

For our configuration, it is necessary to install the following FixPak to upgrade WebSphere Application Server V4.0.1 AE to V4.0.2. Perform the following instructions:

1. Stop the IHS if running. From a command line, type:
   
   ```
   /usr/HTTPServer/bin/apachectl stop
   ```

2. Use your Web browser to access the following Web site:
   
   ```
   ftp://ftp.software.ibm.com/software/websphere/appserv/support/fixpacks/was40/fixpack2/AIX/
   ```

3. Download the file `was40_ae_ptf_2_AIX.tar` to a temporary directory.
4. From a command line, access the temporary directory where the FixPak was saved.

5. Untar the FixPak by executing `tar -xvf was40_ae_ptf_2_AIX.tar`.

6. To install the FixPak, execute `./install.sh`. You will see text similar to Figure 8-30.

![Figure 8-30  PTF2 installation window](image)

7. When prompted for the WebSphere root directory, type `/usr/WebSphere/AppServer` and press Enter.

8. When prompted to install the IHS Webserver PTF, type `y` and press Enter. Once the IHS PTF has been installed, you will see text similar to Figure 8-31.
9. When prompted to install the Connector Architecture for WebSphere, type \textit{y} and press Enter. Once the Connector Architecture is installed, the FixPak is complete. If there were errors, refer to the FixPak documentation for instructions.

8.4.4 Post installation setup

Once WebSphere Application Server AE has been installed and the FixPak applied, the following tasks need to be performed:

- Set up DB2 database repository for WebSphere
- Modify root user profile to access DB2
- Test the WebSphere Application Server installation
- Set WebSphere Application Server to autostart on reboot

**Set up DB2**

Due to the number of shared memory handles that DB2 opens when accessing a local database, DB2 will be configured to access the WebSphere database via TCPIIP on the local host.
1. To create the database and configure access, as root execute the following from a command line:

   ```shell
   su - db2inst1
   db2 create database wasl
   ```

   ![Figure 8-32](image1.png)
   **Expected results from db2 create database wasl**

2. Verify the port/service that the DB2 instance is listening on by executing:

   ```shell
   db2 get dbm cfg | grep SVCENAME
   ```

   ![Figure 8-33](image2.png)
   **Expected results from db2 get dbm cfg | grep SVCENAME**

   **Note:** The port that DB2 is using is the value to the right of the =, db2cdb2inst1 in our case. Use that value for `db2 port` in the next step.

   ```shell
   db2 catalog tcpip node LOCAL remote localhost server db2 port
   ```

   ![Figure 8-34](image3.png)
   **Expected results from db2 catalog tcpip node LOCAL remote localhost server db2cdb2inst10**

   ```shell
   db2 catalog database wasl as was40 at node LOCAL
   ```

   ![Figure 8-35](image4.png)
   **Expected results from db2 catalog database wasl as was40 at node LOCAL**

3. Log out of the db2inst1 account by typing `exit` and press Enter.

**Modify root user profile**

In order for the root user to access DB2 and allow WebSphere Application Server to run, do the following:
1. Using your favorite editor, append the following lines to root's .profile if they are not already there:
   
   ```bash
   if [ -f /home/db2inst1/sqllib/db2profile ]; then
     . /home/db2inst1/sqllib/db2profile
   fi
   export DB2DIR=/usr/lpp/db2_07_01
   
   if [ -f /home/db2inst1/sqllib/java12/usejdbc2 ]; then
     . /home/db2inst1/sqllib/java12/usejdbc2
   fi
   ```

2. You will need to log out and log in order for the changes to take effect.

   **Note:** If accessing the server locally using a DT terminal, the .dtprofile will be used. Uncommenting the DTSOURCEPROFILE=true line will instruct the DT Terminal to include the .profile settings.

**Test the WebSphere Application Server installation**

In order to test the WebSphere Application Server installation, perform the steps in the following sections.

**Start WebSphere Application Server**

1. As root, start WebSphere Application Server by opening a terminal and executing:
   ```bash
   /usr/WebSphere/AppServer/bin/adminserver.sh
   ```

2. When the message **Server __adminServer open for e-business** appears, proceed to the next step.

3. To start the WebSphere admin client, open another terminal and execute:
   ```bash
   /usr/WebSphere/AppServer/bin/adminclient.sh
   ```

4. In the WebSphere Application Server Admin Client, do the following:
   a. Click + next to WebSphere Administration Domain.
   b. Click + next to Nodes to expand the Nodes folder.
   c. Click + next to your hostname to expand the node.
   d. Click + next to Application Servers to expand the Application Servers folder.
   e. Click **Default Server** to select it. You will see a window similar to Figure 8-36.
f. Right-click Default Server and select Start. When the server has been started, a pop-up window will be displayed stating Command “Default Server.startup” completed successfully. Click OK to close the window.

g. Click + next to Enterprise Applications to expand the folder. You will see a window similar to Figure 8-37.
h. Right-click hostname_sampleApp and select Start to start the WebSphere Application Server sample application. For our example, we clicked m10df4ff.sampleApp. Click OK.

i. Start the IHS server if it is not already running. From a command line, execute:

```
/usr/HTTPServer/bin/apachectl start
```

5. From a Web Browser, go to the following URL:

```
http://hostname/servlet/snoop
```

**Note:** Replace hostname with the host name of the WebSphere Application Server server.

6. If a window similar to Figure 8-38 is displayed, then WebSphere Application Server is running correctly.
Set WebSphere Application Server to autostart on reboot

If you want the WebSphere Application Server to be automatically started after a reboot occurs, do the following:

1. Using your favorite editor, open /etc/inittab.
2. Add the following line at the bottom of the file:
   
   ```
   was:2:once:/usr/WebSphere/AppServer/bin/adminserver.sh 2>&1 >:/usr/WebSphere/AppServer/logs/adminserver.log
   ```
3. Save and close the file.
8.5 IBM WebSphere Application Server V4.1 Enterprise Edition - Enterprise Services installation

Part of WebSphere Application Server V4.1 Enterprise Edition is the Enterprise Services. To install the Enterprise Services, do the following:

1. Insert the CD labeled IBM WebSphere Application Server Enterprise Edition Server and Client for AIX V4.1.

2. Mount the CD by executing:
   ```
   mount -r -v cdrfs /dev/cd0 /mnt
   ```

3. Prior to installing the Enterprise Services, the xlC.rte and xlC.aix43.rte (or xlC.aix50.rte if running AIX 5L) packages need to be updated to 5.x.x.x if not already done. To verify what version of xlC.rte you have installed, execute:
   ```
   lslpp -L | grep xlC
   ```
   You will see output similar to Figure 8-39.

<table>
<thead>
<tr>
<th>Package</th>
<th>Version</th>
<th>Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>xlC.aix43.rte</td>
<td>5.0.2.0</td>
<td>C</td>
<td>C Set ++ Runtime for AIX 4.3</td>
</tr>
<tr>
<td>xlC.cpp</td>
<td>4.3.0.1</td>
<td>C</td>
<td>C for AIX Preprocessor</td>
</tr>
<tr>
<td>xlC.msg.en_US.cpp</td>
<td>4.3.0.1</td>
<td>C</td>
<td>C for AIX Preprocessor Messages</td>
</tr>
<tr>
<td>xlC.msg.en_US.rte</td>
<td>4.0.2.0</td>
<td>C</td>
<td>C Set ++ Runtime Messages--U.S.</td>
</tr>
<tr>
<td>xlC.rte</td>
<td>5.0.2.0</td>
<td>C</td>
<td>C Set ++ Runtime</td>
</tr>
</tbody>
</table>

   **Figure 8-39  Output from lslpp command**

4. In order to install the patches execute the following command:
   ```
   installp -acgXd /mnt/AIX/patches/AIX/ioc xlC.aix43 xlC.rte
   ```

5. Start the installer by executing:
   ```
   /mnt/AIX/EnterpriseEdition/setup
   ```
   You will see a window similar to Figure 8-40.
Welcome. This program will install the IBM WebSphere Enterprise Edition on your computer. Click Cancel to quit Setup. Click Next to continue with Setup.

6. Click Next. You will see a window similar to Figure 8-41.

Select the installation option you prefer and then click Next. Typical Installation to install typical components on your system. Custom Installation to choose specific components.

- Typical Installation,
- Custom Installation.

7. Accept the Typical Installation and click Next to continue. You will see a window similar to Figure 8-42.
8. The installer will locate the WebSphere Application Server directory and install the Enterprise Services components in a subdirectory called Enterprise. Click **Next** to continue. You will see a window similar to Figure 8-43.
9. Click **Next** to install the selected options. The installation and configuration will begin.

10. Once the installation and configuration are complete, you will see a window similar to Figure 8-44.

---

**Figure 8-43** Components window

Options selected for install are listed below, click Back to go back to the previous panel, click Next start installation:

- Install package: WorkArea Service
- Install package: Internationalization Service
- Install package: Business Rule Beans
- Install package: Extended Messaging Support
- Install to directory: /usr/WebSphere/AppServer

Space needed = 7314 Kbytes
Space available = 467829 Kbytes

**Figure 8-44** Installation complete window

Setup has finished installing WebSphere Enterprise Edition on your computer. Click Finish to complete Setup.

☑ Yes, I want to view the ReadMe File.
11. Click **Finish** to exit the installer.
12. To unmount the CD, execute the following:

   `umount /mnt`

---

### 8.6 IBM MQSeries V5.2 (WebSphere MQ) installation

In this section, we install IBM MQSeries 2.1. Perform the following steps:

1. Insert the CD labeled IBM MQSeries for AIX V5.2 into the CD drive.
2. From a command line, execute the following:

   ```
   mount -r -v cdrfs /dev/cd0 /mnt
   installp -acgXd /mnt all
   umount /mnt
   ```

   **Note:** If DCE is not installed, two packages will fail installation:
   - `mqm.dce.server`
   - `mqm.dce.samples`

   This is OK.

For fixes, go to the following Web site:


---

### 8.6.1 Post installation tasks

Once MQSeries (WebSphere MQ) has been installed, the following tasks need to be completed:

- Create the MQSeries Queue Manager
- Set WebSphere MQSeries to autostart on reboot

**Create the MQSeries queue manager**

Once IBM MQSeries is installed, you need to create a queue manager.

**Note:** You can choose any name you like for the queue manager. In our sample application, we refer to the queue manager as `QM_machinename` where `machine name` is in all lowercase. Replace `qmgrname` in the following commands with the name of the queue manager to create.
The following tasks need to be done as the mqm user:

1. Log in as mqm or execute `su - mqm` to switch to the mqm user ID.
2. To create the queue manager execute:
   ```
crtmqm qmgrname
   ```
3. To start the queue manager execute:
   ```
strmqm qmgrname
   ```
4. To get information about the queue manager or any queues in the queue manager, execute the following commands:
   ```
runmqsc qmgrname
   ```
5. To display information on about the queue manager, type:
   ```
dis qmgr
   ```
6. Press Enter. You will see text similar to Figure 8-45.

```
<table>
<thead>
<tr>
<th>AMQ8408: Display Queue Manager details.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESC( )</td>
</tr>
<tr>
<td>DEFEXITQ( )</td>
</tr>
<tr>
<td>CLWLEXIT( )</td>
</tr>
<tr>
<td>REPOS( )</td>
</tr>
<tr>
<td>COMMANDQ(SYSTEM.ADMIN.COMMAND.QUEUE)</td>
</tr>
<tr>
<td>CRDATE(2002-04-11)</td>
</tr>
<tr>
<td>ALTDATE(2002-04-24)</td>
</tr>
<tr>
<td>QMID(QM_m10df55f_2002-04-11_14.49.39)</td>
</tr>
<tr>
<td>MAXHANDS(256)</td>
</tr>
<tr>
<td>AUTHOREV(DISABLED)</td>
</tr>
<tr>
<td>LOCALEV(DISABLED)</td>
</tr>
<tr>
<td>PERFDEV(DISABLED)</td>
</tr>
<tr>
<td>CHAD(DISABLED)</td>
</tr>
<tr>
<td>CLWLLEN(100)</td>
</tr>
<tr>
<td>CCSID(819)</td>
</tr>
<tr>
<td>CMDLEVEL(520)</td>
</tr>
<tr>
<td>SYNCPT</td>
</tr>
</tbody>
</table>
```

Figure 8-45   Expected results from dis qmgr

7. To exit, press Ctrl-C.
8. If you switched to the mqm user ID using the `su - mqm` command in step 1, then type `exit` and press Enter to switch back to the root user. Otherwise, log in as root.
9. Add root to the mqm group. Use your favorite editor to edit `/etc/group`. On the `mqm` line append `root`. Then log out and log in.
Set WebSphere MQ to autostart on reboot
If you want WebSphere MQ to be automatically started after a reboot occurs, do the following:

1. Using your favorite editor, open /etc/inittab.
2. Add the following line at the bottom of the file:
   ```
   wasmq:2:once:/usr/bin/strmqm queue_manager_name > /dev/console 2>&1
   ```

   **Note:** Replace `queue_manager_name` with the name of the queue manager you created above.

3. Save and close the file.

8.7 IBM WebSphere MQ Integrator V2.1 installation

In this section, we install the IBM WebSphere MQ Integrator. Use the instructions in the following sections for a successful installation.

8.7.1 Pre-installation tasks
WebSphere MQ Integrator requires IBM Java V1.3.0.10+. You can download Java 1.3 from the Web site:


Directions for downloading and installing the package(s) are provided during download. Also, download the FixPak per directions on the Web site.

8.7.2 Installing WebSphere MQ Integrator
To install IBM MQSeries Integrator do the following:

1. Insert the CD labeled WebSphere MQ or IBM MQSeries Integrator V2.1 for AIX into the CD-ROM drive.
2. To mount the CD, execute the following:
   ```
   mount -r -v cdrfs /dev/cd0 /mnt
   ```
3. Read and accept the license for MQSeries Integrator by executing:
   ```
   /mnt/mqsilicense
   ```
4. Install the NNSY components for MQSeries Integrator by executing:
   ```
   installp -acgXd /mnt/NNSY/nnsy n6nrf56.rte
   ```
This will install n6nf56.rte and all dependent file sets.

5. Install the MQSeries Integrator packages by executing:
   \[ \text{installp } -\text{acgXd } /mnt/wmqi \text{ wmqi} \]

   **Note:** If any part of the installation fails in step 5, you must remove all the installed MQSeries Integrator components, accept the MQ Integrator license again, and reinstall the components after fixing any problems.

6. Unmount the CD by executing:
   \[ \text{umount } /mnt \]

### 8.7.3 Install FixPak

1. To obtain the latest FixPak/CSD for MQSeries Integrator go to:
   \[ \text{http://www-3.ibm.com/software/ts/mqseries/support/summary/mqsi.html} \]

2. Locate the version of MQSeries Integrator that you are running and make note of the file name for the PTF. At the time of writing the latest FixPak/CSD for MQ Integrator V2.1 on AIX was CSD02 (U481946). To download the PTF, click the link in the Download PTF/CSD column and locate the file Uxxxxx.tar.Z and download it to a temporary directory.

3. Change directory to where you stored the PTF file by executing:
   \[ \text{cd directory} \]

4. Uncompress the PTF by executing the following commands:
   \[ \text{gzip } -d \text{ U481946.tar.Z} \]
   \[ \text{tar } -\text{xvf U481946.tar} \]

   **Note:** If you have created any brokers in MQ Integrator, they must be stopped prior to installing the FixPak. Use \texttt{mqsistop brokername} to stop the broker.

5. Update the New Era of Networks filesets in the NNSY/nnsy directory created by executing:
   \[ \text{installp } -\text{acgNXd } \text{NNSY/nnsy } \text{all} \]

6. Update the MQSeries Integrator filesets by executing:
   \[ \text{installp } -\text{acgXd } \text{U481946 } \text{all} \]
8.7.4 Post installation configuration

Once MQ Integrator has been installed and updated to the latest CSD, the following tasks must be completed:

- Update the root user environment
- Create the DB2 database for an MQSeries Integrator broker
- Update ODBC to access the broker database
- Create the MQSeries Integrator broker
- Set MQSeries Integrator to start on reboot
- Add mqm

Update the mqm user environment

In order to run the MQSeries Integrator commands, the root user environment must be modified as follows:

1. From a command line, switch the user to mqm by typing:
   ```
   su - mqm
   ```
2. Assuming root uses ksh as its shell, append the following line to the ~/.profile:
   ```
   . /usr/opt/wmqi/sample/profiles/profile.aix
   ```
   Add mqm to the mqbroker group. Using your favorite editor, edit /etc/group.
   On the mqmbroker: line append ,mqm.

   **Note:** Changes will not take effect until you log out and log in again.

Create the DB2 database

To create the DB2 database (BROKER) execute the following:

1. Switch user identity to the db2inst1 user by executing:
   ```
   su - db2inst1
   ```
2. Create the database by executing:
   ```
   db2 create database broker
   ```
3. Switch back to the root user identity by executing:
   ```
   exit
   ```

Update ODBC

MQSeries Integrator uses the Mercant ODBC drivers to access the broker database. To add the broker database source, do the following:

2. In the [ODBC Datasources] section, add the following line:

   BROKER=IBM DB2 ODBC Driver

3. Add the following lines at the bottom of the file:

   [BROKER]
   Driver=/usr/lpp/db2_07_01/lib/db2_36.o
   Description=ODBC datasource for DB2 Database BROKER
   Database=BROKER

4. Save and close the file.

**Create the MQSeries Integrator broker**

To create the MQSeries Integrator broker do the following:

1. Make sure MQSeries Integrator is up and running by executing the following:

   /usr/mqm/bin/strmqm

   **Note:** Replace *queue manager name* with the name of the queue manager you created in “Create the MQSeries queue manager” on page 372.

   **Figure 8-46** Expected results from strmqm command

2. From a command prompt, switch the user to mqm by executing:

   su - mqm

3. Create an MQSeries Integrator broker called “BROKER” that will use the database named “broker” and Queue Manager *queue manager name* by executing the following:

   mqsicreatebroker BROKER -i mqm -a mqm password -q *queue manager name* -n BROKER -u db2inst1 -p db2inst1 password

   **Note:** Replace values in italics with the appropriate values.

4. Type **exit** to switch back to root.
5. Start the broker by executing:

```
mqstart BROKER
```

**Set MQSeries Integrator to autostart on reboot**

If you want the MQSeries Integrator broker to be automatically started after a reboot occurs, do the following:

1. Using your favorite editor, open the /etc/inittab file.
2. Add the following line at the bottom of the file:

```
wasmqi:2:once:/usr/bin/mqstart BROKER >/dev/console 2>&1
```
3. Save and close the file.

---

**8.8 IBM MQSeries Workflow V3.3.2 installation**

In this section, we install IBM MQSeries Workflow.

**8.8.1 Pre-installation**

Prior to installing MQSeries Workflow, the following tasks must be accomplished:

- Ensure there is sufficient space in the /var filesystem (minimum 120M)
- Create fmcgrp group
- Create fmc user
- Set up a profile for the fmc user
- Verify xlC.rte.5.0.0.0 is installed
Ensure sufficient space in /var filesystem

During configuration of MQ Workflow, a DB2 database named FMCDB will be created in /var/fmc. To ensure there is sufficient space, we will create a filesystem that will be mounted at /var/fmc. To create the filesystem, run the following:

```
crfs -v jfs -g rootvg -a size=220000 -A yes -m /var/fmc
mount /var/fmc
```

**Note:** You do not need a separate filesystem, but to protect the /var filesystem and system processes that use it from running out of space, it is recommended that you create a separate filesystem. If you choose not to create a separate filesystem, then make sure there is at least 120M available for IBM MQSeries Workflow.

Create fmcgrp

To create the fmcgrp and make root a member, run the following:

```
mkgp users=root fmcgrp
```

4. Verify the group was created by executing:

```
lsgroup fmcgrp
```

Create fmc user account

To create the fmc user and make it a member of the fmcgrp and db2iadm1 group, do the following:

1. From a command prompt, execute:

   ```
   mkuser pgrp=fmcgrp groups=db2iadm1,mqm,fmcgrp fmc
   ```

2. To set the password for user fmc, do the following:
   a. From the command line execute:

      ```
      passwd fmc
      ```
   b. Enter the password you want and press Enter.
   c. Re-enter the password and press Enter.

   **Note:** The password is expired. Continue with the following steps to reset a new password.

3. From the command line, execute:

   ```
   su - fmc
   ```

4. Type `passwd`
5. Enter the old password.
6. Enter the new password.
7. Re-enter the new password.

**Verify xlC.rte.5.x.x.x installed**
IBM MQSeries Workflow requires that the xlC runtime version 5.0 is installed. To verify that the correct version is installed and to download the correct version if necessary, do the following:

1. To check what version ofxlC.rte is installed, execute the following:
   ```
   lslpp -L | grep xlC.rte
   ```
2. If xlC.rte.5.x.x.x is not installed, follow steps 1 - 4 and 12 in 8.5, “IBM WebSphere Application Server V4.1 Enterprise Edition - Enterprise Services installation” on page 368.

**8.8.2 Install IBM MQSeries Workflow**
To install IBM MQ Workflow, do the following:
1. Insert the CD labeled IBM MQSeries Workflow V3.3.2 for AIX into the CD drive.
2. To mount the CD, execute:
   ```
   mount -r -v cdrfs /dev/cd0 /mnt
   ```
3. Execute the following command to install the MQSeries Workflow components:
   ```
   installp -acgXd /mnt fmc.base fmc.basertdb.db2 fmc.java.agent fmc.rtdbutil.db2 fmc.server.db2 fmc.webclient
   ```
4. Unmount the CD by executing:
   ```
   umount /mnt
   ```

**8.8.3 Configure MQSeries Workflow**
To configure MQSeries Workflow do the following:
1. Start WebSphere Application Server. For instructions on starting WebSphere Application Server, refer to “Start WebSphere Application Server” on page 364.
2. Execute the following commands to set up MQSeries Workflow:
   ```
   fmczinsx -o env
   fmczinsx -o inf
   fmczinsx -o db2
   ```
3. Press C then Enter to create a configuration.
4. Press Enter twice to accept FMC as identifier and Administrator.
5. Press A then Enter to configure all components.
6. Press X then Enter to exit the Select Category Menu.
7. Press Enter to create the new runtime database.
8. Press Enter to create the runtime database as a local database.
9. Press Enter for all prompts to accept the default configuration information.
10. When prompted to create, save, review or exit, press C then Enter to create the configuration profile.
11. When prompted to create the FMCDB database, press Y then Enter to create the database.
12. When prompted for the fmc user password, enter the password and press Enter.
13. When prompted to create the queue manager, press Y then Enter to create the FMCQM queue manager.
14. When prompted to configure the Web Client within WebSphere Application Server, press Y then Enter.
15. Once configuration is complete, press X then Enter to exit the configuration command menu.

Example 8-1  Configuring IBM MQSeries Workflow

```bash
# fmczutil
FMC3320I Configuration Commands Menu:
l ... List
c ... Create
x ... Exit Configuration Commands Menu
c <enter>
   Configuration identifier : [FMC] <enter>
   Configuration administrator : [fmc] <enter>

FMC33210I Select Category Menu:
s ... ( ) Server
i ... ( ) Runtime Database Utilities
c ... ( ) Client
j ... ( ) Java Agent
w ... ( ) Web Client
a ... all
```
WebSphere Solution Bundles: Implementation and Integration Guide

- Configuration of Runtime database ...
  u ... ( ) Use an existing Runtime database
  n ... (X) Create a new Runtime database
<enter>
  l ... (X) Local database
  r ... ( ) Remote database
<enter>
DB2 instance : [db2inst1] <enter>
DB2 database : [FMCDB] <enter>
DB2 user ID of database administrator : [fmc] <enter>

DB2 database layout file : [/var/fmc/cfgs/FMC/fmcdblay.ini] <enter>
DB2 database location : [/var/fmc/rt_db/db2inst1/FMCDB] <enter>
DB2 container location : [/var/fmc/rt_db/db2inst1/FMCDB] <enter>
DB2 log files location : [/var/fmc/rt_db/db2inst1/FMCDB] <enter>

- FMC33526I Select space management ...
  s ... (X) Managed by system
  d ... ( ) Managed by database (using raw device)
<enter>
- FMC33749I Selected Space management : Managed by system

DB2 user ID to access Runtime database : [fmc] <enter>

System group name : [FMCGRP] <enter>
System name : [FMCSYS] <enter>
Queue manager name : [FMCQM] <enter>
Queue prefix : [FMC] <enter>

- Configuration of the new queue manager ...
  FMC33513I Select log type ...
  c ... (X) Circular log
1 ... ( ) Linear log (prerequisite for backup)
<enter>
- FMC33749I Selected Log type : Circular log

Queue manager log files location : [] <enter>
Channel definition table file : [/var/fmc/chltabs/MQWFCHL.TAB]
<enter>
TCP/IP address : [m10df55f] <enter>
TCP/IP port number : [14008] <enter>
Principal name : [fmc] <enter>
MQ Cluster name : [FMCGRP] <enter>

FMC33537I Select repository type ...:
 f ... (X) 'FMCQM' is the first queue manager in cluster 'FMCGRP'
 a ... ( ) 'FMCQM' is an additional queue manager in cluster 'FMCGRP'
<enter>
- FMC33749I Selected Repository type : 'FMCQM' is the first queue manager in cluster 'FMCGRP'

FMC33632I Transaction coordination will be used between MQSeries and DB2.
FMC33633I The queue manager 'FMCQM' will connect to the database 'FMCDB'.

DB2 user ID of transaction coordinator : [fmc] <enter>

FMC33506I Which user ID will regularly start the queue manager 'FMCQM'? :
 t ... ( ) the transaction coordinator user ID 'fmc'
o ... (X) another user ID within the group 'mqm'
<enter>

- Configuration of client ...
- Configuration of Java Agent ...
- FMC33749I Selected Locator Policy : Local bindings

FMC33606I Specify information about garbage collection (reaper) ...:
 Agent cycle (in seconds) : [300] <enter>
 Client threshold (number of objects) : [1000] <enter>
 Client cycle (in % of agent cycle) : [90] <enter>
- Configuration of Web Client ...

FMC33942I Specify the root URI of the Web Client :
 Root URI : [MQWFClient] <enter>

FMC33777I Select application server ...:
w ... () WebSphere 3.x
f ... (X) WebSphere 4.0 (EAR)
o ... () Other (Servlet API 2.1)
j ... () Other (WAR / EAR)

Code Version of the Java Agent : [3320]

FMC33607I Specify information about the WebSphere Application Server ...
Installation directory : [/usr/WebSphere/AppServer] <enter>
Host name of administration node : [m10df55f] <enter>
Host name of name service host : [m10df55f] <enter>
TCP/IP port number of name service : [900] <enter>
XML configuration skeleton file name : [fmcoh40.skel] <enter>
HTTP transport port of the Web container: [9081] <enter>

c ... Create configuration profile for 'FMC' now
s ... Save input to file
r ... Review/change input
x ... Exit (input for configuration 'FMC' will be lost)
c <enter>
- FMC33680I The profile for the configuration 'FMC' was updated successfully.

- FMC33682I The general configuration profile was updated successfully.
FMC33938I Creating 'fmcohcli.war'
FMC33938I Creating 'fmcohcli.ear'

- FMC33502I Do you want to create the Runtime database 'FMCDB' now?
y ... Yes
n ... No
y <enter>
- FMC33136I Generating database layout.
FMC33153W The managed by value for tablespaces belonging to group INDEX is not customizable.
FMC33110I The database manager is already active.
FMC33115I Creating the database - FMCDB
FMC33116I Please wait... This may take a while.
FMC33117I Database FMCDB has been created.
FMC33120I Updating the database configuration.
FMC33132I Creating tablespaces.
FMC33133I Creating tables.
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbact.bnd (1/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbadm.bnd (2/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbad2.bnd (3/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbatr.bnd (4/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbatr.bnd (5/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbblk.bnd (6/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbccn.bnd (7/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbctr.bnd (8/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbdcn.bnd (9/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbepi.bnd (10/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdblst.bnd (11/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbmat.bnd (12/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbmod.bnd (13/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbopr.bnd (14/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbprc.bnd (15/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdborg.bnd (16/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbses.bnd (17/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbsgo.bnd (18/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbstf.bnd (19/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbsvc.bnd (20/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbtop.bnd (21/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwcss.bnd (22/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (23/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (24/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (25/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (26/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (27/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (28/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (29/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (30/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (31/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (32/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (33/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (34/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (35/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (36/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (37/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (38/39)
FMC33126I Binding /usr/lpp/fmc/bnd/fmcdbwit.bnd (39/39)
FMC33130I Initializing the database.
FMC33130I fmczbstr -gFMCGRP -sFMCSYS -xFMC -dFMCDB -ufmc
FMC24500I fmczbstr is starting.
FMC24560I fmczbstr finished and found 0 errors 0 warnings. RC = 0
FMC33131I Loading reference FDL.
FMC20500I Start parsing /var/fmc/cfgs/FMC/fdl/fmczref.fdl.
FMC25100I CREATE LEVEL '0' finished.
FMC25100I CREATE LEVEL '1' finished.
FMC25100I CREATE LEVEL '2' finished.
FMC25100I CREATE LEVEL '3' finished.
FMC25100I CREATE LEVEL '4' finished.
FMC25100I CREATE LEVEL '5' finished.
FMC25100I CREATE LEVEL '6' finished.
FMC25100I CREATE LEVEL '7' finished.
FMC25100I CREATE LEVEL '8' finished.
FMC25100I CREATE LEVEL '9' finished.
FMC25100I CREATE STRUCTURE 'Default Data Structure' finished.
FMC25100I REPLACE DOMAIN 'DOMAIN' finished.
FMC25100I REPLACE GROUP 'FMCGRP' finished.
FMC25100I REPLACE SYSTEM 'FMCSYS' finished.
FMC25100I REPLACE PERSON 'ADMIN' finished.
FMC25100I REPLACE ROLE 'System administrator' finished.
FMC25100I CREATE SERVER 'CLEANSVR.FMCSYS.FMCGRP' finished.
FMC25100I CREATE SERVER 'EXECSVR.FMCSYS.FMCGRP' finished.
FMC25100I CREATE SERVER 'SCHEDSVR.FMCSYS.FMCGRP' finished.
FMC25100I CREATE SERVER 'PESERVER.FMCSYS.FMCGRP' finished.
FMC25100I CREATE QUEUE_MANAGER 'FMCQM' finished.
FMC20510I Finished parsing /var/fmc/cfgs/FMC/fdl/fmczref.fdl.
- FMC33911I The new Runtime database FMCDB was created successfully.

- FMC3352I Do you want to create the queue manager 'FMCQM' now?
  y ... Yes
  n ... No
y <enter>
MQSeries queue manager created.
Creating or replacing default objects for FMCQM.
Default objects statistics : 29 created. 0 replaced. 0 failed.
Completing setup.
Setup completed.
MQSeries queue manager 'FMCQM' started.
MQSeries queue manager ended.
- FMC33736I The queue manager FMCQM has been updated successfully.
- FMC33598I Do you want to configure the Web Client within the WebSphere
  Application Server now?
  y ... Yes
  n ... No
y <enter>
[4/19/02 10:33:05:082 EDT] 7e82156f NodeConfig    A XMLC0053I: Importing Node :
m10df55f
[4/19/02 10:33:05:392 EDT] 7e82156f ApplicationSe A XMLC0053I: Importing
ApplicationServer : WebClient Server - FMC
[4/19/02 10:33:08:103 EDT] 7e82156f EnterpriseApp A XMLC0053I: Importing
EnterpriseApp : m10df55f/MQWF Web Client - FMC
[4/19/02 10:33:18:995 EDT] 7f661524 AEGeneratePlu A SRVE0098I: Generating
plug-in configuration for this node
- FMC33940I Restart your HTTP server to activate the changes.

FMC33201I Configuration Commands Menu:
  l ... List
  s ... Select
  c ... Create
  x ... Exit Configuration Commands Menu
x <enter>
Set MQSeries Workflow to autostart on reboot
If you want MQSeries Workflow to be automatically started after a reboot occurs, do the following:

1. Using your favorite editor, open the /etc/inittab file.
2. Add the following line at the bottom of the file:
   \[ \text{wasmqw:2:once:/usr/bin/strmqm FMCQM } \text{>/dev/console 2>&1} \]
3. Save and close the file.

8.8.4 Install MQSeries Java classes
In order for Java applications to utilize MQ queues, the MQSeries Java classes (Support Pac MA88) must be installed and the WebSphere Application Server environment must be updated to access the JAR files and libraries. To install the MA88 SupportPac, follow the instructions in the next sections.

Installing MA88 SupportPac
1. Using a Web browser, go to:
   \[ \text{http://www-3.ibm.com/software/ts/mqseries/txppacs/ma88.html} \]
2. Locate the file for AIX and download it to a temporary directory. If you have not already registered at the IBM site, you will need to register to download the file.
3. From a command line, change to the directory where you stored the file.
4. Untar the file by executing:
   \[ \text{tar -xvf ma88_aix.tar} \]
5. Install the Support Pac by executing:
   \[ \text{installp -acgXd . all} \]

Note: The files will be installed to the /usr/mqm/java/ directory.

Configuring MQ support in WebSphere Application Server
In order for WebSphere Application Server to access the MA88 Support Pac files, do the following:

From a command prompt, execute the following:

\[ \text{ln -sf /usr/mqm/java/lib/*.properties/usr/WebSphere/AppServer/lib/} \]
\[ \text{ln -sf /usr/mqm/java/lib/com.ibm.mq.jar/usr/WebSphere/AppServer/lib/} \]
8.9 Deploying and testing the demo application

To deploy the Demo application on the server, do the following:

1. Export the EAR file as outlined in 6.5.7, “Exporting the demo application to an .ear file” on page 199.

   **Note:** Remember to change the HostName and QueueManager variables in the EAR file to point to the production server. See 6.5.4, “Setting up environment variables for WSADMQDemoWeb” on page 191.

2. If you installed the WebSphere components on a server other than your development machine, copy the WSADMQDemo.ear file to a temporary directory. We used /.

   **Note:** Enterprise Archive (EAR) files are zipped archive files that contain J2EE application components such as Web applications (packaged in WAR files) and EJBs. J2EE application containers import EAR files into the application environment at runtime and deploy the components within each EAR file as separate Web applications.

3. Start the WebSphere Administrative Console if it is not already running. From a command prompt execute:

   `/usr/WebSphere/AppServer/adminconsole.sh`

4. You will see a window similar to Figure 8-48.
5. Start the Install Enterprise Application Wizard that will guide you through the deployment of the .ear file by clicking **Console -> Wizards -> Install Enterprise Application**. You will see a window similar to Figure 8-49.
6. This opens a wizard for deploying the .ear application. In the Browse for file on node field, select the name of the Server running WebSphere Application Server if not already selected.

   **Note:** In our example, the machine name where our .ear file is located is m10df4ff.

7. Make sure **Install Application (*.ear)** is selected, and click **Browse**. In the browse window navigate to / (root) and select **WSADMQDemo.ear**.

8. While not necessary, enter **WSADMQDemo** in the Application name field. Click **Next** seven times. You will see a window similar to Figure 8-50.
9. Here, you will specify the virtual hosts for the application to run under. For our example, we did not configure a separate virtual host, but instead left it as Default Host. Click **Next**. You will see a window similar to Figure 8-51.
Selecting Application Servers

Specify the application server where you want to install the modules contained in your application. Modules can be installed on the same server or dispersed among several servers.

Select a module in the list below and click the Select Server button to select the application server on which to install the module.

<table>
<thead>
<tr>
<th>Module</th>
<th>Application Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>WSADM(DemoWeb)</td>
<td>Default Server (m10df4ff)</td>
</tr>
</tbody>
</table>

Figure 8-51  Selecting Application Servers window

10. The Application Server field will be blank. Select the module and then click **Select Server** to select the server or server group where your application will run. Select **Default Server (m10df4ff)**. Click **Next** to have the application run on the default server. You will see a window similar to Figure 8-52.
Chapter 8. Build your WebSphere production environment

8.9.1 Starting the demo application

To start the demo application, do the following:

1. Click + near Enterprise Applications if the folder is not already expanded.
2. Select WSADMQDemo application that you just deployed.
3. Right-click the application and click Start to make the application available.

This is shown in Figure 8-53.

Note: Our sample application does not contain any EJBs, so most of the steps in the wizard are not required. However, if you are deploying one or more EJBs, you have to fill in all the required information.

Completing the Application Installation Wizard

Confirm the information for installing the application or module.

The application or module will be installed with the settings you provided. To make changes to these settings, click Back. To install the application, click Finish.

This application will be installed on the following nodes with the install directory setting for each node as:

```
/m10df4ff/IBM/WebSphere/AppServer/InstalledApps/WSADMQDemo deploy
```

of which m10df4ff is the local node. This wizard will automatically create the install directory for this local node after finishing the install task.

Figure 8-52 Install Enterprise Application Wizard window

11. Review your settings and click Finish. When the installation has completed successfully, click OK. You will be returned to the WebSphere Administration Console.
4. Click **OK** to continue.

5. The IBM HTTP Server and IBM WebSphere Application Servers communicate via a plug-in in the IBM HTTP Server. In order to make IHS aware of the newly deployed application, you must regenerate the Webserver plug-in. To do so, expand the **Nodes** folder by clicking the + if not already expanded.

6. Right-click the node, **m10df4ff** for our example. Then, click **Regen Webserver Plugin**. This should be done after you deploy or remove an application, to refresh the Webserver plug-in configuration file.

7. The Webserver plug-in will reread its configuration file after a short time. You can wait for this to happen or stop and restart the IBM HTTP Server. If you want to stop and start the Webserver, execute the following from a command prompt:

```
/usr/HTTPServer/bin/apachectl restart
```
8.9.2 Create a queue

To create a queue for use with our application, perform the following instructions:

1. From a command prompt, execute:
   \[ su - mqm \]

2. Execute
   \[ runmqsc queue manager \]
   For example, \[ QM_m10df4ff \].

3. Define a local queue named POENTRY.
   This is the queue that the WSADMQDemo will use to place an order. See 7.8, “Creation of the POENTRY queue” on page 318. The command should read:
   \[ define qlocal(POENTRY) \]

4. Press Ctrl+C.

5. Start an MQListener to receive messages for the queue manager. From the command prompt, execute:
   \[ runmqlsr -t TCP -m QM_m10df4ff \]

8.9.3 Running the application

To run the application do the following:

1. Open a browser window, either on the server or another machine, and go to the following URL:
   \[ http://hostname/WSADMQDemoWeb/ \]

   **Note:** Replace hostname with the name or IP address of the production server where WebSphere Application Server resides.

   You must use Internet Explorer 5.x to display XML data islands from the List POs link.

2. On the page displayed, click **EnterPO**.
3. Enter a customer name, item number and quantity and click **Send order**.
4. Once the message has been submitted to MQ, you will be directed to a page stating The message has been sent.
5. Click **List POs** to view all entries on the MQ queue.
6. Click **SubmitPO** to add another entry to the queue. Once submitted, click **List POs** to view all entries on the MQ queue.
Additional material

This redbook refers to additional material that can be downloaded from the Internet as described below.

Locating the Web material

The Web material associated with this redbook is available in softcopy on the Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG246550

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with the redbook form number, SG246550.

Using the Web material

The additional Web material that accompanies this redbook includes the following files:

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WSADMQDemo.ear</td>
<td>WebSphere Application Server Demo Application</td>
</tr>
</tbody>
</table>
System requirements for downloading the Web material

The following system configuration is recommended:

- **Hard disk space:** 2 MB minimum
- **Operating System:** Windows
- **Processor:** 266 MHz or higher
- **Memory:** 64 MB

How to use the Web material

Create a subdirectory (folder) on your workstation, and unzip the contents of the Web material zip file into this folder.
### Abbreviations and acronyms

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACID</td>
<td>Atomicity, Consistency, Isolation, and Durability</td>
</tr>
<tr>
<td>ACL</td>
<td>Access Control List</td>
</tr>
<tr>
<td>AD</td>
<td>Application Development</td>
</tr>
<tr>
<td>AE</td>
<td>WebSphere Application Server Advanced Edition</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>BPM</td>
<td>Business Process Management</td>
</tr>
<tr>
<td>CCLT</td>
<td>Rational ClearCase</td>
</tr>
<tr>
<td>CDF</td>
<td>Content Distribution Framework</td>
</tr>
<tr>
<td>CICS</td>
<td>Customer Information Control System</td>
</tr>
<tr>
<td>CLPD</td>
<td>Certified Lotus Professional Principal Developer</td>
</tr>
<tr>
<td>CORBA</td>
<td>Common Object Request Broker Architecture</td>
</tr>
<tr>
<td>CRM</td>
<td>Customer Relationship Management</td>
</tr>
<tr>
<td>CVM</td>
<td>Customer Value Monitor</td>
</tr>
<tr>
<td>CVS</td>
<td>Concurrent Versioning System</td>
</tr>
<tr>
<td>DB2 UDB</td>
<td>IBM DB2 Universal Database</td>
</tr>
<tr>
<td>DCE</td>
<td>Distributed Computing Environment</td>
</tr>
<tr>
<td>DCP</td>
<td>Decision Check Point</td>
</tr>
<tr>
<td>DHTML</td>
<td>Dynamic Hypertext Markup Language</td>
</tr>
<tr>
<td>DTD</td>
<td>document type definition</td>
</tr>
<tr>
<td>EAR</td>
<td>Enterprise Archive</td>
</tr>
<tr>
<td>ECI</td>
<td>External Call Interface</td>
</tr>
<tr>
<td>EE</td>
<td>WebSphere Application Server Enterprise Edition</td>
</tr>
<tr>
<td>EJB</td>
<td>Enterprise Java-Beans</td>
</tr>
<tr>
<td>ERP</td>
<td>Enterprise Resource Planning</td>
</tr>
<tr>
<td>GEO</td>
<td>Geography</td>
</tr>
<tr>
<td>GSD</td>
<td>Global Solution Directory</td>
</tr>
<tr>
<td>GSI</td>
<td>Global Systems Integrators</td>
</tr>
<tr>
<td>GTM</td>
<td>Go To Market</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>HOD</td>
<td>Host on Demand</td>
</tr>
<tr>
<td>HTML</td>
<td>Hypertext Markup Language</td>
</tr>
<tr>
<td>IBM</td>
<td>International Business Machines Corporation</td>
</tr>
<tr>
<td>IDE</td>
<td>Integrated development environment</td>
</tr>
<tr>
<td>IMS</td>
<td>Information Management System</td>
</tr>
<tr>
<td>IS</td>
<td>Information Systems</td>
</tr>
<tr>
<td>iSeries</td>
<td>IBM integrated business server, formerly AS/400</td>
</tr>
<tr>
<td>ISP</td>
<td>Independent Solution Providers</td>
</tr>
<tr>
<td>ISV</td>
<td>Independent Software Vendors</td>
</tr>
<tr>
<td>ITSO</td>
<td>International Technical Support Organization</td>
</tr>
<tr>
<td>J2EE</td>
<td>Java 2 Platform Enterprise Edition</td>
</tr>
<tr>
<td>JAR</td>
<td>Java Archive</td>
</tr>
<tr>
<td>JCA</td>
<td>J2EE Connector Architecture</td>
</tr>
<tr>
<td>JDBC</td>
<td>Java Database Connectivity access</td>
</tr>
<tr>
<td>JIT</td>
<td>Just In Time</td>
</tr>
<tr>
<td>JMS</td>
<td>Java Messaging Service</td>
</tr>
<tr>
<td>JMX</td>
<td>Java Management Extensions</td>
</tr>
<tr>
<td>JSP</td>
<td>JavaServer Pages</td>
</tr>
<tr>
<td>Acronym</td>
<td>Abbreviation</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
</tr>
<tr>
<td>JSR</td>
<td>Java Authorized Service</td>
</tr>
<tr>
<td>JVM</td>
<td>Java Virtual Machine</td>
</tr>
<tr>
<td>MCSE</td>
<td>Microsoft Certified Systems Engineer</td>
</tr>
<tr>
<td>MDA</td>
<td>Model Driven Architecture</td>
</tr>
<tr>
<td>MQ</td>
<td>Messaging Queue</td>
</tr>
<tr>
<td>OMG</td>
<td>Object Management Group</td>
</tr>
<tr>
<td>PDA</td>
<td>Personal Digital Assistant</td>
</tr>
<tr>
<td>PDE</td>
<td>IBM DB2 Universal Database Personal Developer's Edition</td>
</tr>
<tr>
<td>PDT</td>
<td>Product Development Team</td>
</tr>
<tr>
<td>PMI</td>
<td>Performance Monitor Interface</td>
</tr>
<tr>
<td>pSeries</td>
<td>IBM advanced UNIX servers, formerly RS/6000</td>
</tr>
<tr>
<td>PWD</td>
<td>PartnerWorld for Developers</td>
</tr>
<tr>
<td>RHCE</td>
<td>Red Hat Certified Engineer</td>
</tr>
<tr>
<td>ROI</td>
<td>Return on Investment</td>
</tr>
<tr>
<td>RRS</td>
<td>Resource recovery services</td>
</tr>
<tr>
<td>RSC</td>
<td>Relational Schema Center</td>
</tr>
<tr>
<td>RSI</td>
<td>Regional Systems Integrators</td>
</tr>
<tr>
<td>RTM</td>
<td>Route To Market</td>
</tr>
<tr>
<td>SCM</td>
<td>Supply Chain Management</td>
</tr>
<tr>
<td>SDM</td>
<td>Solution Developer Marketing</td>
</tr>
<tr>
<td>SI</td>
<td>Systems Integrators</td>
</tr>
<tr>
<td>SMB</td>
<td>Small Medium Business</td>
</tr>
<tr>
<td>SOAP</td>
<td>Service oriented application protocol</td>
</tr>
<tr>
<td>SP</td>
<td>Solution Providers</td>
</tr>
<tr>
<td>SPC</td>
<td>IBM Solution Partnership Centers</td>
</tr>
<tr>
<td>SPI</td>
<td>Security Programming Interface</td>
</tr>
<tr>
<td>SWOT</td>
<td>Strengths, Weaknesses, Opportunities, Threats</td>
</tr>
<tr>
<td>TCO</td>
<td>Total Cost of Ownership</td>
</tr>
<tr>
<td>UDDI</td>
<td>Universal Definition, Discover and Integration</td>
</tr>
<tr>
<td>VAD</td>
<td>Value Added Dealers</td>
</tr>
<tr>
<td>VAR</td>
<td>Value Added Resellers</td>
</tr>
<tr>
<td>VPN</td>
<td>Virtual Private Network</td>
</tr>
<tr>
<td>WAR</td>
<td>Web Archive</td>
</tr>
<tr>
<td>WCD</td>
<td>WebSphere Commerce For Digital Media</td>
</tr>
<tr>
<td>WCS</td>
<td>WebSphere Commerce Suite</td>
</tr>
<tr>
<td>WPT</td>
<td>Web Performance Tool</td>
</tr>
<tr>
<td>WSDL</td>
<td>Web Services Description Language</td>
</tr>
<tr>
<td>WWW</td>
<td>World Wide Web</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
<tr>
<td>xSeries</td>
<td>IBM Intel processor-based servers, formerly Netfinity</td>
</tr>
<tr>
<td>XSL</td>
<td>Extensible Stylesheet Language</td>
</tr>
<tr>
<td>zSeries</td>
<td>IBM enterprise class e-business server, formerly S/390</td>
</tr>
</tbody>
</table>
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

IBM Redbooks

For information on ordering these publications, see “How to get IBM Redbooks” on page 406.

- IBM WebSphere V4.0 Advanced Edition Handbook, SG24-6176
- IBM WebSphere V4.0 Advanced Edition Security, SG24-6520
- IBM WebSphere V4.0 Advanced Edition Scalability, SG24-6192
- Self-Study Guide: WebSphere Studio Application Developer and Web Services, SG24-6407
- WebSphere Application Server V4 for Linux, Implementation and Deployment Guide, REDP0405
- Web Services Wizardry with WebSphere Studio Application Developer, SG24-6292
- WebSphere Studio Application Developer Programming Guide, SG24-6585
- WebSphere 4.0 Installation and Configuration on the IBM @server iSeries Servers, SG24-6815-00

Referenced Web sites

These Web sites are also relevant as further information sources:

- Web Performance Tool
  http://aktools.raleigh.ibm.com/
- RS/6000 SolutionSizer
  http://w3-1.ibm.com/sales/systems/ibmsm.nsf/mainframeset?readform&geo=AM&cdoc=rs6ksizer/
- WebSphere Application Server Tools

- WebSphere Application Studio Developer Integration Edition
  http://www.ibm.com/software/ad/studiointegration/

- WebSphere Application Server Advanced Edition 4.0-PTF and FixPaks

- WebSphere Software Platform
  http://www.ibm.com/websphere

- WebSphere Studio Application Developer Integration Edition
  http://www.ibm.com/software/ad/studiointegration/

- Foundation and Tools: Host Access
  /host&S_TACT=102BBW01&S_CMP=campaign

- WebSphere Innovation Connection Online for IBM Business Partners
  http://www.ibm.com/websphere/partners

- WebSphere Developer Domain
  http://www.ibm.com/websphere/developers

- PartnerWorld for Software
  http://www.ibm.com/partnerworld/software

- IT and Professional Training
  http://www.ibm.com/services/learning

- PartnerWorld for Developers
  http://www.developer.ibm.com

- Global Solutions Directory
  r?OpenForm

- IBM Solution Partnership Center

- The IBM Software Mall

- PartnerWorld for Developers individual membership
  &data_src=WWW_NEWS

- ISV SolutionLink

- PartnerWorld for Developers Track Guide 2002

- IBM @server Solution Connection
  http://www.developer.ibm.com/welcome/eserver/eSC.pl?mvid=main&packageid=1000

- IBM @server xSeries for e-business

- IBM @server xSeries Intel processor-based servers

- IBM @server pSeries for e-business

- UNIX Servers (pSeries)

- IBM @server iSeries for e-business

- IBM @server iSeries - integrated application servers
  http://www-1.ibm.com/servers/eserver/iseries/

- IBM @server zSeries for e-business

- IBM @server zSeries - mainframe servers
  http://www-1.ibm.com/servers/eserver/zseries

- WebSphere Application Server prerequisites

- IBM DB2 Product family
  http://www.ibm.com/db2

- Professional Certification Program from IBM
  http://www.ibm.com/certify

- WebSphere 101 - Two-day sales workshop

- WebSphere Solution Sales University 201 workshop
http://www.ibm.com/software/info/websphere/partners/ws201.html

► WebSphere Version 4 Application Development Handbook

► DB2 Universal Database and DB2 Connect V7 product manuals
http://www-4.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/v7pubs.d2w/en_main

► DB2 UDB and DB2 Connect Online Support

► MA88: MQSeries classes for Java and MQSeries classes for Java Message Service

► WebSphere Application Server Support

► WebSphere MQ Integrator fixes

► WebSphere MQ Integrator support

► MQSeries Support, Service summary for AIX

► IBM developer kit porting
http://www-106.ibm.com/developerworks/java/jdk/?dwzone=java

► MQSeries Support, Service summary for MQSeries Integrator

► @server planning
http://techsupport.services.ibm.com/server/planning

► WebSphere Application Server, Advanced Edition Security redbook

► Tivoli System Management products
http://www.tivoli.com

► IBM Crossworlds
- Holosofx Business Process Management Suite
- IBM MQSeries Workflow
- IBM CrossWorlds System Manager
  http://www-3.ibm.com/software/info1/websphere/#sysmgr
- IBM CrossWorlds LogViewer
  http://www-3.ibm.com/software/info1/websphere/#logviewer
- IBM CrossWorlds Process Designer
  http://www-3.ibm.com/software/info1/websphere/#process
- IBM CrossWorlds Business Object Designer
  http://www-3.ibm.com/software/info1/websphere/#bod
- IBM CrossWorlds Object Discovery Agent Development Kit (ODK)
- IBM CrossWorlds Map Designer
  http://www-3.ibm.com/software/info1/websphere/#map
- IBM CrossWorlds Relationship Designer
- IBM CrossWorlds Relationship Manager
- IBM CrossWorlds Connector Development Kit (CDK)
- IBM CrossWorlds InterChange Server
- WebSphere Sales and Support intranet site
  http://w3-3.ibm.com/software/websphere/websites.nsf/
- WebSphere Innovation Connection Online site
How to get IBM Redbooks

You can order hardcopy Redbooks, as well as view, download, or search for Redbooks at the following Web site:

ibm.com/redbooks

You can also download additional materials (code samples or diskette/CD-ROM images) from that site.

IBM Redbooks collections

Redbooks are also available on CD-ROMs. Click the CD-ROMs button on the Redbooks Web site for information about all the CD-ROMs offered, as well as updates and formats.
A
access control lists (ACLs) 43
ACID properties 41
  consistency 41
  durability 41
  isolation 41
administration console 11
administrative console 199
AIX 332, 368, 375
akrecord 106
akstress 106
AKtools 106
ALS API 112
analyze business processes 28
Application Connectivity 26
Application Development Tools Guide 117
Application Server 10
Assign the users associated with MQSeries 302
atomicity 41
authentication 43
authorization 43
automated compensation 14
automotive 27
autostart 387
availability 12, 14
AXIS V3.0 53

B
B2B 21, 27
B2B e-commerce 21
B2C 21
B2C e-commerce 21
back-end systems 21
bandwidth 15
BEA WebLogic Server 111
BM DB2 Universal Database Enterprise Edition V7.2 102
BROKER 376
Broker 302, 310
Building Business Solutions with WebSphere 117
built-in object management 29
business applications 15
business consultative perspective 47
business integration 9, 26
business model 46
business objects 29
Business Partner 59, 126
business processes 8
Business Rule Beans 13
business scenarios 47
business-to-business (B2B) 22, 52
Business-to-Business Integration (B2Bi) 29
business-to-consumer (B2C) 22
business-to-employee (B2E) 22
centralized execution 28
chunked-transfer encoding 106
CICS 13, 17, 37
CICS Application Programming Guide 117
Citrix Metaframe 77
classpath 194
clustering 12
collaborations 29
commerce 27
Commerce-enabled portals 21
Common Object Request Broker Architecture (CORBA) 7
compensation model 29
Component Broker 116
Component Broker Programming Guide 117
Configuration Manager 302, 310
connectivity 12
connectors 29
container-managed messaging 13
Content Distribution Framework (CDF) 15
cookie cache 107
course roadmaps 117
CRM 111
cross-referencing 29
CrossWorlds Collaborations 30
customer 7
cVerify 106

D

data 8
data integrity 28
data management 27
data persistence 28
database 84
Database Application Adapters Development Guide 117
database instance name 274
DB2 17
DB2 Application Development Client 137
DB2 Connect parameters 277
DB2 Control Center 140, 208
DB2 FixPak 211
DB2 instance 363
DB2 JDBC Applet Server Windows service 149–150
DB2 Personal Edition Quick Beginnings 140
DB2 UDB 12
DB2 Universal Database V7.2 23
demo application 388
departmental applications 11
development environment 5
development phase 3
development server 5
Device Developer 10
distributed computing 39
Distributed Computing Environment (DCE) 7
Domino R5 107
DSOURCEPROFILE 364
dynamic application interaction 12–13
Dynamic e-business 1
dynamic e-business 9

E

EAR file 160, 388
e-business infrastructure 77
e-business platform 9
e-business transactions 46
Eclipse 19
EDI 34
EDI-aware applications 34
EDI-INT 34
e-insight 80
EJB 6, 326, 393
electronics 27
employees 7
end-to-end application optimization 14
Enterprise Application Archive (EAR) 388
terprise application integration 27
Enterprise Application Integration (EAI) 29
Enterprise Archive (EAR) 6
Enterprise Information Portal 23
Enterprise JavaBean (EJB) 13
Enterprise Modernization 35
Enterprise Resource Planning (ERP) 290
Enterprise Services 12, 201
Enterprise Services Developer 130
enterprise-level Web analytics tool 111
Entrust Inc. 79
Entrust/PKI security 79
Entrust/Toolkit for Java (OS/390 Edition) 79
Epicentric 111
e-procurement 80
e-revenue 80
ERP 111
error detection and handling 29
e-technology 80
event dependencies 28
event sequencing 29
external integration 46

F

FixPak 347
FixPak 6 143
Foundation & Tools 9–10, 35

G

general recommendations 102
global marketplace 21
H
Holosofx 28
Homepage Builder 10
Host Access 10, 19–20
HTML 6, 163
HTTP 14, 106, 217, 394
HTTP Server SVT testing 106
HTTP/1.1 verification testing 106
HVWS Simulator for WebSphere 80

I
IBM AIX 332
IBM Business Partner programs 60
IBM Business Partners 115
IBM Content Manager V7 23
IBM CrossWorlds 27, 29
IBM CrossWorlds Connector 34
IBM CrossWorlds Connectors
Connectivity - applications
CrossWorlds Connector for BroadVision 4.1 30
CrossWorlds Connector for BroadVision 5.0 30
CrossWorlds Connector for BroadVision 5.5 30
CrossWorlds Connector for Clarify 10 31
CrossWorlds Connector for Clarify 8 30
CrossWorlds Connector for Clarify 8.1 30
CrossWorlds Connector for Clarify 9 31
CrossWorlds Connector for i2 Active Data Warehouse 4 31
CrossWorlds Connector for i2 Active Data Warehouse 5.x 31
CrossWorlds Connector for MetaSolv TBS 4.x 31
CrossWorlds Connector for MetaSolv TBS 5.x 31
CrossWorlds Connector for Oracle Applications 10.7 31
CrossWorlds Connector for Oracle Applications 11 31
CrossWorlds Connector for Oracle Applications 11i 31
CrossWorlds Connector for PeopleSoft 7.x 31
CrossWorlds Connector for PeopleSoft 8.x 31
CrossWorlds Connector for Portal Infranet 6.1 31
CrossWorlds Connector for SAP R/3 3.x 31
CrossWorlds Connector for SAP R/3 4.50 to 4.60 31
CrossWorlds Connector for Siebel 2000 31
CrossWorlds Connector for Trilogy 3. 31
CrossWorlds Connector for Vantive 7.0 31
CrossWorlds Connector for Vantive 8.x 31
Connectivity - e-business
CrossWorlds Access Framework 30
CrossWorlds Access Framework for Enterprise JavaBeans 30
CrossWorlds Connector for Web Services 30
CrossWorlds EDI Data Handler 1.1.1 30
CrossWorlds Resource Adapter for InterChange Server 30
CrossWorlds Serverless Trading Agent 30
CrossWorlds Trading Partner InterChange for ASPs and Exchanges 30
CrossWorlds Trading Partner InterChange for Trading Networks 30
CrossWorlds Trading Partner InterChange On-Ramp 30
CrossWorlds Trading Partner InterChange Solo 30
CrossWorlds XML Data Handler 30
Connectivity - technology
CrossWorlds Connector for e-Mail 31
CrossWorlds Connector for FIX Protocol (Financial Information eXchange) 31
CrossWorlds Connector for IBM MQSeries 31
CrossWorlds Connector for IBM MQSeries Workflow 31
CrossWorlds Connector for JDBC 31
CrossWorlds Connector for JMS 31
CrossWorlds Connector for Jtxt 31
CrossWorlds Connector for MQSIV2 31
CrossWorlds Connector for SWIFT 1.0 31
CrossWorlds Connector for XML 31
CrossWorlds Mainframe Connector for ADABAS 31
CrossWorlds Mainframe Connector for CICS 31
CrossWorlds Mainframe Connector for DB2 31
CrossWorlds Mainframe Connector for IMS.
<p>| Database | 31 |
| CrossWorlds Mainframe Connector for IMS | |
| Transaction Manager | 31 |
| CrossWorlds Mainframe Connector for VSAM | 31 |
| IBM CrossWorlds Full Toolset | |
| CrossWorlds Business Object Designer | 30 |
| CrossWorlds Connector Development Kit (CDK) | 30 |
| CrossWorlds LogViewer | 30 |
| CrossWorlds Map Designer | 30 |
| CrossWorlds Object Discovery Agent Development Kit (ODK) | 30 |
| CrossWorlds Process Designer | 30 |
| CrossWorlds Relationship Designer | 30 |
| CrossWorlds Relationship Manager | 30 |
| CrossWorlds System Manager | 30 |
| IBM CrossWorlds implementation | 31 |
| IBM CrossWorlds InterChange Server | 29 |
| IBM DB2 Personal Developer’s Edition | 103 |
| IBM DB2 Universal Database Enterprise Edition | 203, 332 |
| IBM DB2 Universal Database Enterprise Edition (DB2 EE) | 201 |
| IBM DB2 Universal Database Personal Developer’s Edition | 135, 202 |
| IBM DB2 Universal Database V7.2 | 100–101 |
| IBM DB2 Universal Database V7.2 Personal Developer’s Edition | 126 |
| IBM DB2 Universal Database V7.2 Personal Developer’s Edition (PDE) | 125 |
| IBM Developer Kit for AIX, Java Technology Edition V1.3.1 | 98 |
| IBM Developer Kit for Linux, Java Technology Edition V1.3.1 | 98 |
| IBM Developer Kit for OS/390, Java Technology Edition V1.2.2 and V1.3.0 | 98 |
| IBM Developer Kit for Windows, Java, Technology Edition V1.3.0 | 98 |
| IBM e-business initiative | 7 |
| IBM eServer Solution Connection tool | 71 |
| IBM iSeries Developer Kit for Java V1.2.2 and V1.3.0 | 98 |
| IBM MQSeries | 32, 110, 125–126, 151, 201, 203, 233, 332, 372 |
| IBM MQSeries classes for Java and MQSeries classes for Java Message Service | |
| IBM MQSeries for AIX V5.2 | 100 |
| IBM MQSeries for OS/390, V5.2 | 101 |
| IBM MQSeries for Windows NT and Windows 2000 | 100 |
| IBM MQSeries Integrator | 33, 99, 125 |
| IBM MQSeries V5.2.1 | 96 |
| IBM MQSeries Workflow | 201 |
| IBM MQSeries Workflow 101 | 101, 125, 203, 332, 378 |
| IBM MQSeries Workflow for AIX, V3.3.2 | 102 |
| IBM MQSeries Workflow for Windows 2000 and Windows NT, V3.3.2 | 101 |
| IBM MQSeries Workflow for z/OS V3.3 | 102 |
| IBM MQSeries Workflow V3.3.2 | 101–102 |
| IBM PartnerWorld for Software | 59 |
| IBM Personal Communications | 11, 20 |
| IBM Pervasive Computing | 24 |
| IBM Message Center | 25 |
| IBM MQ Everyplace | 25 |
| IBM WebSphere Edge Server | 26 |
| IBM WebSphere Everyplace Access | 24 |
| IBM WebSphere Everyplace Mobile Connect | 26 |
| IBM WebSphere Everyplace Portal | 26 |
| IBM WebSphere Everyplace Server Enable Offering | 24 |
| IBM WebSphere Everyplace Server, Service Provider Edition | 24 |
| IBM WebSphere Transcoding Publisher | 26 |
| IBM WebSphere Translation Server | 24 |
| IBM WebSphere Voice Response Beans | 25 |
| IBM WebSphere Voice Response for AIX | 25 |
| IBM WebSphere Voice Response for Windows NT and Windows 2000 | 25 |
| IBM WebSphere Voice Server | 24 |
| IBM WebSphere Voice Server for Transcription | 25 |
| IBM WebSphere Voice Toolkit | 25 |
| IBM Professional Certification | 60 |
| IBM Sales Contacts | 73 |
| IBM Screen Customizer | 11, 20 |
| IBM SecureWay Directory | 111 |
| IBM Secureway Directory | 23 |
| IBM Tivoli Access Manager for Business Integration | 109 |
| IBM Tivoli Access Manager for e-business | 110 |
| IBM Tivoli Access Manager for WebSphere Application Server | 109 |
| IBM Tivoli Monitoring for Web | 109 |
| IBM Tivoli Monitoring for Web Infrastructure | 108 |
| IBM Tivoli Storage Manager for Application Servers | 109 |</p>
<table>
<thead>
<tr>
<th>IBM Tivoli Web Site Analyzer</th>
<th>111</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM TX Series</td>
<td>332</td>
</tr>
<tr>
<td>IBM TXSeries</td>
<td>201</td>
</tr>
<tr>
<td>IBM WebSphere Adapter</td>
<td>34</td>
</tr>
<tr>
<td>IBM WebSphere Application Server</td>
<td>11</td>
</tr>
<tr>
<td>IBM WebSphere Application Server Advanced Edition</td>
<td>203</td>
</tr>
<tr>
<td>IBM WebSphere Application Server Enterprise Edition</td>
<td>332</td>
</tr>
<tr>
<td>IBM WebSphere Application Server V4.0 Advanced Developer Edition</td>
<td>11</td>
</tr>
<tr>
<td>IBM WebSphere Application Server V4.0 Advanced Single Server Edition</td>
<td>11</td>
</tr>
<tr>
<td>IBM WebSphere Business Partner opportunities</td>
<td>60</td>
</tr>
<tr>
<td>IBM WebSphere Communications Server</td>
<td>11</td>
</tr>
<tr>
<td>IBM WebSphere course information</td>
<td>60</td>
</tr>
<tr>
<td>IBM WebSphere Host On-Demand</td>
<td>11</td>
</tr>
<tr>
<td>IBM WebSphere Host Publisher</td>
<td>11</td>
</tr>
<tr>
<td>IBM WebSphere Innovation Connection Online</td>
<td>60</td>
</tr>
<tr>
<td>IBM WebSphere MQ Integrator</td>
<td>201, 203, 332</td>
</tr>
<tr>
<td>IBM WebSphere Studio Application Developer Integration Edition</td>
<td>133</td>
</tr>
<tr>
<td>IBM WebSphere Studio Application Developer V4.1 Integration Edition</td>
<td>126</td>
</tr>
<tr>
<td>IBM WebSphere Studio Site Developer for Windows</td>
<td>16</td>
</tr>
<tr>
<td>IMS</td>
<td>17, 37</td>
</tr>
<tr>
<td>independent software vendors (ISVs)</td>
<td>60</td>
</tr>
<tr>
<td>industry open-standards</td>
<td>2</td>
</tr>
<tr>
<td>insurance</td>
<td>27</td>
</tr>
<tr>
<td>integrated development environment (IDE)</td>
<td>126</td>
</tr>
<tr>
<td>Integrated Edge Server</td>
<td>50</td>
</tr>
<tr>
<td>internal integration</td>
<td>46</td>
</tr>
<tr>
<td>iPlanet Directory Server</td>
<td>111</td>
</tr>
<tr>
<td>iSeries</td>
<td>13, 19, 71, 76, 81</td>
</tr>
<tr>
<td>ISV</td>
<td>126</td>
</tr>
<tr>
<td>J</td>
<td></td>
</tr>
<tr>
<td>J2EE</td>
<td>6, 11, 16, 18, 27, 50, 58</td>
</tr>
<tr>
<td>J2EE 1.3 Message Beans</td>
<td>13</td>
</tr>
<tr>
<td>J2EE environment</td>
<td>14</td>
</tr>
<tr>
<td>J2ME</td>
<td>18</td>
</tr>
<tr>
<td>Java</td>
<td>87</td>
</tr>
<tr>
<td>Java 2 Platform Enterprise Edition (J2EE)</td>
<td>2</td>
</tr>
<tr>
<td>Java Archive (JAR)</td>
<td>6</td>
</tr>
<tr>
<td>Java Authorization Service</td>
<td>14</td>
</tr>
<tr>
<td>Java Bean</td>
<td>163</td>
</tr>
<tr>
<td>Java Connector Architecture (JCA)</td>
<td>13</td>
</tr>
<tr>
<td>Java Developers Kit or Java Runtime Environment</td>
<td>98</td>
</tr>
<tr>
<td>Java Management eXtensions (JMX)</td>
<td>14</td>
</tr>
<tr>
<td>Java Messaging Service (JMS)</td>
<td>13, 151</td>
</tr>
<tr>
<td>Java Native Interface (JNI)</td>
<td>259</td>
</tr>
<tr>
<td>Java Servlet</td>
<td>163</td>
</tr>
<tr>
<td>Java Servlets</td>
<td>16</td>
</tr>
<tr>
<td>Java specifications</td>
<td>88</td>
</tr>
<tr>
<td>Java-based APIs</td>
<td>98</td>
</tr>
<tr>
<td>JavaScript</td>
<td>6, 16, 48</td>
</tr>
<tr>
<td>JavaServer Pages</td>
<td>16, 163</td>
</tr>
<tr>
<td>JDBC driver</td>
<td>85</td>
</tr>
<tr>
<td>JDBC driver managers</td>
<td>85</td>
</tr>
<tr>
<td>JDBC level</td>
<td>149</td>
</tr>
<tr>
<td>JDBC2</td>
<td>139</td>
</tr>
<tr>
<td>JMS</td>
<td>13</td>
</tr>
<tr>
<td>JMX</td>
<td>14–15</td>
</tr>
<tr>
<td>JNI connections</td>
<td>98</td>
</tr>
<tr>
<td>JSP</td>
<td>6</td>
</tr>
<tr>
<td>JSR 109</td>
<td>53</td>
</tr>
<tr>
<td>JSR 115</td>
<td>14</td>
</tr>
<tr>
<td>K</td>
<td></td>
</tr>
<tr>
<td>Kerberos tokens</td>
<td>15</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Local Warehouse Control Database</td>
<td>213</td>
</tr>
<tr>
<td>Lotus Collaborative Components</td>
<td>23</td>
</tr>
<tr>
<td>Lotus Collaborative Places</td>
<td>23</td>
</tr>
<tr>
<td>Lotus Extended Search R3.6</td>
<td>23</td>
</tr>
<tr>
<td>Lotus Quickplace R2.5</td>
<td>23</td>
</tr>
<tr>
<td>Lotus Sametime R2.6</td>
<td>23</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>MA88 SupportPac</td>
<td>98, 387</td>
</tr>
<tr>
<td>Magic eDeveloper</td>
<td>76</td>
</tr>
<tr>
<td>manual intervention</td>
<td>28</td>
</tr>
<tr>
<td>mapping/transformation</td>
<td>29</td>
</tr>
<tr>
<td>Mercant ODBC</td>
<td>376</td>
</tr>
<tr>
<td>Message Beans</td>
<td>55</td>
</tr>
<tr>
<td>Message Center</td>
<td>25</td>
</tr>
<tr>
<td>messaging middleware</td>
<td>33</td>
</tr>
<tr>
<td>messaging middleware integration</td>
<td>27</td>
</tr>
<tr>
<td>Microsoft Active Directory</td>
<td>111</td>
</tr>
<tr>
<td>Microsoft Windows 2000</td>
<td>19</td>
</tr>
<tr>
<td>Microsoft Windows 2000 Server</td>
<td>126, 203</td>
</tr>
<tr>
<td>Microsoft Windows NT</td>
<td>19</td>
</tr>
</tbody>
</table>
mobile access 27
mobile marketplace 21
model business processes 28
monitor business processes 28
MQ Everyplace 25
MQ messaging 10
MQSeries 12, 89, 98, 201
MQSeries Application Adapter Development Guide 116
MQSeries classes for Java 98, 259
MQSeries classes for Java Message Service (JMS) 98, 259
MQSeries Everyplace 33
MQSeries for MVS/ESA V1.2 98
MQSeries for OS/390 V2.1 98
MQSeries for OS/390 V5.2 98
mySAP.com 111

N
NNSYFormatter 294
NNSYRules 294

O
Object Management Group (OMG) 7
Object Relationship Management 29
operating system 82
optimize business processes 28
OS/390 17, 98, 101
OS/390 Component Broker Assembling Applications Guide 117

P
PartnerWorld for Developers 71
performance 12, 14
Performance Monitor Interface (PMI) 14
performance monitoring tool 107
persistent connections 106
Personalization 23
pervasive computing 23
planning, installation and configuration tools 81
plug-ins 19
Plumtree 111
POENTRY queue 159, 318, 395
portal 27
predefined business logic templates 29
principal 43
Procedural Application Adapter Development Guide 117
process and workflow management 28
process automation 28
process flow diagram 4
Process Integration 26–27, 34
production environment 3, 6
production server 3–5
pSeries 71, 78, 81

Q
Quickplace 23

R
RAD 19
rapid application development (RAD) 18
Reach & User Experience 9, 21, 35
real-time synchronization and management 28
Redbooks Web site 406
Contact us xiv
reliability 14
Resource Analyzer 15
Resource Analyzer for WebSphere 4.0 107
Resource Recovery Services (RRS) 17
retail distribution 27
roadmap
  IBM MQSeries 123
  WebSphere Administrator 118
  WebSphere Developer 119
  WebSphere Developer for Integration 121
  WebSphere Foundations 118
  WebSphere MQ 122
roadmaps 117
root user 363
RS/6000 107
RS/6000 Solution Sizer 107
rVerify 106

S
S/390 17, 37
Sametime 23
sample application 159
scalability 12, 14
SCM 111
security 12, 14, 42, 90, 108
security authentication options 15
Security Programming Interfaces (SPIs) 15
shared workareas 55
Siebel 111
Signature Selling Methodology 116
simple object access protocol (SOAP) 52
single security management solution 110
single server configuration 11
sizing and capacity planning 80
skills planning and education 115
Solution Bundles Marketing and Sales Guide xi, 420
SSL 33, 106
stages in e-business adoption 46
Staging environment 159
staging phase 3
staging server 3–5
stand-alone applications 11
state management 28
Studio Professional 10
Sun Microsystems Enterprise JavaBeans Specification 117
suppliers 7
SupportPac MA88 151, 259
SupportPac MA88 158
system management 108

T
Tag Libraries 16
telecommunications 27
Three-tiered client/server computing 39
Tivoli Access Manager V3.9 23
Tivoli Data Protection for WebSphere Application Server 1.1 109
Tivoli Manager 108
Tivoli Performance Viewer 15
Tivoli Policy Director 15, 23, 110
Tivoli Policy Director for MQSeries 109
Tivoli Policy Director-Application Servers 110
Tivoli Site Analyzer V4.1 23
Tivoli Web Services Analyzer 111
tools 19
TPF 37
transaction 41
transaction management 12
Transaction Servers and Tools 9, 35
Enterprise Modernization 35
WebSphere Transaction Gateway 36
WebSphere Developer Studio for iSeries 36
WebSphere Host Integration Solution 36
WebSphere Studio Asset Analyzer 36
WebSphere Studio Enterprise Developer 36
Traditional Tools 37
Application Monitor for z/OS and OS/390 38
CICS Interdependency Analyzer 38
CICS Online Transmission Time Optimizer 38
CICS Performance Analyzer 38
COBOL Family 38
COBOL for OS/390 & VM 38
COBOL for VSE 38
COBOL Set for AIX 38
Debug Tool for z/OS and OS/390 38
Enterprise COBOL for z/OS and OS/390 38
Fault Analyzer for z/OS and OS/390 38
File Manager for z/OS and OS/390 38
VisualAge C++ 38
VisualAge COBOL 38
VisualAge Enterprise Suite 38
VisualAge for Java 38
VisualAge Generator 38
VisualAge Packbase 38
VisualAge PL/I 38
VisualAge Smalltalk 38
WebSphere Studio Asset Analyzer 38
WebSphere Studio Enterprise Developer 38
Workload Simulator for z/OS and OS/390 38
Transaction Processing 37
CICS Transaction Server 37
CS/390 37
TPF 37
TXSeries for Multiplatforms 37
Transactional Qualities of Service 15
transactions 15, 47
trusted third party 43
TXSeries 12, 37, 116

U
Universal Description, Discovery and Integration (UDDI) 52
UNIX 6, 19, 78

V
Versata Logic Suite 10, 18–19, 58
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web applications</td>
<td>8</td>
</tr>
<tr>
<td>Web Archive (WAR)</td>
<td>6</td>
</tr>
<tr>
<td>Web browsers</td>
<td>86</td>
</tr>
<tr>
<td>Web content publishing</td>
<td>23</td>
</tr>
<tr>
<td>Web logs</td>
<td>112</td>
</tr>
<tr>
<td>Web Performance Tools (WPT)</td>
<td>106</td>
</tr>
<tr>
<td>Web publishing</td>
<td>46</td>
</tr>
<tr>
<td>Web server</td>
<td>83</td>
</tr>
<tr>
<td>Web services</td>
<td>11, 16</td>
</tr>
<tr>
<td>Web Services Description Language (WSDL)</td>
<td>52</td>
</tr>
<tr>
<td>Web services gateway</td>
<td>52</td>
</tr>
<tr>
<td>Web Services Invocation Framework (WSIF)</td>
<td>52</td>
</tr>
<tr>
<td>Web Tracker</td>
<td>112</td>
</tr>
<tr>
<td>Web-based sizing tool</td>
<td>107</td>
</tr>
<tr>
<td>WebSphere Administrative Console</td>
<td>318, 388</td>
</tr>
<tr>
<td>WebSphere Application Connectivity</td>
<td>32</td>
</tr>
<tr>
<td>WebSphere Application Server</td>
<td>xi, 2, 10, 50, 58</td>
</tr>
<tr>
<td>WebSphere Application Server - Express</td>
<td>10</td>
</tr>
<tr>
<td>WebSphere Application Server - Express V5.0</td>
<td>16</td>
</tr>
<tr>
<td>WebSphere Application Server Advanced Edition</td>
<td>20, 201</td>
</tr>
<tr>
<td>WebSphere Application Server Advanced Edition V4.0.2</td>
<td>23</td>
</tr>
<tr>
<td>WebSphere Application Server Enterprise</td>
<td>10</td>
</tr>
<tr>
<td>WebSphere Application Server Enterprise Edition</td>
<td>126, 201, 229, 368</td>
</tr>
<tr>
<td>WebSphere Application Server Express V5.0</td>
<td>49</td>
</tr>
<tr>
<td>WebSphere Application Server for z/OS</td>
<td>10</td>
</tr>
<tr>
<td>WebSphere Application Server for z/OS V5.0</td>
<td>17</td>
</tr>
<tr>
<td>WebSphere Application Server V4.0 Advanced Edition</td>
<td>11, 108</td>
</tr>
<tr>
<td>WebSphere Application Server V4.1 Enterprise Edition</td>
<td>12</td>
</tr>
<tr>
<td>WebSphere Application Server V5.0</td>
<td>13</td>
</tr>
<tr>
<td>WebSphere Application Server, V5.0</td>
<td>xi, 10, 12, 14</td>
</tr>
<tr>
<td>WebSphere architecture</td>
<td>8</td>
</tr>
<tr>
<td>WebSphere Business Integration</td>
<td>27</td>
</tr>
<tr>
<td>WebSphere certification</td>
<td>115</td>
</tr>
<tr>
<td>WebSphere channel enablement</td>
<td>xi, 420</td>
</tr>
<tr>
<td>WebSphere Commerce</td>
<td>21</td>
</tr>
<tr>
<td>WebSphere Commerce for Digital Media</td>
<td>21</td>
</tr>
<tr>
<td>WebSphere Commerce Suite</td>
<td>107</td>
</tr>
<tr>
<td>WebSphere Commerce Suite - Service Provider Edition</td>
<td>107</td>
</tr>
<tr>
<td>WebSphere Communications Server</td>
<td>20</td>
</tr>
<tr>
<td>WebSphere Competitive Comparison</td>
<td>44</td>
</tr>
<tr>
<td>WebSphere Data Interchange</td>
<td>34</td>
</tr>
<tr>
<td>WebSphere Edge Server</td>
<td>26</td>
</tr>
<tr>
<td>WebSphere Event Broker v2.1</td>
<td>27</td>
</tr>
<tr>
<td>WebSphere Everyplace Access</td>
<td>24</td>
</tr>
<tr>
<td>WebSphere Everyplace Mobile Connect</td>
<td>26</td>
</tr>
<tr>
<td>WebSphere Everyplace Portal</td>
<td>26</td>
</tr>
<tr>
<td>WebSphere Everyplace Server Enable Offering</td>
<td>24</td>
</tr>
<tr>
<td>WebSphere Everyplace Server, Service Provider Edition</td>
<td>24</td>
</tr>
<tr>
<td>WebSphere family</td>
<td>8</td>
</tr>
<tr>
<td>WebSphere Host Access</td>
<td>10</td>
</tr>
<tr>
<td>WebSphere Host Integration Solution</td>
<td>20</td>
</tr>
<tr>
<td>WebSphere Host On-Demand</td>
<td>20</td>
</tr>
<tr>
<td>WebSphere Host Publisher</td>
<td>20</td>
</tr>
<tr>
<td>WebSphere MQ</td>
<td>27, 32, 96, 110, 125–126, 151</td>
</tr>
<tr>
<td>WebSphere MQ Brokers</td>
<td>33</td>
</tr>
<tr>
<td>WebSphere MQ Event Broker</td>
<td>33</td>
</tr>
<tr>
<td>WebSphere MQ Everyplace</td>
<td>33</td>
</tr>
<tr>
<td>WebSphere MQ Integrator</td>
<td>98–99, 125, 290, 311</td>
</tr>
<tr>
<td>WebSphere MQ Integrator Broker</td>
<td>33</td>
</tr>
<tr>
<td>WebSphere MQ Integrator for AIX V2.1</td>
<td>100</td>
</tr>
<tr>
<td>WebSphere MQ Integrator for Windows NT and Windows 2000</td>
<td>100</td>
</tr>
<tr>
<td>WebSphere MQ Integrator for z/OS V2.1</td>
<td>101</td>
</tr>
<tr>
<td>WebSphere MQ Workflow</td>
<td>28, 101, 125</td>
</tr>
<tr>
<td>WebSphere Personalization V4.0</td>
<td>23</td>
</tr>
<tr>
<td>WebSphere Portal</td>
<td>22</td>
</tr>
<tr>
<td>WebSphere Portal Enable</td>
<td>22</td>
</tr>
<tr>
<td>WebSphere Portal Experience</td>
<td>22</td>
</tr>
<tr>
<td>WebSphere Portal Extend</td>
<td>22</td>
</tr>
<tr>
<td>WebSphere Portal product matrix</td>
<td>23</td>
</tr>
<tr>
<td>WebSphere Process Manager</td>
<td>202</td>
</tr>
<tr>
<td>WebSphere Sales University 101 Workshop</td>
<td>115</td>
</tr>
<tr>
<td>WebSphere Site Analyzer</td>
<td>111</td>
</tr>
<tr>
<td>WebSphere Solution Bundles</td>
<td>xi, 420</td>
</tr>
<tr>
<td>WebSphere Solution Sales 201 Workshop</td>
<td>116</td>
</tr>
<tr>
<td>WebSphere Studio</td>
<td>10, 18</td>
</tr>
<tr>
<td>WebSphere Studio Application Developer</td>
<td>10, 18</td>
</tr>
<tr>
<td>WebSphere Studio Application Developer Integration Edition</td>
<td>10, 19, 103, 125–126, 159</td>
</tr>
<tr>
<td>WebSphere Studio Application Developer V4.0.2</td>
<td>23</td>
</tr>
<tr>
<td>WebSphere Studio Device Developer</td>
<td>18–19</td>
</tr>
<tr>
<td>WebSphere Studio Enterprise Developer</td>
<td>18</td>
</tr>
<tr>
<td>WebSphere Studio Enterprise Edition</td>
<td>10, 19</td>
</tr>
<tr>
<td>WebSphere Studio Homepage Builder</td>
<td>18</td>
</tr>
<tr>
<td>WebSphere Studio Professional</td>
<td>19</td>
</tr>
<tr>
<td>WebSphere Studio Site Developer</td>
<td>18</td>
</tr>
<tr>
<td>WebSphere Studio Site Developer Advanced</td>
<td>10, 19</td>
</tr>
</tbody>
</table>
WebSphere Transcoding Publisher   26
WebSphere Translation Server   24
WebSphere Voice Response Beans   25
WebSphere Voice Response for AIX   25
WebSphere Voice Response for Windows NT & Windows 2000   25
WebSphere Voice Server   24
WebSphere Voice Server for Transcription   25
WebSphere Voice Toolkit   25
Whole Product Concept   xi, 47, 420
Workflow Configuration Utility   272
World Wide Web (WWW)   7
Writing Encina Applications   117
Writing Enterprise Beans in WebSphere   117

X
XA transactions   259
XAResource interface   259
XML   34, 89
XML-based administrator client   14
xSeries   71, 77, 81
XSL   89

Z
z/OS   17, 98
zSeries   13, 17, 19, 33, 37, 71, 79–81
WebSphere Solution Bundles: Implementation and Integration Guide

The WebSphere Solution Bundles: Implementation and Integration Guide was developed to help the marketing and support efforts for WebSphere Channels Enablement. This guide represents one of two documents, together known as the Solution Bundle for WebSphere Channel Enablement. The Solution Bundle includes WebSphere channel-ready documentation in the form of a Solution Bundles Marketing and Sales Guide and an implementation and integration guide. The purpose of this implementation and integration guide is to simplify the planning and implementation of IBM Business Partners’ and independent software vendors’ e-business applications that are enabled for WebSphere Application Server. It also takes into consideration the “Whole Product Concept”, which incorporates everything the customer needs to achieve the business goals that drive its purchase decisions, including consultation, design, configuration, implementation, OEM products and services, and on-going support.

In this book, we review and execute a step-by-step set of instructions that includes the setup and configuration of WebSphere Application Server, and the design and development of an e-business application to be deployed on Microsoft Windows 2000 and IBM AIX. This methodology provides a reference for a working solution that has been system-assured and can be quickly implemented. Additional information on performance guidelines, sizing, education and support is included to help you to understand and manage your WebSphere e-business solution.

Planning and implementation of Business Partner and ISV e-business applications

Recommended hardware and software selection for WebSphere Application Server

Examples of development, test, and production environments

SG24-6550-00 ISBN 0738424579

INTERNATIONAL TECHNICAL SUPPORT ORGANIZATION

BUILDING TECHNICAL INFORMATION BASED ON PRACTICAL EXPERIENCE

IBM Redbooks are developed by the IBM International Technical Support Organization. Experts from IBM, Customers and Partners from around the world create timely technical information based on realistic scenarios. Specific recommendations are provided to help you implement IT solutions more effectively in your environment.

For more information: ibm.com/redbooks